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About Control Center

Control Center is an administration tool, used to deploy, run, and administer 
StreamServe applications. The applications are organized in sites, for example by 
company or organization, and in application domains, for example by department 
or region.

You also use Control Center to create StreamServe repositories for the sites and 
the application domains. You can either create the repositories directly from the 
tool (for Microsoft® SQL Server and Oracle® Database) or you can generate 
database scripts to be executed later in an external tool. After creation, you can 
apply database hotfixes to the repositories directly from Control Center.

You can use Control Center to run applications and create repositories on both 
UNIX and Windows hosts.

Terminology

• StreamServe applications – StreamServer, Archiver, service gateway, and 
Task Scheduler applications.

• StreamServer applications – StreamServe applications used to run Design 
Center Projects.

In this section

• Component overview on page 8.

• Document type deployment overview on page 19.

• Control Center tasks on page 22.
StreamServe Persuasion SP5 Control Center User Guide Rev C
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Component overview
This section describes the StreamServe applications and the components used to 
deploy, run, and administer these applications.

In this section

• Components to run StreamServer applications on page 8.

• Components to run StreamStudio web applications on page 9.

• Component descriptions on page 11.

• Scenarios on page 15.

Components to run StreamServer applications
To run a Design Center Project, you need:

• A StreamServe Enterprise Repository, which stores information about 
computers, StreamServe applications, and application domains for a 
company or an organization. 
See StreamServe Enterprise Repository on page 12.

• A site, which represents the company or organization in Control Center.
See Site on page 12.

• A management gateway, which connects the computer where you run the 
applications to the enterprise repository and to Control Center.
See Management gateway on page 12.

• An application domain, which is a group of one or more applications. All 
applications in one domain share the same runtime repository (see below). 
See Application domain on page 13.

• A StreamServer application, which runs the Design Center Project. 
See StreamServer application on page 13.

• A runtime repository, which stores jobs and job related information 
produced by the StreamServer application. If you run StreamStudio, the 
repository is also used to store security profiles and web access information.
See Runtime repository on page 13.

You can use the same computer (host) for Control Center, the enterprise 
repository, the runtime repository, and the StreamServe applications. It is also 
possible to use different computers for all of these components.
StreamServe Persuasion SP5 Control Center User Guide Rev C
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Figure 1 StreamServer components to run Design Center Projects

Components to run StreamStudio web applications
In addition to the components used to run Design Center Projects, you need the 
following to run StreamStudio:

• A StreamStudio web portal, which contains the StreamStudio web 
applications. The web portal is configured outside the application domain 
and can be shared by several application domains.
See StreamStudio web portal on page 14.

• User directories, which contains the user profiles. These profiles are used to 
access the StreamStudio web applications via the StreamStudio web portal. 
See User directories on page 14.

• A service gateway, which is used by the StreamStudio web portal to access 
the user directories and the runtime repository. 
See Service gateway on page 14.
StreamServe Persuasion SP5 Control Center User Guide Rev C
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Figure 2 Basic StreamStudio components

Collector specific components

In addition to the basic StreamStudio components, you need the following to run 
StreamStudio Collector:

• A StreamServe archive, which stores output documents and related 
metadata that are accessed from StreamStudio Collector. The Collector web 
application is connected to the StreamServe archive via the service gateway. 
The StreamServe archive is configured outside the application domain, and 
can be shared by several application domains.
See StreamServe archive on page 15.

• An Archiver application, which transfers output documents and metadata 
from the runtime repository to the StreamServe archive. 
See Archiver application on page 15.

Figure 3 StreamStudio Collector components
StreamServe Persuasion SP5 Control Center User Guide Rev C
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Composition Center specific components

In addition to the basic StreamStudio components, you need the following to run 
StreamStudio Composition Center:

• A web content repository, which is used by the Composition Center web 
application for storing document definitions, resources, and rules during the 
document design phase. 
See Web content repository on page 15.

Figure 4 StreamStudio Composition Center components

Component descriptions

In this section

• StreamServe Enterprise Repository on page 12.

• Site on page 12

• Management gateway on page 12.

• Application domain on page 13.

• StreamServer application on page 13.

• Runtime repository on page 13.

• StreamStudio web portal on page 14.

• User directories on page 14.

• Service gateway on page 14.

• StreamServe archive on page 15.

• Archiver application on page 15.

• Web content repository on page 15.
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StreamServe Enterprise Repository
StreamServe Enterprise Repository stores information about computers, 
StreamServe applications, and application domains for a company or 
organization. 

The repository is also the main storage for the document types used by the 
company or organization. For more information, see Document type deployment 
overview on page 19.

Site
In Control Center, a company or organization is represented by a site. For each 
site, you configure computers, application domains, and StreamServe 
applications.

The site is connected to the StreamServe Enterprise Repository for the company 
or organization via a Management gateway. If you use more than one computer 
to run the applications at the site, you must configure all computers to use the 
same enterprise repository.

Management gateway
Each computer where you run StreamServe applications has its own management 
gateway. The management gateway is connected to a StreamServe Enterprise 
Repository.

The management gateway is used to:

• Manage the communication between Control Center and the applications on 
the computer.

• Manage and monitor the applications on the computer.

Management gateway users

To use Control Center to manage and monitor the StreamServe applications on a 
computer, you must have a user name and password for the management gateway.

For more information about management gateway users, see Managing users on 
page 39.
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Application domain
Depending on what you want to achieve in terms of document storage and access, 
you organize the StreamServe applications in application domains. All 
applications in one application domain share the same repositories, connection 
profiles, document types, channels for reprocess and preview, etc.

For example, you can use one application domain per company, department, or 
geographical region. Or you can use one application domain for the test 
environment and another application domain for the production environment.

You can configure recovery actions for each application domain. For example, 
what actions to take if the connection to the runtime repository is lost, and who to 
notify if one of the applications in the application domain goes down.

Applications domains are independent from computers. This means you can use 
different computers to run applications in the same domain, or you can use the 
same computer to run applications in different domains.

For application domain scenarios, see Scenarios on page 15.

StreamServer application
A StreamServer application runs an exported Design Center Project. Each Project 
is deployed to and run by a separate StreamServer application. You can use 
several StreamServer applications, running different deployed Projects, in the 
same Application domain.

For failover reasons, you can deploy a Project to more than one StreamServer 
application and let the StreamServer applications share queues. This means that 
jobs can be reallocated if the StreamServer application processing the job goes 
down or loses connection to the repositories.

Runtime repository
A runtime repository is used to store jobs and job related information in queues. 
It is also used to store security profiles and web access information for the 
StreamStudio web applications. Each Application domain uses a separate runtime 
repository.

The following repositories are included in the runtime repository:

• Queue – Stores jobs and job information in input and output queues as 
specified in the Design Center Project configuration.

• Security – Stores security settings, such as user roles, for the StreamStudio 
web applications as specified in the StreamStudio Administrator and 
Customers web applications.

• Web Access – Stores access information for the user roles as specified in 
the StreamStudio Administrator and Customers web applications. 
Depending on role, the StreamStudio user can access certain web 
applications and documents.
StreamServe Persuasion SP5 Control Center User Guide Rev C
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StreamStudio web portal
The StreamStudio web portal contains the StreamStudio web applications. The 
web applications are based on Java code and must be deployed to a Java 
application server, for example Apache Tomcat.

Each Application domain can access one StreamStudio web portal. One web 
portal can be shared by several application domains.

In the User directories, StreamStudio users are associated with application 
domains. A user can log on to the application domains that the user is associated 
with.

User directories
The user directories contain the user profiles for the StreamStudio web 
applications. These profiles are used to access the web applications and to 
validate users assigned to StreamServe jobs. The user directories can be 
connected to an existing directory server, which must support the LDAP protocol. 

There are two kinds of user directories:

• Internal – Contains user profiles of internal company employees. These are 
used, for example, to access the StreamStudio web applications and to 
validate users assigned to StreamServer jobs.

• External – Contains user profiles of external customers and clients, used to 
access the StreamStudio web applications.

Several application domains can share the same user directories.

Note: You can access StreamStudio without a user directory. For example, if no 
user directory is available, or if you want to demonstrate or test 
StreamStudio without a directory connection. In this case, the only 
available user is the application domain administrator. For more 
information, see Administrator tab on page 174.

Service gateway
A service gateway connects the StreamStudio web portal to the Runtime 
repository, the StreamServe archive, and the User directories.

When a user logs in to StreamStudio, the service gateway authenticates the user 
credentials in the user directory and in the Security repository. The service 
gateway then gives the user access to certain web applications and documents as 
defined in the Web Access repository.

Each Application domain used to run StreamStudio must include a service 
gateway application. For failover reasons, you can add a secondary service 
gateway.
StreamServe Persuasion SP5 Control Center User Guide Rev C
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StreamServe archive
A StreamServe archive stores output documents and related metadata that are 
accessed from the StreamStudio Collector web application. An Archiver 
application transfers output documents and metadata from the Runtime repository 
to the StreamServe archive. The connection between the Collector web 
application and the StreamServe archive is handled by the Service gateway. 

Each Application domain can access one StreamServe archive. One StreamServe 
archive can be shared by several application domains.

Note: If one StreamServe archive is shared by several application domains, a 
Collector user can access all documents (created via all application 
domains) in the StreamServe archive.

Archiver application
An Archiver application transfers output documents and metadata from the 
Runtime repository to the StreamServe archive according to a specified schedule. 
Each Application domain requires a separate Archiver application. For failover 
and load balancing reasons, you can add several Archiver applications.

Web content repository
A web content repository is used by Composition Center for storing document 
definitions, resources, and rules during the document design phase. One web 
content repository can be used in only one Application domain.

When a document definition is published, the document definition together with 
its resources and rules are copied to the Runtime repository, where it is available 
to the StreamServer application that produces the document.

Scenarios

In this section

• Application domains for test and production on page 15.

• Application domains for specific business processes on page 16.

• Application domains for several retailers on page 17.

Application domains for test and production
A company implementing StreamServe is using the same site for the test and 
production environments. In order not to add any test data to the production 
runtime repository, the company uses two application domains – one for the test 
environment and one for the production environment.

As the company only runs small jobs in the test application domain, an SQL 
Server Express database is used for the test runtime repository.
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When the testing is complete, the company starts using the production application 
domain. In production, the company uses an SQL Server for the production 
runtime repository. This repository only contains real documents (no test data).

Figure 5 Separate application domains for test and production

Application domains for specific business processes
A financial services company uses StreamServe to:

• Produce and mail out monthly account statements to their customers.

• Produce and email weekly internal financial reports to their branch offices.

The company uses StreamStudio Collector to access the documents.

Two separate StreamServe archives

The company wants to use separate management processes for the applications 
used to produce the account statements and for the applications used to produce 
the internal reports. The company also wants to use two different StreamServe 
archives to store the account statements and financial reports.

Two application domains

The company uses one application domain for the StreamServer applications used 
to produce the weekly financial reports. The financial reports are stored in the 
archive for financial reports on an Oracle database instance.

Another application domain is used for the StreamServer applications that 
produce and mail the account statements. The account statements are stored in the 
StreamServe archive for account statements on another Oracle database instance. 
This application domain includes StreamServer applications running on different 
computers.
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Separate failover actions

Separating the applications into two application domains means that the company 
can set up failover actions specific to the StreamServer applications used to 
produce the account statements. This enables them to take immediate action if an 
application goes down due to disc failure, loss of database connection, etc.

Figure 6 Application domains for different business processes

Application domains for several retailers
A manufacturing company has a central StreamServe installation for a network of 
several retailers. Each retailer uses StreamStudio Collector to access documents.

One StreamServe archive for each retailer

For document storage, the manufacturing company uses one StreamServe archive 
for each retailer. Each retailer can then access their own documents, and not the 
documents stored by any other retailer.

One application domain for each retailer

The manufacturing company uses one application domain for each retailer. Each 
application domain contains (at least) one StreamServer application, one runtime 
repository, and one Archiver application. An identical Design Center Project is 
deployed to all StreamServer applications in all the application domains. Each 
application domain is connected to a separate StreamServe archive.

Note: If the manufacturing company would want the retailers to access each 
others documents, a central StreamServe archive could be used instead.

Two StreamStudio web portals

The manufacturing company uses two Java application servers for the 
StreamStudio web applications for the retailers.
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In Control Center, two StreamStudio web portals are configured for the two Java 
application servers. Each application domain is connected to one of these portals. 
To enable the use of StreamStudio, each application domain also includes a 
service gateway.

In the user directory of the manufacturer, each retailer is associated with an 
application domain. When retailers log in to the Collector web application, each 
retailer can only access their own application domain. After logging in, the 
retailer is connected to the StreamServe archive for the retailer’s application 
domain and can access documents created via this application domain.

Figure 7 Application domains for several retailers
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About Control Center
Document type deployment overview
Document types are used to categorize documents, for example as invoices, 
orders, etc. For each document type, a number of metadata can be specified, for 
example, invoice number, customer name, etc. Metadata is used, for example, 
when searching for documents from StreamStudio Collector or when writing 
personalized marketing messages in StreamStudio Composition Center. The 
document types and metadata are configured in Design Center. 

The document types (including the metadata) must be stored in StreamServe 
Enterprise Repository, in the runtime repository, and in the StreamServe archive 
(if StreamStudio Collector is used). The enterprise repository contains the 
“master document types”, to which the other repositories should comply.

In this section

• Document type deployment on page 19.

• Document type redeployment on page 20.

• Document type redeployment scenario on page 21.

Document type deployment
After being configured in Design Center, document types are deployed to the 
StreamServe repositories in the following way:

1 StreamServe Enterprise Repository – When you deploy a Project to a 
StreamServer application in Control Center, the management gateway 
stores the “master document types” in the enterprise repository.

2 Runtime repository – When the StreamServer application is started, the 
application retrieves the relevant document types from the enterprise 
repository and stores them in the runtime repository.

3 StreamServe archive – When the Archiver application is started, the 
application retrieves the relevant document types from the enterprise 
repository and stores them in the StreamServe archive.
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Figure 8 Document type deployment

Document type redeployment
Once a document type is deployed to the StreamServe repositories, there are strict 
rules for how the document type and metadata can be modified in Design Center. 
If the rules are fulfilled, the updated document types can be redeployed to the 
repositories from Control Center, and no further actions are required.

However, if these rules are not fulfilled, you cannot redeploy the Project in 
Control Center. For example, if a metadata is removed from a document type in 
Design Center. You can then log in to Control Center as the management gateway 
administrator user and force the updated document type into the runtime 
repository. If the force is successful, the redeploy operation is completed. The 
updated document type is then identical in the enterprise repository and the 
runtime repository.

Note: Forcing an updated document type into the runtime repository does not 
affect the document type in the StreamServe archive.

Related topics

For a complete list of consequences in the StreamServe repositories and the 
StreamStudio web applications when redeploying modified document types, see 
the Document types and metadata documentation.
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Document type redeployment scenario
A manufacturing company uses a document type called Invoice. Several 
metadata is defined for this document type, for example Invoice Number, 
Customer Name, Project Number. The company has already stored 10 million 
documents in the StreamServe archive with the defined metadata.

Metadata not used in searches

The company uses StreamStudio Collector to access the documents. Since 
Project Number is never used in the Collector searches, the company wants to 
remove this metadata from the Collector web application and release the 
corresponding space in the StreamServe archive. 

Delete metadata from all repositories

A StreamServe consultant helps the company with the implementation.

In Design Center, the consultant removes the Project Number metadata from the 
Invoice document type.

The consultant logs in to Control Center as the management gateway 
administrator user. When the Archiver application has finished all ongoing 
archiving tasks, the consultant stops the application. Before redeploying the 
Project, the consultant ensures there is a complete backup of the runtime 
repository. At the redeploy, the Compare Document Types tool opens, informing 
that the document type has been changed. The consultant completes the redeploy 
operation by forcing the updated document type into the runtime repository. The 
updated document type, without the Project Number metadata, is then stored in 
the enterprise repository and the runtime repository.

To release space in the StreamServe archive, the Project Number metadata must 
be deleted from the archive. To delete the metadata, the consultant contacts the 
database administrator for the company. Using the DBMS (Database 
Management System), the database administrator deletes the metadata from the 
archive.

Identical document types, without metadata, in all repositories

The Invoice document type is now identical in all three repositories. 

The consultant restarts the applications and runs the Project. The processed 
documents are stored in the StreamServe archive without the Project Number 
metadata. The Project Number metadata does not appear in Collector, and is not 
related to any old documents in the StreamServe archive.
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Control Center tasks
This section gives an overview of the tasks that can be carried out when managing 
applications using Control Center.

Control Center task list

1 Getting started in Control Center:

• Change the password for the Management Gateway Administrator.

• Configure the connection settings for the enterprise repository.

• Create the database for the enterprise repository.

• Rename the site.

• Create management gateway users.

See Getting Started on page 25.

2 Prepare to run Design Center Projects using StreamServer applications:

• Create and configure an application domain.

• Create a runtime repository for the application domain.

• Add StreamServer applications to the application domain.

• Deploy Design Center Projects to the StreamServer applications.

See StreamServer configurations on page 45.

3 Prepare to run StreamStudio web applications:

• Configure the application domain for StreamStudio.

• Add a service gateway application to the application domain.

• Add a StreamStudio web portal.

• Connect the portal to the application domain.

See StreamStudio configurations on page 69.

4 Prepare to run StreamStudio Collector:

• Add and configure a StreamServe archive.

• Create the StreamServe archive.

• Connect the StreamServe archive to the application domain.

• Add an Archiver application to the application domain and schedule 
the archiving tasks.

See StreamStudio Collector configurations on page 81.

5 Prepare to run StreamStudio Composition Center:

• Configure the application domain for Composition Center.

• Create a web content repository.

See StreamStudio Composition Center configurations on page 97.

6 Manage the applications. For example:
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• Start applications.

• Monitor applications.

See Managing StreamServe applications on page 105.
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Getting Started

This chapter describes the first steps you take to get started in Control Center. 

It also includes information about how to work with sites, create the database for 
StreamServe Enterprise Repository and manage users in Control Center.

In this section

• First steps in Control Center on page 26.

• Creating StreamServe Enterprise Repository on page 29.

• Working with sites on page 36.

• Managing users on page 39.

• Finding installed StreamServe components on page 43.

Related topics

For information about:

• Preparations you must make to run StreamServer applications, see 
StreamServer configurations on page 45.

• Additional configurations you must carry out to run StreamStudio, see 
StreamStudio configurations on page 69.
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First steps in Control Center
The following steps are required to get started in Control Center:

• Enter a new password for the Management Gateway Administrator.

• Configure the connection settings to the enterprise repository.

• If you are making a new installation of StreamServe Persuasion, you must 
create the database for the enterprise repository.

• For best practices, you should rename the site node, which is named New 
Site by default. 

In this section

• Opening Control Center and changing the password for the Management 
Gateway Administrator on page 26.

• Connecting to the enterprise repository on page 27.

Related topics

For information about:

• How to create the database for the enterprise repository, see Creating 
StreamServe Enterprise Repository on page 29.

• How to rename the site, see Renaming a site on page 36.

• How to re-connect to an existing site after the first time you open Control 
Center, see Connecting to an existing site on page 36.

• How to connect to a site if you fail to do so the first time you open Control 
Center, see Connecting to a site when you fail to the first time you open of 
Control Center on page 37.

Opening Control Center and changing the password for 
the Management Gateway Administrator

The first time you open Control Center you are prompted to enter a new password 
for the local Management Gateway Administrator. 

To open Control Center and change the password for the Manage-
ment Gateway Administrator

1 From the Start menu, select All Programs > StreamServe Persuasion 
SP5 > Control > Control Center. The Welcome to Control Center window 
opens.

2 Click OK to continue. The Change Password dialog box opens.

3 Enter a new (case-sensitive) password for the Management Gateway 
Administrator and click OK. 

The Configure Enterprise Repository dialog box is displayed, which you can 
use to specify the connection settings to the enterprise repository.
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Connecting to the enterprise repository
Typically each computer that is used to run StreamServe applications is 
connected to one StreamServe Enterprise Repository. If there is an existing 
StreamServe Enterprise Repository at your company or organization, you can 
connect the computer to that enterprise repository. 

If you are making a new installation of StreamServe Persuasion, you can create a 
new StreamServe Enterprise Repository. To do this, you first configure 
connection settings and then create the database for the enterprise repository.

In this section

• Configuring the connection settings for a new StreamServe Enterprise 
Repository on page 27.

• Configuring the connection settings to an existing StreamServe Enterprise 
Repository on page 28.

Related topics

• For information about how to create the database for the enterprise 
repository, see Creating StreamServe Enterprise Repository on page 29.

Configuring the connection settings for a new StreamServe 
Enterprise Repository

1 If the Configure Enterprise Repository dialog box is not displayed 
automatically, right-click the site node and select Configuration...

2 Enter the connection settings for the enterprise repository. See Configure 
Enterprise Repository dialog box on page 165.

3 Click OK to close the Configure Enterprise Repository dialog box.

Post requisites

You must now create the database for the enterprise repository. See Creating 
StreamServe Enterprise Repository on page 29.

If you have problems changing the password for the Management 
Gateway Administrator the first time you open Control Center, see 
Connecting to a site when you fail to the first time you open of Control 
Center on page 37.
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Configuring the connection settings to an existing StreamServe 
Enterprise Repository

From Control Center, you can connect to an existing enterprise repository in 
Microsoft® SQL Server or Oracle® Database.

Prerequisites for Microsoft® SQL Server

To connect to an existing enterprise repository in Microsoft® SQL Server, you 
need the following information:

• IP Address or host name, and port of the database server.

• Name of the enterprise repository database.

• Enterprise repository user name and password. The default user name is 
StrsSERAccess

Prerequisites for Oracle® Database

To connect to an existing enterprise repository in Oracle® Database, you need the 
following information:

• IP Address or host name, and port of the database server.

• Service name (SID) of the enterprise repository.

• Enterprise repository schema owner user name and password. The default 
user name is StrsSERAccess

To specify the connection settings to an existing enterprise reposi-
tory

1 If the Configure Enterprise Repository dialog box is not displayed 
automatically, right-click the site node and select Configuration...

2 Enter the connection settings to the existing enterprise repository. See 
Configure Enterprise Repository dialog box on page 165.

3 Click OK to close the Configure Enterprise Repository dialog box.
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Creating StreamServe Enterprise Repository
You can create the database for the StreamServe Enterprise Repository directly 
from Control Center (for Microsoft® SQL Server and Oracle® Database).

You can also create the database for the enterprise repository manually. This may 
be required if the company security policy prevents Control Center from 
connecting to the database, or if you want to have full traceability of the 
repository creation. To do this, you generate the database scripts for the repository 
in Control Center and then run the scripts using an external tool.

After the enterprise repository is created, you can apply database hotfixes to the 
repository directly from Control Center.

Post requisites

An enterprise repository created directly from Control Center is normally 
sufficient for development and testing purposes, and may also be sufficient for a 
production environment.

If the enterprise repository is not sufficient for your production environment, you 
must adjust the repository to fit the actual conditions using an external tool.

In this section

• Prerequisites for creating StreamServe repositories on page 30.

• Creating an enterprise repository from Control Center on page 30.

• Creating an enterprise repository manually on page 31.

• Listing and applying database hotfixes on page 34.

Related topics

• Configuring the connection settings for a new StreamServe Enterprise 
Repository on page 27.

After creating a repository, always do a sanity check to make sure the 
repository was created according to your configurations.
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Prerequisites for creating StreamServe repositories

Database access

Before you can create a StreamServe Enterprise Repository, you must have access 
to a supported database installation. 

For information about the supported databases, see Databases in the Supported 
platforms and software documentation.

If you plan to use SQL Server or SQL Server Express for the StreamServe 
repositories, you must configure the database installation for use with 
StreamServe components.

All StreamServe repositories must use the same database vendor. For example, if 
the enterprise repository runs on Oracle, the runtime repository, the StreamServe 
archive, and the web content repository must also run on Oracle. 

Configuring SQL Server and SQL Server Express for use with 
StreamServe components

For SQL Server and SQL Server Express, you must configure your database 
according to the following:

• Enable TCP/IP.

• Mixed Mode authentication must be specified.

• Specify the static TCP port number that you use for accessing the database, 
for all IP addresses.

• Do not specify any dynamic TCP ports.

SQL Server Browser service for named instances

• If you use a named instance of SQL Server, the SQL Server Browser service 
must be started before you create the StreamServe repositories.

Creating an enterprise repository from Control Center
This section applies to Microsoft SQL Server and Oracle.

Prerequisites

• The connection settings to enterprise repository are configured. See 
Configuring the connection settings for a new StreamServe Enterprise 
Repository on page 27.

• The DBMS (Database Management System) is prepared for use with 
StreamServe components. See Prerequisites for creating StreamServe 
repositories on page 30.

• The the login details for the database administration user are available.
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Note: For Microsoft SQL Server 2008 R2, you cannot create the repository 
directly from Control Center if the password contains certain 
characters. For example: [] {}() , ; ? * ! @
For more information, see:
http://msdn.microsoft.com/en-us/library/ms161962.aspx

To create the enterprise repository directly from Control Center

1 Right-click the site node and select Create Database. The Create Database 
dialog box opens.

2 In the Operation area, select Create now.

3 Select the enterprise repository from the drop-down list.

4 Click Start to run the scripts. The Connect dialog box opens.

5 Enter the user name and password for the database administration user.

6 Click OK. The scripts to create the enterprise repository are executed. A 
short version of the log is displayed in the Result log area.

Note: To view the full log in the default text editor, click Open Log File.

After creating the enterprise repository, the management gateway 
automatically tries to connect to the new enterprise repository.

7 Click Close to close the Create Database dialog box.

Creating an enterprise repository manually
You can create a StreamServe Enterprise Repository manually. To do this, you 
must first generate the scripts for the repository in Control Center and then run the 
scripts using an external tool.

Prerequisites

• The connection settings to enterprise repository are configured. See 
Configuring the connection settings for a new StreamServe Enterprise 
Repository on page 27.

• The DBMS (Database Management System) is prepared. See Prerequisites 
for creating StreamServe repositories on page 30.

In this section

• Generating database scripts for the enterprise repository on page 32.

• Executing the scripts for the enterprise repository (SQL Server) on page 32.

• Executing the scripts for the enterprise repository (Oracle) on page 33.
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Generating database scripts for the enterprise repository
You can generate the database scripts from the computer used for StreamServe 
Enterprise Repository or from another computer.

When you generate the scripts from Control Center, the scripts are saved in the 
directory below. The scripts are saved as a ZIP file, which you can unpack using 
an archiving application, such as WinZip.

<Base directory>\<Version>\root\config\database\-<GUID>.zip

Where:

• <Base directory> – Is the path specified for StreamServe Projects during 
the Framework and Control Center installation.
For example: C:\ManagementGateway

• <GUID> – Is a globally unique identifier for the ZIP file.

To generate database scripts for the enterprise repository

1 Right-click the site node and select Create Database. The Create Database 
dialog box opens.

2 In the Operation area, select Create scripts for later use.

3 Select the enterprise repository from the drop-down list.

4 Click Start. The scripts for the enterprise repository are generated. A short 
version of the log is displayed in the Result log area.

Note: To view the full log in the default text editor, click Open Log File.

5 A Control Center window opens, asking if you want to save a local copy of 
the scripts. Click Yes or No.

6 Click Close to close the Create Database dialog box.

Executing the scripts for the enterprise repository (SQL Server)
To create a StreamServe Enterprise Repository, you must:

• Run the load_as_sys.sql script to create the database.

• Run the load.sql script to create the tables etc. for the repository.

Prerequisites

• The login details for the system administrator user (sa) are available.

• A ZIP file (with the scripts for the repository) is generated in Control Center 
and unpacked using an archiving application, such as WinZip.

Post requisites

• Always do a sanity check to make sure the repository was created according 
to your configurations.

• Since the scripts contain passwords, it is recommended to delete the scripts 
after you have created the repository.
StreamServe Persuasion SP5 Control Center User Guide Rev C



Creating StreamServe Enterprise Repository 33
Getting Started
To execute the scripts for the repository

1 Open the appropriate SQL Server tool. For example, 
Microsoft® SQL Server™ Management Studio or SQLCMD.

2 Log in as the system administrator user (sa).

3 Run the load_as_sys.sql script.

4 Run the load.sql script in the database created in step 3 above.

Executing the scripts for the enterprise repository (Oracle)
To create a StreamServe Enterprise Repository, you must:

• Run the load_as_sys.sql script to create the schema.

• Run the load.sql script to create the tables etc. for the repository.

Prerequisites

• The login details for the SYS user and the schema owner are available.

• A ZIP file (with the scripts for the repository) is generated in Control Center 
and unpacked using an archiving application, such as WinZip.

Post requisites

• Always do a sanity check to make sure the repository was created according 
to your configurations.

• Since the scripts contain passwords, it is recommended to delete the scripts 
after you have created the repository.

To execute the scripts for the repository

1 Since the password of the schema owner is the same as the schema owner 
user name, it is recommended to change the password in the 
load_as_sys.sql script.

2 Open the appropriate Oracle tool. For example, Oracle® SQL Developer or 
SQL*Plus (requires Oracle® Database Instant Client).

3 Log in as the SYS user.

4 Run the load_as_sys.sql script.

5 Log in as the schema owner configured for the repository.

6 Run the load.sql script.
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Listing and applying database hotfixes
You can apply database hotfixes to the StreamServe repositories directly from 
Control Center. 

Before applying a hotfix, you can list all repositories that belong to a site, together 
with their current schema versions and the latest available hotfixes. This will give 
you an overview of the current statuses of the repositories and help you to decide 
whether the repositories need to be upgraded.

Prerequisites

• The login details for the database administration user are available.

• The setup for the hotfix has been run and the database hotfixes are installed 
in:

<Base directory>\<Version>\root\config\database\

Where <Base directory> is the path specified for StreamServe Projects 
during the Framework and Control Center installation.
For example: C:\ManagementGateway

In this section

• Listing schema versions and applied database hotfixes on page 34.

• Applying a database hotfix to the enterprise repository on page 35.

Listing schema versions and applied database hotfixes
In Control Center, you can list all repositories that belong to a site, together with 
their current schema versions and the latest available hotfixes. This will help you 
to decide whether a repository needs to be upgraded.

Prerequisites

• See Prerequisites on page 34.

To list available and applied database hotfixes

1 Right-click the site node and select Available Database Hotfixes. The 
Available Database Hotfixes dialog box opens.

2 Click Get List (if the dialog box is opened for the first time) or Update List 
(if the dialog box was previously opened). The Connect dialog box opens.

3 Enter the user name and password for the database administration user.

4 Click OK. In the Overview area, the repositories, current schema versions, 
and the latest available database hotfixes are listed. A log is displayed in the 
Result log area.

5 Click Close to close the Available Database Hotfixes dialog box.
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Applying a database hotfix to the enterprise repository
You can apply the latest available database hotfix to a StreamServe Enterprise 
Repository directly from Control Center.

Prerequisites and recommendations

• See Prerequisites on page 34.

• Before applying a database hotfix, the following is recommended:

– Make sure that no other users are connected to the repository. If 
possible, set the repository to single user mode.

– Stop all applications accessing the repository.

– Perform a backup of the repository.

Always read the hotfix documentation for additional preparations for a 
specific hotfix.

To apply a hotfix from Control Center

1 Right-click the site and select Create Database. The Create Database 
dialog box opens.

2 In the Operation area, select Apply database hotfix.

3 Select the enterprise repository from the drop-down list.

4 Click Start to apply the latest available database hotfix in the base directory. 
The Connect dialog box opens.

5 Enter the user name and password for the database administration user.

6 Click OK. The database hotfix is applied to the enterprise repository. A 
short version of the log is displayed in the Result log area.

Note: To view the full log in the default text editor, click Open Log File.

7 Click Close to close the Create Database dialog box.
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Working with sites
This section describes how to rename a site and how to re-connect to a site each 
time you open Control Center.

It also includes information about how to use Control Center to:

• Manage StreamServe applications on a management gateway on another 
computer.

• Manage StreamServe applications at different sites.

In this section

• Renaming a site on page 36.

• Connecting to an existing site on page 36.

• Connecting to a site when you fail to the first time you open of Control 
Center on page 37.

• Working at multiple sites and connecting to management gateways other 
computers on page 37.

Related topics

For information about:

• How to create and manage users in Control Center, see Managing users on 
page 39.

• The first steps you take to get started in Control Center, see First steps in 
Control Center on page 26.

Renaming a site
1 Right-click the site node and select Rename. The Edit Site dialog box 

opens.

2 Enter a new name for the site and click OK. The Edit Site dialog box closes.

Connecting to an existing site
Each time you close Control Center, you are disconnected from all sites. When 
you open Control Center again, you must re-connect to the appropriate sites.

Prerequisites

Login details (case-sensitive) for a management gateway user. 

To connect to a site

1 Right-click the site node and select Connect. The Connect dialog box 
opens.
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2 Enter the user name and password for the management gateway user, and 
click OK.

Connecting to a site when you fail to the first time you 
open of Control Center

If you encounter problems the first time you open Control Center, you can 
manually configure a site and change the password for the Management Gateway 
Administrator.

To manually configure a site and change the password for the Man-
agement Gateway Administrator

1 Right-click the root node and select New Site. The New Site dialog box 
opens.

2 Enter the parameters for the site. See New Site dialog box on page 171.

3 Enter a new password for the Management Gateway Administrator and 
click OK.

Post requisites

You must now specify the connection settings to the enterprise repository. See 
Connecting to the enterprise repository on page 27.

Working at multiple sites and connecting to 
management gateways other computers

You can connect to a management gateway on another computer. This is 
necessary if you want to:

• Manage StreamServe applications on a computer at another site.

• Manage the StreamServe applications on a computer that does not run 
Control Center.

Prerequisites for connecting to a management gateway on another 
computer

• Host name or IP address of the computer with the management gateway that 
you want to connect to.

• Login details (case-sensitive) for a management gateway user on the 
computer.

• A valid root certificate for the management gateway.

To connect to a management gateway on another computer

1 Right-click the root node and select New Site. The New Site dialog box 
opens.
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2 Enter the parameters for the management gateway. See New Site dialog box 
on page 171.

3 Click OK to connect to the management gateway.
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Managing users
To log on to Control Center and manage the StreamServe applications on a 
computer, each user needs a login for the management gateway. Management 
gateway users can have different roles, which controls their access rights in 
Control Center.

Note: Management gateway user names and passwords are case-sensitive.

In this section

• Management Gateway Administrator on page 39.

• Roles and access rights on page 39.

• Creating new users on page 40.

• Removing users on page 41.

• Changing your password on page 41.

• Changing a password for another user on page 42.

Related topics

• Opening Control Center and changing the password for the Management 
Gateway Administrator on page 26.

Management Gateway Administrator
The Management Gateway Administrator is created with the Control Center and 
Framework setup, or Framework setup on UNIX. This user is assigned the 
Administrator role and can be used the first time you open Control Center. 

User name and password

The default (case-sensitive) user name for the Management Gateway 
Administrator is Administrator 

Changing the password

For security reasons, you must enter a new password for the Administrator the 
first time you open Control Center.

Removing the Management Gateway Administrator

It is possible to remove the Management Gateway Administrator providing you 
have another user with the Administrator role on the management gateway.

Roles and access rights
Users can be assigned an either an Administrator role or a Basic role. 
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Access rights for Administrators

Administrators have full access rights on the management gateway. Some 
examples of the privileges only available to Administrators include:

• Creating repositories and deploying hotfixes.

• Creating application domains.

• Forcing document type updates into the enterprise and runtime repositories 
when deploying Design Center Projects.

• Managing user accounts.

• Creating applications.

Access rights for basic users

Users assigned the basic role have the following access rights on the management 
gateway:

• Start/Stop/Restart applications. 

• Deploy Design Center Projects, but cannot force document type changes.

• Change their password.

• View properties, logs, etc.

Access to the StreamServe applications on a single management 
gateway

In Control Center, users are created at management gateway level. This means 
users can only access the StreamServe applications run on the same management 
gateway as their user account.

Creating new users 
When you create a new user, you must specify a role for the user. For information 
about roles, see Roles and access rights on page 39.

Prerequisites

Before you can create new users, you must:

• Configure an application domain.

• Add an application to the application domain.

Sites using more than one computer or management gateway to run 
StreamServe applications

In Control Center, users can only access the StreamServe applications on the 
same management gateway (or computer) as their user account. 

If a Control Center user needs to manage StreamServe applications on more than 
one management gateway (or computer), you must create separate users on each 
management gateway (or computer).
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To create a new user

Note: User names and passwords are case-sensitive.

1 In the tree node in Control Center, select the host you where you want to 
create the new user.

2 Right-click the host node and select Manage Users. The Manage Users 
dialog box opens.

3 Click Add. The Add User dialog box opens.

4 Configure the parameters for the new user. See Add User dialog box on 
page 224.

5 Click OK to close the Add User dialog box. The new user is added to the list 
of users in the Manage Users dialog box.

6 Click OK to close the Manage User dialog box.

Removing users

1 Right-click the host node and select Manage Users. The Manage Users 
dialog box opens.

2 Select the user you want to delete and click Remove. 

3 Select Yes to confirm you want to remove the user. The user is removed.

4 Click OK to close the Manage Users dialog box.

Changing the role for a user
1 Right-click the host node and select Manage Users. The Manage Users 

dialog box opens.

2 Select the user you want to change the role for and click Edit. The Edit User 
dialog box opens.

3 In the User privileges area, select the new role for the user. See Edit User 
dialog box on page 225.

4 Click OK to close the Edit User dialog box.

5 Click OK to close the Manage Users dialog box.

Changing your password
Note: Passwords are case-sensitive.

You must have at least one user with the Administrator role on each 
management gateway.
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1 Right-click the host node and select Change Password. The Change 
Password dialog box opens.

2 Enter the old password.

3 Enter and confirm a new password.

4 Click OK to close the Change Password dialog box.

Changing a password for another user
Note: Passwords are case-sensitive.

1 Right-click the host node and select Manage Users. The Manage Users 
dialog box opens.

2 Select the user you want to change the password for and click Edit. The Edit 
User dialog box opens.

3 Change the password for the user. See Edit User dialog box on page 225.

4 Click OK to close the Edit User dialog box. 

5 Click OK to close the Manage User dialog box.
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Finding installed StreamServe components
You can view the StreamServe components and version information installed on 
a computer. This information is required when you report an incident to 
StreamServe Support. 

Related topics

StreamServe support may also need the schema versions and hotfixes applied to 
the StreamServe repositories. See Listing schema versions and applied database 
hotfixes on page 34.

To find the StreamServe components installed on a computer

In the Control Center tree view, right-click the host and select View Installed 
Software.
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To run Design Center Projects from the Control Center, you must:

• Create an application domain.

• Create a runtime repository for the application domain.

• Add StreamServer applications to the application domain. You need one 
StreamServer application for each Design Center Project.

• Deploy the Design Center Projects to the StreamServer applications.

In this section

• Creating an application domain on page 46.

• Creating a runtime repository on page 49.

• Adding a StreamServer application on page 56.

• Deploying a Design Center Project on page 57.

• Redeploying a Design Center Project on page 60.

• Testing a StreamServer application using FastCopy on page 65.

• Adding scheduled tasks to the application domain on page 66.

Related topics

For information about:

• The first steps you must take to get started in Control Center and how to 
create the enterprise repository, see Getting Started on page 25.

• The additional configurations you must carry out to run StreamStudio, see 
StreamStudio configurations on page 69.

• How to manage the applications in a domain (starting, stopping, monitoring 
etc.), see Managing StreamServe applications on page 105.
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Creating an application domain
Before you can add any StreamServe applications, you must create an application 
domain for the applications.

In this section

• Creating and configuring an application domain on page 46.

• Editing an application domain on page 47.

• Deleting an application domain on page 48.

Creating and configuring an application domain
You configure the application domain using the Application Domain Editor.

If you import an application domain configuration, you must adjust the 
configuration to fit the actual conditions for your application domain. For 
example, if no user directory is to be used, you must select Disable directory 
server settings on the Directory tab, and if no web content repository is to be 
used, you must select Disable web content repository settings on the Web 
Content Repository tab.

Related topics

• Configuring the application domain for StreamStudio on page 70.

• Configuring the application domain for Composition Center on page 98.

Application domain name requirements

The application domain name must:

• Only include ASCII characters (a-z, A-Z, 0-9).

• Not include any white spaces.

To create and configure an application domain

1 Right-click the site node and select New Application Domain. The New 
Application Domain dialog box opens.

2 Enter a name for the application domain and select a version. See New 
Application Domain dialog box (Adding) on page 172.

3 Click OK. The New Application Domain dialog box opens.

4 Specify how you want to configure the new application domain. See New 
Application Domain dialog box (Selecting type) on page 173.

5 Click OK. The Application Domain Editor opens.

6 Configure the application domain. See Application Domain Editor on page 
174. 

7 Click OK.

You must now create the runtime repository for the application domain.
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Editing an application domain
You can edit an existing application domain. For example, if you want to move 
the database server to a different host, or update the passwords for the user 
accounts. This can be done while the applications in the application domain are 
running.

After you have edited the application domain, you must apply the changes to the 
applications and restart the applications. You can apply changes to:

• All the applications in the application domain at once.

• All the applications on a particular host (that are part of the application 
domain).

• A single application.

The status of the application domain configuration is displayed in the Application 
Domain property of each application:

• <Application domain> (Current) – The application is using the most 
recent version of the application domain configuration.

• <Application domain> Out of date – The application is using an old 
version of the application domain. The application domain configuration 
has been edited, but the new configuration has not been applied to the 
application.

To edit the application domain

1 Right-click the application domain and select Edit Application Domain. 
The Application Domain Editor opens.

2 Edit the application domain settings. See Application Domain Editor on 
page 174.

3 Click OK.

To apply the changes to the applications

1 Right-click the application domain, host, or application to apply the changes 
to and select Update Application Domain File.

2 Restart the affected applications.
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Deleting an application domain

Prerequisites

Before you can delete an application domain, you must delete all applications 
from the application domain. 

If you do not have access to the computer (host) where an application was created, 
you cannot delete the application. You must then remove the application from the 
application domain. 

See Deleting applications on page 107.

Repositories are not deleted

When you delete an application domain, the repositories specific for, or 
connected to, the application domain are not deleted. If you want to delete these 
repositories, you must do it manually in an external database administration tool.

To delete an application domain

1 Right-click the application domain and select Delete Application Domain.

2 Click Yes to confirm.
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Creating a runtime repository
You must create one runtime repository for each application domain. You can 
create the runtime repository directly from Control Center (for Microsoft SQL 
Server and Oracle). 

As an alternative, you can create the runtime repository manually. For example, 
if the company security policy prevents Control Center from connecting to the 
database, or if you want to have full traceability of the repository creation. First 
you generate the database scripts for the repository in Control Center and then you 
run the scripts using an external tool. 

When the runtime repository is created, you can apply database hotfixes to the 
repository directly from Control Center.

Prerequisites

• The runtime repository must use the same database vendor as StreamServe 
Enterprise Repository.

• If you use a named instance of SQL Server, the SQL Server Browser service 
must be started when you create the repository.

Post requisites

The created runtime repository is sufficient for development and testing purposes. 
In a production environment, you must adjust the runtime repository to fit the 
actual conditions (for example, configure filegroups, size and file growth 
parameters, etc). To adjust the runtime repository, you can use the DBMS 
(Database Management System). 

In this section

• Creating a runtime repository from Control Center on page 50.

• Creating a runtime repository manually on page 51.

• Listing and applying database hotfixes on page 54.

After creating a repository, always do a sanity check to make sure the 
repository was created according to your configurations.
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Creating a runtime repository from Control Center
This option is available for Microsoft SQL Server and Oracle.

Prerequisites

The login details for the database administration user are available:

• SQL Server – The login details for the sa user.

Note: For Microsoft SQL Server 2008 R2, you cannot create the repository 
directly from Control Center if the password contains certain 
characters. For example: [] {}() , ; ? * ! @
For more information, see:
http://msdn.microsoft.com/en-us/library/ms161962.aspx

• Oracle – The login details for the SYSDBA user.

To create the runtime repository for the application domain

1 Right-click the application domain and select Create Database. The Create 
Database dialog box opens.

2 In the Operation area, select Create now.

3 Select the runtime repository from the drop-down list.

4 Click Start to run the scripts. The Connect dialog box opens.

5 Enter the user name and password for the database administration user.

6 Click OK. The scripts to create the runtime repository are executed. A short 
version of the log is displayed in the Result log area.

Note: To view the full log in the default text editor, click Open Log File.

7 Click Close to close the Create Database dialog box.
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Creating a runtime repository manually
You can create the runtime repository manually. To do this, you must first 
generate the scripts for the repository in Control Center, and then you must run 
the scripts using an external tool.

In this section

• Generating database scripts for the runtime repository on page 51.

• Executing the scripts for the runtime repository (SQL Server) on page 52.

• Executing the scripts for the runtime repository (Oracle) on page 53.

Generating database scripts for the runtime repository
When you generate the database scripts from Control Center, the scripts are saved 
in the directory below. The scripts are saved as a ZIP file, which you can unpack 
using an archiving application, such as WinZip.

<Base directory>\<Version>\root\config\database\<Application 
domain>-<GUID>.zip

Where:

• <Base directory> – Is the path specified for StreamServe Projects during 
the Framework and Control Center installation.
For example: C:\ManagementGateway

• <Application domain> – Is the name of the application domain.

• <GUID> – Is a globally unique identifier for the ZIP file.

To generate database scripts for the runtime repository

1 Right-click the application domain and select Create Database. The Create 
Database dialog box opens.

2 In the Operation area, select Create scripts for later use.

3 Select the runtime repository from the drop-down list.

4 Click Start. The scripts for the runtime repository are generated. A short 
version of the log is displayed in the Result log area.

Note: To view the full log in the default text editor, click Open Log File.

5 A Control Center window opens, asking if you want to save a local copy of 
the scripts. Click Yes or No.

6 Click Close to close the Create Database dialog box.
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Executing the scripts for the runtime repository (SQL Server)
To create a runtime repository, you must:

• Run the load_as_sys.sql script to create the database.

• Run the load.sql script to create the tables etc. for the repository.

Prerequisites

• The login details for the system administrator user (sa) are available.

• A ZIP file (with the scripts for the repository) is generated in Control Center 
and unpacked using an archiving application, such as WinZip.

Post requisites

• Always do a sanity check to make sure the repository was created according 
to your configurations.

• Since the scripts contain passwords, it is recommended to delete the scripts 
after you have created the repository.

To execute the scripts for the repository

1 Open the appropriate SQL Server tool. For example, 
Microsoft® SQL Server™ Management Studio or SQLCMD.

2 Log in as the system administrator user (sa).

3 Run the load_as_sys.sql script.

4 Run the load.sql script in the database created in step 3 above.
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Executing the scripts for the runtime repository (Oracle)
To create a runtime repository, you must:

• Run the load_as_sys.sql script to create the schema.

• Run the load.sql script to create the tables etc. for the repository.

Prerequisites

• The login details for the SYSDBA user and the schema owner are available.

• A ZIP file (with the scripts for the repository) is generated in Control Center 
and unpacked using an archiving application, such as WinZip.

Post requisites

• Always do a sanity check to make sure the repository was created according 
to your configurations.

• Since the scripts contain passwords, it is recommended to delete the scripts 
after you have created the repository.

To execute the scripts for the repository

1 Since the password of the schema owner is the same as the schema owner 
user name, it is recommended to change the password in the 
load_as_sys.sql script.

2 Open the appropriate Oracle tool. For example, Oracle® SQL Developer or 
SQL*Plus (requires Oracle® Database Instant Client).

3 Log in as the SYSDBA user.

4 Run the load_as_sys.sql script.

5 Log in as the schema owner configured for the repository.

6 Run the load.sql script.
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Listing and applying database hotfixes
You can apply database hotfixes to the StreamServe repositories directly from 
Control Center. 

Before applying a hotfix, you can list all repositories that belong to a site, together 
with their current schema versions and the latest available hotfixes. This will give 
you an overview of the current statuses of the repositories and help you to decide 
whether the repositories need to be upgraded.

Prerequisites

• The login details for the database administration user are available.

• The setup for the hotfix has been run and the database hotfixes are installed 
in:

<Base directory>\<Version>\root\config\database\

Where <Base directory> is the path specified for StreamServe Projects 
during the Framework and Control Center installation.
For example: C:\ManagementGateway

In this section

• Listing schema versions and applied database hotfixes on page 54.

• Applying a database hotfix to the runtime repository on page 55.

Listing schema versions and applied database hotfixes
In Control Center, you can list all repositories that belongs to a site, together with 
their current schema versions and the latest available hotfixes. This will help you 
to decide whether or not a repository needs to be upgraded.

Prerequisites

• See Prerequisites on page 54.

To list available and applied database hotfixes

1 Right-click the site node and select Available Database Hotfixes. The 
Available Database Hotfixes dialog box opens.

2 Click Get List (if the dialog box is opened for the first time) or Update List 
(if the dialog box was previously opened). The Connect dialog box opens.

3 Enter the user name and password for the database administration user.

4 Click OK. In the Overview area, the repositories, current schema versions, 
and the latest available database hotfixes are listed. A log is displayed in the 
Result log area.

5 Click Close to close the Available Database Hotfixes dialog box.
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Applying a database hotfix to the runtime repository
You can apply the latest available database hotfix to a runtime repository directly 
from Control Center.

Prerequisites and recommendations

• See Prerequisites on page 54.

• Before applying a database hotfix, the following is recommended:

– Make sure that no other users are connected to the repository. If 
possible, set the repository in single user mode.

– Make sure that all jobs running against the repository are completed.

– Stop all applications accessing the repository.

– Perform a backup of the repository.

Always read the hotfix documentation for additional preparations for a 
specific hotfix.

To apply a hotfix from Control Center

1 Right-click the application domain and select Create Database. The Create 
Database dialog box opens.

2 In the Operation area, select Apply database hotfix.

3 Select the runtime repository from the drop-down list.

4 Click Start to apply the latest available database hotfix in the base directory. 
The Connect dialog box opens.

5 Enter the user name and password for the database administration user.

6 Click OK. The database hotfix is applied to the runtime repository. A short 
version of the log is displayed in the Result log area.

Note: To view the full log in the default text editor, click Open Log File.

7 Click Close to close the Create Database dialog box.
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Adding a StreamServer application
You must add the required StreamServer applications to the application domain. 
You need one StreamServer application for each Design Center Project.

You can add applications on your local host, or on remote hosts that are part of 
the site. The remote host must be configured to use the StreamServe Enterprise 
Repository that the site is connected to.

To add a new application

1 Right-click the application domain and select New Application. The New 
Application dialog box opens.

2 From the Application host drop-down list, select the host used to run the 
application.

3 Configure the application properties. See New Application dialog box on 
page 188.

4 Click OK.

You can now deploy a Design Center Project to the application.

To add an application on a remote host

1 Right-click the application domain and select New Application. The New 
Application dialog box opens.

2 From the Application host drop-down list, select Show all. All the hosts in 
the site are displayed.

3 Select the host for the application.

4 Configure the application properties. See New Application dialog box on 
page 188.

5 Click OK. The Connect dialog box opens.

6 Enter the user name and password for a management gateway user and click 
OK.

The remote host and application are added to the tree view. You can now 
deploy a Design Center Project to the application.
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Deploying a Design Center Project
To run a StreamServer application, you must deploy an export file for a Project to 
the application. Each time you export a new version of the Project in Design 
Center, you must redeploy the export file in Control Center.

You can deploy an export file from the file system or from the version control 
system.

Extracting the export file to the working directory

When you deploy the export file, the content of the file is extracted to the working 
directory for the application. The path for this directory is:

<Base directory>\<Version>\root\applications\<Application name>

Where: 

• <Base directory> – Is the path specified for StreamServe Projects during 
the Framework and Control Center installation. 
For example: C:\ManagementGateway

• <Application name> – Is the name of the StreamServer application.

Deploying document types

For information about how document types are deployed to the StreamServe 
repositories, see Document type deployment overview on page 19.

In this section

• Deploying a Project from the file system on page 57.

• Deploying a Project from a version control system on page 58.

Deploying a Project from the file system
1 Right-click the application domain for the Project and select Deploy export 

file. The Deploy wizard opens.

2 Select the StreamServer application(s) to deploy the export file to and click 
Next.

3 Select Deploy an export file from the file system, browse to the export 
file for the Project and click Next.

4 Select the physical layer to deploy and click Finish.
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Deploying a Project from a version control system
You can connect Control Center to a version control system. This enables you to 
deploy export files that have been checked in to the version control system in 
Design Center. 

Before you can deploy the export file for a Project from a version control system, 
you must configure a connection to the system, either in Design Center or in 
Control Center. Connections configured to version control systems in a Design 
Center instance running on the same computer are automatically available in 
Control Center.

In this section

• Connecting to a version control system on page 58.

• Deploying an export file from a version control system on page 59.

Connecting to a version control system

To configure a connection to a version control system

1 Select File > Version Control > Manage VCS Connections. The Open 
VCS connection dialog box opens.

2 Click Add to add a new connection. The Add VCS connection dialog box 
opens.

3 Select the VCS system you want to create a connection to, and click OK. 
The Add VCS connection dialog box opens.

4 Enter a name for the connection and click OK. The Add connection dialog 
box opens.

5 Configure the CVS connection, see Add connection dialog box on page 163.

To connect to a version control system

1 Select File > Version Control > Connect.

2 Enter a user name and password to login to the version control system if 
prompted.

To disconnect from a version control system

Select File > Version Control > Disconnect.
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Deploying an export file from a version control system
1 Right-click the application domain for the Project and select Deploy export 

file. The Deploy wizard opens.

2 Select the StreamServer application(s) to deploy the export file to and click 
Next.

3 Select Deploy an export file from a version control system, the 
connection profile and click Next.

4 Enter the user name and password to connect to the version control system.

5 Browse to the export file for the Project, select the revision of the file to 
deploy and click Next. 

6 Select the physical layer and click Finish.
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Redeploying a Design Center Project
Every time you update a Design Center Project, you must export the Project and 
redeploy the Project export file to the StreamServer application.

If the Project includes modified document types or modified StoryTeller 
Processes, that are used as templates in Composition Center, you may not be 
allowed to redeploy the Project.

All or nothing is deployed

If the redeployment for some reason fails, none of the Project updates are 
deployed. The export file used before the failed redeployment remains on the 
StreamServe application. For example, if a Project contains several updated 
document types and all changes except one are accepted for redeployment, none 
of the updates are deployed.

Prerequisites

If the Project includes modified document types and the documents are stored in 
a StreamServe archive, it is recommended to let the Archiver applications finish 
any ongoing archiving tasks and then stop the applications. 

To redeploy a Project

Right-click the StreamServer application and select Redeploy.

To redeploy a Project with modified document types

1 Right-click the StreamServer application and select Redeploy. The 
document types in the updated Project are compared with the existing 
document types in StreamServe Enterprise Repository. 

2 If the document types differ, the Compare Document Types tool opens:

a Examine the information in the tool. The type of difference determines 
whether you can complete the redeploy operation.

Message storages and Post-processing storages

If the Project includes paused Messages in Message storages or 
documents in Post-processing storages, any updates are applied to 
these Messages or documents at redeploy. Some updates may corrupt 
already paused Messages or documents.

To achieve full control over the layout and behavior, you should 
ensure that any Message and Post-processing storages are empty 
before redeploying a Project – either by letting the jobs complete or by 
manually emptying the storages. 

You can examine, empty and drop Message and Post-processing 
storages using Database Administration Tool. You can launch this tool 
directly from Control Center by right-clicking the application domain 
and selecting Launch Database Administration Tool.
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b Click OK or Cancel.

If the redeploy succeeds, any modified document types are updated in the 
enterprise repository. When the StreamServer and Archiver applications are 
restarted, the document types are updated in the runtime repository and in the 
StreamServe archive.

If the redeploy fails due to modified document types, you can either:

• Revert to a previous version of the Project, with the existing document 
types, and redeploy this Project.

• Keep the updated Project and force the modified document types into 
the enterprise repository and the runtime repository.

To redeploy a Project with modified StoryTeller Processes

1 Right-click the StreamServer application and select Redeploy. The 
StoryTeller Processes in the Project are compared with existing templates in 
the StreamServe Enterprise Repository. 

2 If no differences are found, the Project is successfully redeployed. If there 
are differences, the Compare Composition Center Templates tool opens:

a Examine the information in the tool. Depending on the type of 
difference, you must either modify the StoryTeller Process or modify 
the version number.

b Click OK or Cancel.

3 Open the StoryTeller Process in StoryTeller and modify the document or 
the version number.

In this section

• Forcing document types into the repositories on page 62.

• Deleting document types from the repositories on page 63.

• Deleting Composition Center templates from the repositories on page 64

Related topics

• For a list of consequences (in StreamServe repositories and in 
StreamStudio) when redeploying modified document types, see 
Consequences of redeploying modified document types in the Document 
types and metadata documentation.

• For information about Composition Center template versioning and what 
Project changes that can affect the possibility to redeploy Projects used with 
Composition Center, see Modifying Composition Center Projects in the 
Composition Center documentation.
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Forcing document types into the repositories
Once a document type is deployed to the StreamServe repositories, there are strict 
rules for how the document type can be modified in Design Center. Unless these 
rules are fulfilled, you cannot redeploy the Project in Control Center. 

However, if a modification is necessary, you can force a modified document type 
into the enterprise repository and the runtime repository at redeploy.

Note: Forcing a document type into the enterprise and the runtime repositories 
does not affect the document type in the StreamServe archive.

Note: You cannot force a document type with a revision that is older than the 
one in the enterprise repository.

Prerequisites

• Make sure you have a complete backup of the runtime repository.

• Depending on how the document type is modified, you must make different 
preparations. For lists of the required preparations for different types of 
modifications, see Changes that require database manipulation in the 
Document types and metadata documentation.

Post requisites

If the document type contains modified metadata used in StreamStudio, the 
metadata in StreamStudio must be updated accordingly. For example, if the 
metadata is used in texts and rules in Composition Center, these texts and rules 
must be updated.

To force a document type into the runtime repository

1 Right-click the StreamServer application and select Redeploy. The 
Compare Document Types tool opens.

2 Click Force update. The Force Document Type Update dialog box dialog 
box opens.

3 Click Start to force the document type into the repositories.

At the preparations, you can use Database Administration 
Tool. You can launch this tool directly from Control Center 
by right-clicking the application domain and selecting 
Launch Database Administration Tool.
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Deleting document types from the repositories
If a document type is deleted from a Design Center Project, and the Project is 
redeployed, the document type is not automatically removed from the 
StreamServe repositories. 

In Control Center, you can manually delete the removed document type from the 
enterprise repository and from the runtime repository.

Note: Deleting a document type from the enterprise and the runtime repositories 
does not affect the document type in the StreamServe archive.

Prerequisites

• Make sure you have a complete backup of the runtime repository.

• For a list of the required preparations before you can delete a document 
type, see Deleting document types in enterprise and runtime repository in 
the Document types and metadata documentation. 

To delete a document type from the enterprise repository

1 Right-click the Site node and select Manage Document Types. The 
Manage Document Types dialog box opens.

2 Select the document type you want to delete and click Delete.

Related topics

For a list of the consequences (in StreamServe repositories and in StreamStudio) 
when deleting document types, see Deleting document type resources (redeploy) 
in the Document types and metadata documentation.

At the preparations, you can use Database Administration 
Tool. You can launch this tool directly from Control Center 
by right-clicking the application domain and selecting 
Launch Database Administration Tool.
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Deleting Composition Center templates from the 
repositories

If a StoryTeller Process is deleted from a Design Center Project and the Project is 
redeployed, the corresponding Composition Center template is not automatically 
removed from the StreamServe repositories. 

In Control Center, you can manually delete the removed templates from the 
enterprise repository and the runtime repository.

Prerequisites

Make sure you have a complete backup of the runtime repository.

To delete a template from the enterprise repository

1 Right-click the Site node and select Manage Templates. The Manage 
Templates dialog box opens.

2 Select the template you want to delete and click Delete.

References

For more information about deleting Composition Center templates, see 
Renaming or deleting templates in the Composition Center documentation.
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Testing a StreamServer application using 
FastCopy

You can use FastCopy to test StreamServer applications with one or more 
Directory input connectors. FastCopy copies files from a source directory to a 
destination directory. The source and destination directories can be located on a 
local drive or on a remote host.

To open the FastCopy view

Right-click the application and select FastCopy View.

To create a new Source/Destination pair

1 Right-click the FastCopy view and select Create Pair. The Source and 
Destination dialog box opens.

2 Specify the paths to the source and destination directories and click OK.

To duplicate an existing Source/Destination pair

Right-click the Source/Destination pair and select Duplicate.

To edit a Source/Destination pair

1 Right-click the Source/Destination pair and select Edit Pair. The Source 
and Destination dialog box opens.

2 Specify the paths to the source and destination directories and click OK.

To use FastCopy

Right-click the Source/Destination pair and select Transfer files.

Note: To be able to use FastCopy, the StreamServer application must be started. 
See Starting, stopping, and restarting applications on page 106.

To edit the source file

1 Right-click the Source/Destination pair and select Edit Source. The source 
file opens in an editor.

2 Edit and save the source file.

To delete a Source/Destination pair

1 Right-click the Source/Destination pair and select Delete Pair.

2 Click OK to save the changes.
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Adding scheduled tasks to the application 
domain

You can add a Task Scheduler application to your application domain and 
schedule one or several tasks to be carried out by the application. For example:

• A task that triggers maintenance of the runtime repository each night at 
1:00 a.m. 

• A task that deletes expired StreamServe jobs from the runtime repository 
every 60 minutes.

To ensure that the tasks are executed even if the Task Scheduler application goes 
down, you can add several Task Scheduler applications and schedule the tasks for 
each one of these applications.

Tasks by default performed by StreamServer applications

By default, the following tasks related to the runtime repository are performed by 
the StreamServer applications in your application domain:

• Update statuses of top jobs.

• Delete expired jobs.

• Delete expired Messages from Message storages.

• Delete expired documents from Post-processing storages.

You can let one or several Task Scheduler applications perform these tasks 
instead. For information about when to use Task Scheduler applications for these 
tasks and how to disable the corresponding tasks for the StreamServer 
applications, see the Database Guidelines.

Repository maintenance

You can set up a task to trigger database maintenance on a specified repository in 
the application domain. For information about the maintenance package and how 
to use Task Scheduler applications to trigger database maintenance, see the 
Database Guidelines.

In this section

• Adding and configuring a Task Scheduler application on page 67.

Related topics

• Database Guidelines for SQL Server

• Database Guidelines for Oracle

The guidelines are available at http://streamshare.streamserve.com/Downloads/
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Adding and configuring a Task Scheduler application
You can add Task Scheduler applications on your local host, or on remote hosts 
that are part of the site. The remote host must be configured to use the 
StreamServe Enterprise Repository that the site is connected to.

Post requisites

To be able to start a Task Scheduler application and run the scheduled tasks, a 
runtime repository must be created for the application domain. 

To add and configure a Task Scheduler

1 Right-click the application domain and select New Application. The New 
Application dialog box opens.

2 From the Application host drop-down list, select the host used to run the 
application.

3 Configure the application properties.

Note: You cannot use the name Task Scheduler if you run the application 
on a Windows host, since this name is used by a Windows service.

4 Click OK. The Task Scheduler application is added to the application 
domain and the Configuration dialog box opens.

5 Configure the application log level and the scheduled tasks, see:

• Configuration dialog box (Task Scheduler) on page 195.

• Service Configuration dialog box (Task Scheduler) on page 196.

• Scheduler Configuration dialog box on page 199.

6 Click OK.

To add and configure a Task Scheduler on a remote host

1 Right-click the application domain and select New Application. The New 
Application dialog box opens.

2 From the Application host drop-down list, select Show all. All the hosts in 
the site are displayed.

3 Select the host for the application.

4 Configure the application properties.

Note: You cannot use the name Task Scheduler if you run the application 
on a Windows host, since this name is used by a Windows service.

5 Click OK. The Connect dialog box opens.

6 Enter the user name and password for a management gateway user and click 
OK. The remote host and Task Scheduler application are added to the tree 
view and the Configuration dialog box opens.

7 Configure the application log level and the scheduled tasks.

8 Click OK.
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To run StreamStudio web applications in an application domain, you must:

• Configure the application domain for StreamStudio.

• Add a service gateway application to the application domain.

• Add a StreamStudio web portal.

• Connect the web portal to the application domain.

In this section

• Configuring the application domain for StreamStudio on page 70.

• Adding a service gateway application on page 76.

• Adding a StreamStudio web portal on page 77.

• Connecting the StreamStudio web portal on page 79.

Related topics

For information about:

• The basic configurations you must carry out to run StreamServer 
applications, see StreamServer configurations on page 45.

• The additional configurations you must carry out to run StreamStudio 
Collector, see StreamStudio Collector configurations on page 81.

• The additional configurations you must carry out to run StreamStudio 
Composition Center, see StreamStudio Composition Center configurations 
on page 97.

• How to manage the applications in a domain (starting, stopping, monitoring 
etc.), see Managing StreamServe applications on page 105.

• Any StreamStudio administrator’s tasks not related to Control Center, see 
the StreamStudio Administrator’s Guide. For example, how to install and 
run StreamStudio, how to load balance service gateways, etc.
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Configuring the application domain for 
StreamStudio

In addition to the basic application domain configurations, you must also 
configure the application domain for StreamStudio. In the Application Domain 
Editor, you configure the StreamStudio web access, the user directories, and the 
service gateway web service(s). To improve robustness, you can also configure 
recovery settings for the user directories.

For information about basic application domain configurations and how to edit an 
existing application domain, see Creating an application domain on page 46.

After editing or deleting an existing application domain, you must restart the 
StreamStudio application for the changes to take effect. When adding a new 
application domain, you do not have to re-start the StreamStudio application.

In this section

• Configuring access from StreamStudio on page 70.

• Configuring user directories on page 71.

• Configuring web service communication on page 74.

• Configuring recovery settings for user directories on page 75.

Configuring access from StreamStudio
To limit access from StreamStudio to the Queue repository and the StreamServe 
archive, there are two repositories used to store information about users with web 
access – the Security repository and the Web Access repository. The Security 
repository is used by the service gateway to authenticate the user logging in to 
StreamStudio. The Web Access repository is used by the service gateway to give 
the StreamStudio user access to web applications and documents.

You can use the default connection profiles to access the repositories, but for 
security reasons it is recommended to change the connection profiles for both the 
Security repository user and the Web Access repository user.

To configure StreamStudio access

1 In Control Center, right-click the application domain and select Edit 
Application Domain. The Application Domain Editor opens.

2 Select the Runtime Repository tab.

3 Configure the user name and password for the connection profiles for both 
the Security and the Web Access repositories. See Runtime Repository tab 
on page 175.

4 Click OK to save the application domain configuration, or continue the 
configuration on the next tab.
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Configuring user directories
To integrate StreamStudio with a directory server, you must specify the directory 
settings for external and internal users of the directory server. You can use two 
separate directories for the internal and external users respectively, or a single 
directory for all users (with the external and internal users in separate locations).

The directory server must support the LDAP protocol. You can either use 
Microsoft Active Directory or a generic LDAPv3 compliant directory, for 
example OpenDS.

To access StreamStudio without a user directory

1 In Control Center, right-click the application domain and select Edit 
Application Domain. The Application Domain editor opens.

2 Select the Directory tab.

3 Select Disable directory server settings.

4 Click OK to save the application domain configuration, or continue the 
configuration on the next tab.

To configure the user directories

1 In Control Center, right-click the application domain and select Edit 
Application Domain. The Application Domain editor opens.

2 Select the Directory tab.

3 Configure the internal and external user directories. See:

• Directory tab on page 178.

• LDAP attribute syntax on page 72.

• Storing external and internal users in the same directory on page 73.

4 Click OK to save the application domain configuration, or continue the 
configuration on the next tab.

You can access StreamStudio without a user directory. For example, if 
the company is small and does not have a user directory, or if you want 
to demonstrate or test StreamStudio without a directory connection. 

The only available user is then the application domain administrator, 
by default assigned the StreamStudio System Manager role. The 
application domain administrator is specified on the Administrator tab 
in the Application Domain Editor. See Administrator tab on page 174.
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LDAP attribute syntax
When configuring the user directories for an application domain, you specify 
LDAP attributes that will be used in queries against the directory server. You 
specify these attributes on the Directory tab in the Application Domain Editor.

For example, you can specify attributes for controlling senders or receivers of 
jobs. You can also specify attributes for translating a user logging into 
StreamStudio into a qualified distinguished name. The distinguished name 
together with the password that the StreamStudio user specify are used to 
authenticate the user in the user directory.

For example, for OpenDS, the following default attributes are suggested (in the 
Translate name attributes setting) to translate a StreamStudio user into a 
qualified distinguished name:

uid="%1" || cn="%1"

Where:

• uid (user ID) and cn (common name) are standardized X.500 attributes.

• || is a logical "OR"

• %1 is a placeholder which will be substituted by the user name that the user 
specify when logging into StreamStudio.

To be translated into a distinguished name, there must be either a user ID or a 
common name in the user directory. See the example below.

You can also specify additional attributes. For example, to enable the user to log 
in also with an email address or a phone number, you can add the email and phone 
attributes:

uid="%1" || cn="%1" || mail="%1" || phone="%1"

Note: In order to enhance search performance in the user directory, you should 
only use attributes that are indexed.

Example 1 Translate name attributes

In this example, the default attributes are used to translate a user logging in to 
StreamStudio into a qualified distinguished name:

Translate name attributes: uid="%1" || cn="%1"

When a user with the user ID User123 logs on to StreamStudio, the attributes in 
the query sent to the directory server is as follows:

uid="User123" || cn="user123"

In order for the user to be translated into a qualified distinguished name, there 
must be either a user ID called User123 or a common name called User123 in the 
user directory.
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Storing external and internal users in the same directory
You can use two separate directories for the internal and external users 
respectively, or a single directory for all users (with the external and internal users 
in separate locations).

Example 2 Storing external and internal users in the same directory

In this example, external and internal users are stored in separate locations in the 
same user directory. In this example, the locations are called internal and 
external, but these could be any locations.

In the Host name field, the same host is specified for the external and the internal 
user directories.

In the DN Base field for the internal user directory, the internal branch is entered 
on the level below the organization name:

ou=internal, dc=telco, dc=com

In the DN Base field for the external user directory, the external branch is entered 
on the level below the organization name:

ou=external, dc=telco, dc=com
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Configuring web service communication
StreamStudio accesses the runtime repository and the user directory using web 
services, hosted by a service gateway. The service gateway listens to a specified 
port on the host to which the application domain belongs.

If you add more than one service gateway to the application domain, you must 
select which is the primary and which is the secondary service gateway in the 
Application Domain Editor.

In the Application Domain Editor, you can also enable web service security for 
the web service requests to the service gateways in the application domain.

In this section

• Selecting primary and secondary service gateways on page 74.

• Enabling web service security on page 75.

Related topics

• Adding a service gateway application on page 76.

Selecting primary and secondary service gateways
If you add more than one service gateway application to your application domain, 
you must select which is the primary and which is the secondary service gateway.

Prerequisites

The service gateway applications must be added to the application domain. See 
Adding a service gateway application on page 76.

To configure service gateways for web services

1 In Control Center, right-click the application domain and select Edit 
Application Domain. The Application Domain Editor opens.

2 Select the Web Services tab.

3 Select the primary and secondary service gateway instances. See Web 
Services tab on page 182.

4 Click OK to save the application domain configuration, or continue the 
configuration on the next tab.
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Enabling web service security
You can specify that all web service requests to the service gateway(s) in the 
application domain are authenticated with the credentials of the user logged in.

Post requisites

• If you use Ad Hoc Correspondence or Correspondence Reviewer, you must 
also specify the user whose credentials will be used for authentication.

• When using web service security, it is recommended to encrypt the 
communication by configuring a Trusted Communication Channel (TCC).

For more information, see the Security documentation, available at StreamShare.

To enable web service security

1 In Control Center, right-click the application domain and select Edit 
Application Domain. The Application Domain Editor opens.

2 Select the Web Services tab.

3 Select Enable Web Service security.

4 Click OK to save the application domain configuration, or continue the 
configuration on the next tab.

Configuring recovery settings for user directories
To improve robustness, you can configure recovery settings for the user 
directories. These recovery settings can differ from the recovery settings for the 
runtime repository.

To configure recovery settings for the user directories

1 In Control Center, right-click the application domain and select Edit 
Application Domain. The Application Domain Editor opens.

2 Select the Recovery tab.

3 Configure the recovery settings for the internal and external user 
directories. See Recovery tab on page 181.

4 Click OK to save the application domain configuration, or continue the 
configuration on the next tab.
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Adding a service gateway application
To use the StreamStudio web applications, you must add a service gateway 
application to the application domain. For failover and load balancing reasons, 
you can add more service gateways.

You can add service gateways to your local host, or to remote hosts that are part 
of the site. To be a part of the site, the remote hosts must be configured to use the 
enterprise repository that the site is connected to.

Post requisites

• If you add more than one service gateway to the application domain, you 
must select which is the primary and which is the secondary service 
gateway in the Application Domain Editor. See Selecting primary and 
secondary service gateways on page 74

• By default, the first added service gateway listens to port number 2718. For 
each service gateway that you add, the port number is increased by one. 
You can update these port numbers in the service gateway properties. See 
Updating application properties on page 109.

To add a new service gateway

1 Right-click the application domain and select New Application. The New 
Application dialog box opens.

2 From the Application host drop-down list, select the host used to run the 
service gateway.

3 Configure the service gateway properties. 

4 Click OK.

To add a service gateway on a remote host

1 Right-click the application domain and select New Application. The New 
Application dialog box opens.

2 From the Application host drop-down list, select Show all. All the hosts in 
the site are displayed.

3 Select the host for the application.

4 Configure the application properties.

5 Click OK. The Connect dialog box opens.

6 Enter the user name and password for a management gateway user. 

7 Click OK. The remote host and application are added to the tree view.

Related topics

• For information on how to load-balance service gateways, see the 
StreamStudio Administrator’s Guide.
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Adding a StreamStudio web portal
To use the StreamStudio web applications, you must add a StreamStudio web 
portal to the StreamStudio Portals folder. The web portal is then available to all 
application domains at the site. Several application domains can share one web 
portal.

When you have added the web portal, you must connect the portal to the 
application domains in which you want to use the portal.

Deploy StreamStudio from Control Center

When you configure the web portal in Control Center, you specify the directory 
(that is, the portal root) on the Java application server to which you want to deploy 
the StreamStudio web archive file. The management gateway copies the file to the 
specified portal root from where the file can be unpacked.

Deploy several StreamStudio web portals

Several StreamStudio web portals can be deployed to the same Java application 
server. This enables you to run StreamStudio Persuasion SP4 and later Persuasion 
versions on the same application server. The earliest release must then be installed 
first.

Deploy manually in isolated environments

A common production scenario is that Framework and Control Center is installed 
on a different computer than the Java application server. Using the Manual 
deploy option in the Add StreamStudio Portal dialog box, you can still configure 
the StreamStudio environment in Control Center. Then you must manually copy 
the web archive file and the web portal configuration file to the computer where 
the Java application server is installed. For more information, see the 
StreamStudio Administrator’s Guide.

Web portal name requirements

The web portal name must:

• Only include ASCII characters (a-z, A-Z, 0-9).

• Not include any white spaces.

• Be unique if you deploy several web portals to the same Java application 
server.

• Not be the word applications.

Deploying several StreamStudio web portals to the same Java 
application server is resource intensive (i.e. memory) and may result 
in decreased performance.
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To add a StreamStudio web portal

1 Right-click the StreamStudio Portals folder and select Add StreamStudio 
Portal. The Add StreamStudio Portal dialog box opens.

2 Configure the StreamStudio web portal. See Add StreamStudio Portal 
dialog box on page 211.

3 Click OK.

The management gateway copies the file to the specified directory from 
where the file can be unpacked. For information on how to unpack the file, 
see the user documentation for the Java application server. For Apache 
Tomcat, the file may be unpacked automatically if you restart the Apache 
Tomcat service.

You must now connect the web portal to the application domains in which 
you want to use the portal.
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Connecting the StreamStudio web portal
You must connect the StreamStudio web portal to the application domains in 
which you want to use the portal. You can either connect the web portal directly 
from the StreamStudio Portals folder, or from the application domain.

Prerequisites

• The StreamStudio web portal must be available in the StreamStudio Portals 
folder. 

• If you deploy StreamStudio from Control Center, the StreamStudio web 
archive file must be copied to the portal root and unpacked by the Java 
application server.

To connect a web portal from the StreamStudio Portals folder

1 In the StreamStudio Portals folder, right-click the StreamStudio web portal 
and select Link Application Domain. The Link Application Domain dialog 
box opens.

2 In the Available Application Domains area, select the application domains 
to which you want to add the StreamStudio web portal.

3 Click the arrow button to connect the web portal to the application domain.

4 Click OK.

To connect a web portal from the application domain folder

1 Right-click the application domain folder and select Link StreamStudio 
Portal. The Link StreamStudio Portal dialog box opens.

2 From the Available portals list, select the web portal that you want to add 
to the application domain.

3 Click OK.
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To run StreamStudio Collector in the application domain, you must:

• Add and configure a StreamServe archive.

• Create the StreamServe archive.

• Connect the StreamServe archive to the application domain.

• Add an Archiver application to the application domain and configure the 
archiving tasks for the application.

In this section

• Creating a StreamServe archive on page 82.

• Connecting the StreamServe archive on page 90.

• Adding an Archiver application on page 91.

Related topics

For information about:

• The basic configurations you must carry out to run StreamServer 
applications, see StreamServer configurations on page 45.

• The basic configurations that you also must carry out to run StreamStudio, 
see StreamStudio configurations on page 69.

• How to manage the applications in a domain (starting, stopping, monitoring 
etc.), see Managing StreamServe applications on page 105.

• Any StreamStudio administrator’s tasks not related to Control Center, see 
the StreamStudio Administrator’s Guide. For example, how to install and 
run StreamStudio, how to load balance service gateways, etc.
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Creating a StreamServe archive
If you want to store output documents and related metadata, you must create a 
StreamServe archive. Each application domain can access one archive. One 
archive can be shared by several application domains. If one StreamServe archive 
is shared by several application domains, a Collector user can access all 
documents (created via all application domains) in the StreamServe archive.

First you add a StreamServe archive to the Archives folder and configure the 
database settings and the connection settings for the archive. Then you create the 
StreamServe archive according to the configuration you have made. 

You can create the StreamServe archive directly from Control Center. 

As an alternative, you can create the StreamServe archive manually. For example, 
if the company security policy prevents Control Center from connecting to the 
database, or if you want to have full traceability of the archive creation. First you 
generate the database scripts for the archive in Control Center and then you run 
the scripts using an external tool. 

When the StreamServe archive is created, you can apply database hotfixes to the 
archive directly from Control Center.

Prerequisites

• Microsoft SQL Server and Oracle can be used for the StreamServe archive.

• The StreamServe archive must use the same database vendor as the 
enterprise repository.
The StreamServe archive can be created in any reachable database – either 
in the same database as the runtime and web content repositories or on a 
separate database server. The fact that the StreamServe archive may contain 
large amounts of data must be considered. 

• If you use a named instance of SQL Server, the SQL Server Browser service 
must be started when you create the repository.

Improve search performance by using indexes

When a Collector user searches for documents in StreamStudio 
Collector, metadata is used as search criteria. By indexing the 
metadata in the StreamServe archive, search performance can be 
improved. However, increasing the number of indexes may have 
negative effect on the insert performance.

The question of indexing or not must be considered by a DBA 
(database administrator). The DBA must consult the Collector user for 
information about which indexes are the most frequently used. The 
DBA then performs the indexing using the DBMS (Database 
Management System) for the database.
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Post requisites

The created StreamServe archive is sufficient for development and testing 
purposes. In a production environment, you must adjust the archive to fit the 
actual conditions (for example, configure filegroups, size and file growth 
parameters, etc). You can use the DBMS to adjust the archive.

In this section

• Adding and configuring a StreamServe archive on page 84.

• Creating a StreamServe archive from Control Center on page 84.

• Creating a StreamServe archive manually on page 85.

• Listing and applying database hotfixes on page 88.
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Adding and configuring a StreamServe archive
You must add and configure the StreamServe archive in the Archives folder. 
After adding and configuring the StreamServe archive, you must also create the 
archive.

Name limitation

The name of the StreamServe archive cannot include underscore characters ("_").

To add and configure a StreamServe archive

1 Right-click the Archives folder, and select New Archive. The New Archive 
dialog box opens.

2 Configure the new archive. See New Archive dialog box on page 213.

3 Click OK. The Configuration dialog box opens.

4 Configure the properties for the archive. See Configuration dialog box 
(Archive) on page 214.

5 Click OK. The StreamServe archive is added to the Archives folder.

Note: You must now create the StreamServe archive.

Creating a StreamServe archive from Control Center
You can create the StreamServe archive directly from Control Center.

Prerequisites

• The login details for the database administration user are available.

Note: For Microsoft SQL Server 2008 R2, you cannot create the repository 
directly from Control Center if the password contains certain 
characters. For example: [] {}() , ; ? * ! @
For more information, see:
http://msdn.microsoft.com/en-us/library/ms161962.aspx

• A configured StreamServe archive is available in the Archives folder.

To create a StreamServe archive from Control Center

1 In the Archives folder, right-click the StreamServe archive and select 
Create Database. The Create Database dialog box opens.

2 In the Operation area, select Create now.

3 Select the StreamServe archive from the drop-down list.

After creating a repository, always do a sanity check to make sure the 
repository was created according to your configurations.
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4 Click Start to run the scripts. The Connect dialog box opens.

5 Enter the user name and password for the database administration user.

6 Click OK. The scripts to create the StreamServe archive are executed. A 
short version of the log is displayed in the Result log area.

Note: To view the full log in the default text editor, click Open Log File.

7 Click Close to close the Create Database dialog box.

Creating a StreamServe archive manually
You can create the StreamServe archive manually. To do this, you must first 
generate the scripts for the archive in Control Center, and then you must run the 
scripts using an external tool.

Prerequisites

A configured StreamServe archive is available in the Archives folder.

In this section

• Generating database scripts for the StreamServe archive on page 85.

• Executing the scripts for the StreamServe archive (SQL Server) on page 86.

• Executing the scripts for the StreamServe archive (Oracle) on page 87.

Generating database scripts for the StreamServe archive
When you generate the database scripts from Control Center, the scripts are saved 
in the directory below. The scripts are saved as a ZIP file, which you can unpack 
using an archiving application, such as WinZip. Since the scripts contains 
passwords, it is recommended to delete the scripts after you have used them to 
create the StreamServe archive.

<Base directory>\<Version>\root\config\database\<StreamServe 
archive>-<GUID>.zip

Where:

• <Base directory> – Is the path specified for StreamServe Projects during 
the Framework and Control Center installation.
For example: C:\ManagementGateway

• <StreamServe archive> – Is the name of the StreamServe archive.

• <GUID> – Is a globally unique identifier for the ZIP file.

After creating a repository, always do a sanity check to make sure the 
repository was created according to your configurations.
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To generate database scripts for the StreamServe archive

1 In the Archives folder, right-click the StreamServe archive and select 
Create Database. The Create Database dialog box opens.

2 In the Operation area, select Create scripts for later use.

3 Select the StreamServe archive from the drop-down list.

4 Click Start. The scripts for the StreamServe archive are generated. A short 
version of the log is displayed in the Result log area.

Note: To view the full log in the default text editor, click Open Log File.

5 A Control Center window opens, asking if you want to save a local copy of 
the scripts. Click Yes or No.

6 Click Close to close the Create Database dialog box.

Executing the scripts for the StreamServe archive (SQL Server)
To create a StreamServe archive, you must:

• Run the load_as_sys.sql script to create the database.

• Run the load.sql script to create the tables etc. for the repository.

Prerequisites

• The login details for the system administrator user (sa) are available.

• A ZIP file (with the scripts for the repository) is generated in Control Center 
and unpacked using an archiving application, such as WinZip.

Post requisites

• Always do a sanity check to make sure the repository was created according 
to your configurations.

• Since the scripts contain passwords, it is recommended to delete the scripts 
after you have created the repository.

To execute the scripts for the repository

1 Open the appropriate SQL Server tool. For example, 
Microsoft® SQL Server™ Management Studio or SQLCMD.

2 Log in as the system administrator user (sa).

3 Run the load_as_sys.sql script.

4 Run the load.sql script in the database created in step 3 above.
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Executing the scripts for the StreamServe archive (Oracle)
To create a StreamServe archive, you must:

• Run the load_as_sys.sql script to create the schema.

• Run the load.sql script to create the tables etc. for the repository.

Prerequisites

• The login details for the SYS user and the schema owner are available.

• A ZIP file (with the scripts for the repository) is generated in Control Center 
and unpacked using an archiving application, such as WinZip.

Post requisites

• Always do a sanity check to make sure the repository was created according 
to your configurations.

• Since the scripts contain passwords, it is recommended to delete the scripts 
after you have created the repository.

To execute the scripts for the repository

1 Since the password of the schema owner is the same as the schema owner 
user name, it is recommended to change the password in the 
load_as_sys.sql script.

2 Open the appropriate Oracle tool. For example, Oracle® SQL Developer or 
SQL*Plus (requires Oracle® Database Instant Client).

3 Log in as the SYS user.

4 Run the load_as_sys.sql script.

5 Log in as the schema owner configured for the repository.

6 Run the load.sql script.
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Listing and applying database hotfixes
You can apply database hotfixes to the StreamServe repositories directly from 
Control Center. 

Before applying a hotfix, you can list all repositories that belong to a site, together 
with their current schema versions and the latest available hotfixes. This will give 
you an overview of the current statuses of the repositories and help you to decide 
whether the repositories need to be upgraded.

Prerequisites

• The login details for the database administration user are available.

• The setup for the hotfix has been run and the database hotfixes are installed 
in:

<Base directory>\<Version>\root\config\database\

Where <Base directory> is the path specified for StreamServe Projects 
during the Framework and Control Center installation.
For example: C:\ManagementGateway

In this section

• Listing schema versions and applied database hotfixes on page 88.

• Applying a database hotfix to a StreamServe archive on page 89.

Listing schema versions and applied database hotfixes
In Control Center, you can list all repositories that belongs to a site, together with 
their current schema versions and the latest available hotfixes. This will help you 
to decide whether or not a repository needs to be upgraded.

Prerequisites

• See Prerequisites on page 88.

To list available and applied database hotfixes

1 Right-click the site node and select Available Database Hotfixes. The 
Available Database Hotfixes dialog box opens.

2 Click Get List (if the dialog box is opened for the first time) or Update List 
(if the dialog box was previously opened). The Connect dialog box opens.

3 Enter the user name and password for the database administration user.

4 Click OK. In the Overview area, the repositories, current schema versions, 
and the latest available database hotfixes are listed. A log is displayed in the 
Result log area.

5 Click Close to close the Available Database Hotfixes dialog box.
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Applying a database hotfix to a StreamServe archive
You can apply the latest available database hotfix to a StreamServe archive 
directly from Control Center.

Prerequisites and recommendations

• See Prerequisites on page 88.

• Before applying a database hotfix, the following is recommended:

– Make sure that no other users are connected to the repository. If 
possible, set the repository in single user mode.

– Stop all applications accessing the repository.

– Perform a backup of the repository.

Always read the hotfix documentation for additional preparations for a 
specific hotfix.

To apply a hotfix from Control Center

1 In the Archives folder, right-click the StreamServe archive and select 
Create Database. The Create Database dialog box opens.

2 In the Operation area, select Apply database hotfix.

3 Select the StreamServe archive from the drop-down list.

4 Click Start to apply the latest available database hotfix in the base directory. 
The Connect dialog box opens.

5 Enter the user name and password for the database administration user.

6 Click OK. The database hotfix is applied to the StreamServe archive. A 
short version of the log is displayed in the Result log area.

Note: To view the full log in the default text editor, click Open Log File.

7 Click Close to close the Create Database dialog box.
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Connecting the StreamServe archive
To store output documents and related metadata, you must connect the created 
StreamServe archive to the application domains containing the runtime 
repositories with the documents you want to archive. One StreamServe archive 
can be shared by several application domains.

You can either connect the StreamServe archive directly from the Archives 
folder, or from the application domain.

Note: If you have started the service gateway before you connect the 
StreamServe archive to the application domain, you must restart the 
service gateway after you have connected the StreamServe archive.

Prerequisites

The StreamServe archive must be available in the Archives folder.

To connect a StreamServe archive from the Archives folder

1 In the Archives folder, right-click the StreamServe archive and select Link 
Application Domain. The Link Application Domain dialog box opens.

2 In the Available Application Domains area, select the application domains 
you want to connect the StreamServe archive to.

3 Click the arrow button to connect the StreamServe archive to the 
application domain.

4 Click OK.

To connect a StreamServe archive from the application domain

1 Right-click the application domain and select Link Archive. The Link 
Archive dialog box opens.

2 From the Available Archives list, select the StreamServe archives you want 
to connect the application domain to.

3 Click OK.
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Adding an Archiver application
To enable archiving, you must add an Archiver application to the application 
domain and configure the archiving tasks to be carried out by the application. For 
failover and load balancing reasons, you can add additional Archiver 
applications.

Separate tasks for separate document types

For each Archiver application, you can configure one or several archiving tasks. 
If you have several document types, you can configure a separate task for each 
document type. For example, you can configure one task for pick lists which 
should be available at a warehouse as soon as possible, and another task for 
invoices which should be available only twice a month.

Batch contra continuous archiving

In the task configuration, you schedule how often the Archiver application should 
poll the output queue in the runtime repository for documents ready for archiving. 
When the Archiver application finds such documents, the documents and the 
related metadata are archived in one of the following ways:

• Batch archiving – At the specified polling interval, the Archiver 
application checks the number of documents in the output queue. If the 
number of documents equals or exceeds a certain value (the Task trigger 
(documents) setting in the Configuration dialog box), the Archiver 
application archives the batch of documents. By using batch archiving and 
directing the archiving to off peak hours, the load on the StreamServe 
archive can be decreased.

• Continuous archiving – The Archiver application archives any documents 
marked for archiving based on the specified poll interval. By using 
continuous archiving, documents are quickly available to the StreamStudio 
user.

You can configure several archiving tasks for the same Archiver application and 
combine batch and continuous tasks.

Documents moved per transfer

To reduce the load on a single Archiver application and decrease the impact of an 
archiving failure, documents are locked and transferred in smaller segments (the 
Documents moved per transfer setting in the Configuration dialog box). If you 
add several Archiver applications to an application domain, different segments 
can be archived by different applications. The workload is thereby spread among 
the Archiver applications, and the applications act as failover for each other.

Example 3 Triggered archiving events

In this example, the following is configured for an Archiver application:

• Type – Batch

• Task trigger (documents) – 40 documents
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• Documents moved per transfer – 100 documents

Depending on number of documents ready for archiving in the output queue, 
different archiving events are triggered.

In this section

• Adding and configuring an Archiver application on page 92.

• Editing an Archiver application on page 95.

Adding and configuring an Archiver application
To enable archiving, you must add an Archiver application to the application 
domain and configure the archiving tasks to be carried out by the application. 

It is possible to add applications on remote hosts that are part of the site, but not 
visible in Control Center. To do this, the host must be configured to use the 
StreamServe Enterprise Repository that the site is connected to.

Prerequisites

A Project must be deployed to a StreamServer application in the application 
domain. The document types are then available to the Archiver application, 
enabling you to configure different archiving tasks for different document types. 
See Deploying a Design Center Project on page 57.

To add and configure an Archiver application

1 Right-click the application domain and select New Application. The New 
Application dialog box opens.

2 From the Application host drop-down list, select the host used to run the 
application.

Number of 
documents in the 
output queue

Archiving events by the Archiver application

39 No archiving is triggered

40 The archiving is triggered, and 40 documents are locked 
and transferred in one segment (with 40 documents in the 
segment).

201 The archiving is triggered and 201 documents are locked 
and transferred in three segments (with 100, 100, and 1 
documents in the segments). 

100 000 The archiving is triggered and 100 000 documents are 
locked and transferred in 1 000 segments (with 100 
documents in each segment).
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3 Configure the application properties. See New Application dialog box on 
page 188.

4 Click OK. The Archiver application is added to the application domain and 
the Configuration dialog box opens.

5 Configure the application log level and the archiving tasks, see:

• Configuration dialog box (Archiver application) on page 191.

• Service Configuration dialog box (Archiver application) on page 192.

• Scheduling polling of the output queue on page 93.

6 Click OK.

To add and configure an Archiver application on a remote host

1 Right-click the application domain and select New Application. The New 
Application dialog box opens.

2 From the Application host drop-down list, select Show all. All the hosts in 
the site are displayed.

3 Configure the application properties.

4 Select the host for the application.

5 Click OK. The Connect dialog box opens.

6 Enter the user name and password for a management gateway user and click 
OK. The remote host and application are added to the tree view and the 
Configuration dialog box opens.

7 Configure the log level and the archiving tasks for the Archiver application.

8 Click OK.

Scheduling polling of the output queue
You must schedule the interval at which the Archiver application polls the output 
queue for documents ready for archiving. You can set a single time interval, or 
create more complex schedules.

If you specify a stop time (or end time), all ongoing archiving tasks will continue 
until the they are finished, even if the stop time is passed.

If a new task is scheduled to start before an on-going task has completed, the 
application first finalizes the ongoing task before the new task is started.

To open the Scheduler Configuration dialog box

1 Right-click the Archiver application and select Configuration. The 
Configuration dialog box opens.

2 If no archiving tasks are configured, select the (Item list) field and click the 
button to the right of the field. The Service Configuration dialog box opens.

Note: You can edit schedules for already existing tasks directly in the 
Configuration dialog box.
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3 Create a new task.

4 Select the Schedule field and click the button to the right of the field. The 
Scheduler Configuration dialog box opens. See Scheduler Configuration 
dialog box on page 199.

To add an interval

1 In the Scheduler Configuration dialog box, click New (Intervals area). A 
new item is added to the list.

2 In Define Interval, select a unit and enter the value.

To set a time frame for a specific interval

1 Select the interval.

2 Click New (Apply selected interval area). A new item is added to the area.

3 Select a unit (Year, Month, etc.) for the item and enter a Start and, 
optionally, an End value for the time frame.

To set a time frame for all intervals

You can set a time frame for when to apply all intervals in the list. In the Apply 
all intervals area, use Date and Time for Start and Stop to set the frame for all 
intervals.

Example 4 Schedule polling intervals

In this example, a schedule that causes the Archiver application to poll the output 
queue is configured. The action is triggered once every second Monday to 
Wednesday, and once every hour Thursday to Sunday is configured.
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Editing an Archiver application
You can edit the Archiver application log level and the archiving tasks for an 
Archiver application. You must restart the Archiver application for the changes 
to take effect.

To edit an Archiver application

1 Right-click the Archiver application and select Configuration. The 
Configuration dialog box opens.

2 Edit the log level and the archiving tasks. See Configuration dialog box 
(Archiver application) on page 191.

3 Restart the Archiver application.
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StreamStudio Composition Center 
configurations

To run StreamStudio Composition Center in your application domain, you must 
create a web content repository.

Note: The web content repository must be created before you start the 
StreamServer applications and before the StreamStudio user logs in to the 
Composition Center application.

Note: If you do not run StreamStudio Composition Center in the application 
domain, the Disable web content repository settings must be selected 
on the Web Content Repository tab in the Application Domain Editor.

In this section

• Configuring the application domain for Composition Center on page 98.

• Creating a web content repository on page 99.

Related topics

For information about:

• The basic configurations you must carry out to run StreamServer 
applications, see StreamServer configurations on page 45.

• The basic configurations that you also must carry out to run StreamStudio, 
see StreamStudio configurations on page 69.

• How to manage the applications in a domain (starting, stopping, monitoring 
etc.), see Managing StreamServe applications on page 105.

• Any StreamStudio administrator’s tasks not related to Control Center, see 
the StreamStudio Administrator’s Guide.
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Configuring the application domain for 
Composition Center

In addition to the basic application domain configuration, you must also configure 
the application domain for Composition Center. In the Application Domain 
Editor, you specify the database settings for the web content repository and the 
connection settings to access the repository.

For information about basic application domain configurations and how to edit an 
existing application domain, see Creating an application domain on page 46.

After editing or deleting an existing application domain, you must restart the 
StreamStudio application for the changes to take effect. When adding a new 
application domain, you do not have to re-start the StreamStudio application.

Note: If you do not run StreamStudio Composition Center in the application 
domain, the Disable web content repository settings should be selected 
on the Web Content Repository tab in the Application Domain Editor.

In this section

• Configuring the application domain for Composition Center on page 98.

• Creating a web content repository on page 99.

Configuring a web content repository
You must specify the database and connection settings for the web content 
repository.

You can use the default connection profiles to access the repository, but for 
security reasons it is recommended to change the connection profile.

To configure the web content repository

1 In Control Center, right-click the application domain and select Edit 
Application Domain. The Application Domain Editor opens.

2 Select the Web Content Repository tab.

3 Configure the web content repository. See Web Content Repository tab on 
page 183.

4 Click OK to save the application domain configuration, or continue the 
configuration on the next tab.
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Creating a web content repository
To run the StreamStudio Composition Center application, you must create a web 
content repository. You can create the web content repository directly from 
Control Center.

As an alternative, you can create the repository manually. For example, if the 
company security policy prevents Control Center from connecting to the 
database, or if you want to have full traceability of the repository creation. First 
you generate the database scripts for the repository in Control Center and then you 
run the scripts using an external tool.

When the web content repository is created, you can apply database hotfixes to 
the repository directly from Control Center.

Prerequisites

• Microsoft SQL Server and Oracle can be used for the web content 
repository.

• The web content repository must use the same database vendor as the 
enterprise repository.

• If you use a named instance of SQL Server, the SQL Server Browser service 
must be started when you create the repository.

In this section

• Creating a web content repository from Control Center on page 99.

• Creating a web content repository manually on page 100.

• Listing and applying database hotfixes on page 103.

Creating a web content repository from Control Center

Prerequisites

The login details for the database administration user are available.

Note: For Microsoft SQL Server 2008 R2, you cannot create the repository 
directly from Control Center if the password contains certain characters. 
For example: [] {}() , ; ? * ! @
For more information, see:
http://msdn.microsoft.com/en-us/library/ms161962.aspx

After creating a repository, always do a sanity check to make sure the 
repository was created according to your configurations.
StreamServe Persuasion SP5 Control Center User Guide Rev C

http://msdn.microsoft.com/en-us/library/ms161962.aspx


100 Creating a web content repository
StreamStudio Composition Center configurations
To create the web content repository for the application domain

1 Right-click the application domain and select Create Database. The Create 
Database dialog box opens.

2 In the Operation area, select Create now.

3 Select the web content repository from the drop-down list.

4 Click Start to run the scripts. The Connect dialog box opens.

5 Enter the user name and password for the database administration user.

6 Click OK. The scripts to create the web content repository are executed. A 
short version of the log is displayed in the Result log area.

Note: To view the full log in the default text editor, click Open Log File.

7 Click Close to close the Create Database dialog box.

Creating a web content repository manually
You can create the web content repository manually. To do this, you must first 
generate the scripts for the repository in Control Center, and then you must run 
the scripts using an external tool.

In this section

• Generating database scripts for the web content repository on page 100.

• Executing the scripts for the web content repository (SQL Server) on page 
101.

• Executing the scripts for the web content repository (Oracle) on page 102.

Generating database scripts for the web content repository
When you generate the database scripts from Control Center, the scripts are saved 
in the directory below. The scripts are saved as a ZIP file, which you can unpack 
using an archiving application, such as WinZip.

<Base directory>\<Version>\root\config\database\<Application 
domain>-<GUID>.zip

Where:

• <Base directory> – Is the path specified for StreamServe Projects during 
the Framework and Control Center installation.
For example: C:\ManagementGateway

• <Application domain> – Is the name of the application domain.

• <GUID> – Is a globally unique identifier for the ZIP file.

To generate database scripts for the web content repository

1 Right-click the application domain and select Create Database. The Create 
Database dialog box opens.
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2 In the Operation area, select Create scripts for later use.

3 Select the web content repository from the drop-down list.

4 Click Start. The scripts for the web content repository are generated. A 
short version of the log is displayed in the Result log area.

Note: To view the full log in the default text editor, click Open Log File.

5 A Control Center window opens, asking if you want to save a local copy of 
the scripts. Click Yes or No.

6 Click Close to close the Create Database dialog box.

Executing the scripts for the web content repository (SQL Server)
To create a web content repository, you must:

• Run the load_as_sys.sql script to create the database.

• Run the load.sql script to create the tables etc. for the repository.

Prerequisites

• The login details for the system administrator user (sa) are available.

• A ZIP file (with the scripts for the repository) is generated in Control Center 
and unpacked using an archiving application, such as WinZip.

Post requisites

• Always do a sanity check to make sure the repository was created according 
to your configurations.

• Since the scripts contain passwords, it is recommended to delete the scripts 
after you have created the repository.

To execute the scripts for the repository

1 Open the appropriate SQL Server tool. For example, 
Microsoft® SQL Server™ Management Studio or SQLCMD.

2 Log in as the system administrator user (sa).

3 Run the load_as_sys.sql script.

4 Run the load.sql script in the database created in step 3 above.
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Executing the scripts for the web content repository (Oracle)
To create a web content repository, you must:

• Run the load_as_sys.sql script to create the schema.

• Run the load.sql script to create the tables etc. for the repository.

Prerequisites

• The login details for the SYS user and the schema owner are available.

• A ZIP file (with the scripts for the repository) is generated in Control Center 
and unpacked using an archiving application, such as WinZip.

Post requisites

• Always do a sanity check to make sure the repository was created according 
to your configurations.

• Since the scripts contain passwords, it is recommended to delete the scripts 
after you have created the repository.

To execute the scripts for the repository

1 Since the password of the schema owner is the same as the schema owner 
user name, it is recommended to change the password in the 
load_as_sys.sql script.

2 Open the appropriate Oracle tool. For example, Oracle® SQL Developer or 
SQL*Plus (requires Oracle® Database Instant Client).

3 Log in as the SYS user.

4 Run the load_as_sys.sql script.

5 Log in as the schema owner configured for the repository.

6 Run the load.sql script.
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Listing and applying database hotfixes
You can apply database hotfixes to the StreamServe repositories directly from 
Control Center. 

Before applying a hotfix, you can list all repositories that belong to a site, together 
with their current schema versions and the latest available hotfixes. This will give 
you an overview of the current statuses of the repositories and help you to decide 
whether the repositories need to be upgraded.

Prerequisites

• The login details for the database administration user are available.

• The setup for the hotfix has been run and the database hotfixes are installed 
in:

<Base directory>\<Version>\root\config\database\

Where <Base directory> is the path specified for StreamServe Projects 
during the Framework and Control Center installation.
For example: C:\ManagementGateway

In this section

• Listing schema versions and applied database hotfixes on page 103.

• Applying a database hotfix to a web content repository on page 104.

Listing schema versions and applied database hotfixes
In Control Center, you can list all repositories that belongs to a site, together with 
their current schema versions and the latest available database hotfixes. This will 
help you to decide whether or not a repository needs to be upgraded.

Prerequisites

• See Prerequisites on page 103.

To list available and applied database hotfixes

1 Right-click the site node and select Available Database Hotfixes. The 
Available Database Hotfixes dialog box opens.

2 Click Get List (if the dialog box is opened for the first time) or Update List 
(if the dialog box was previously opened). The Connect dialog box opens.

3 Enter the user name and password for the database administration user.

4 Click OK. In the Overview area, the repositories, current schema versions, 
and the latest available database hotfixes are listed. A log is displayed in the 
Result log area.

5 Click Close to close the Available Database Hotfixes dialog box.
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Applying a database hotfix to a web content repository
You can apply the latest available database hotfix to a web content repository 
directly from Control Center.

Prerequisites and recommendations

• See Prerequisites on page 103.

• Before applying a database hotfix, the following is recommended:

– Make sure that no other users are connected to the repository. If 
possible, set the repository in single user mode.

– Stop all applications accessing the repository.

– Perform a backup of the repository.

Always read the hotfix documentation for additional preparations for a 
specific hotfix.

To apply a hotfix from Control Center

1 Right-click the application domain and select Create Database. The Create 
Database dialog box opens.

2 In the Operation area, select Apply database hotfix.

3 Select the web content repository from the drop-down list.

4 Click Start to apply the latest available database hotfix in the base directory. 
The Connect dialog box opens.

5 Enter the user name and password for the database administration user.

6 Click OK. The database hotfix is applied to the web content repository. A 
short version of the log is displayed in the Result log area.

Note: To view the full log in the default text editor, click Open Log File.

7 Click Close to close the Create Database dialog box.
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applications

This section describes how to manage StreamServer applications, Archiver 
applications, and service gateway applications.

In this section

• Starting, stopping, and restarting applications on page 106.

• Deleting applications on page 107.

• Refreshing application status information on page 108.

• Updating and exporting application properties on page 109.

• Monitoring applications on page 111.

• Administering applications on remote hosts on page 114.

• Configuring Java parameters on page 115.

Related topics

Before you can run the applications, you must configure the administration 
environment. For more information, see:

• StreamServer configurations on page 45.

• StreamStudio configurations on page 69.

• StreamStudio Collector configurations on page 81.

• StreamStudio Composition Center configurations on page 97.
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Starting, stopping, and restarting 
applications

To start an application

Right-click the application and select Start.

To stop an application

Right-click the application and select Stop.

Note: If you stop an Archiver application during an ongoing task, the application 
stops immediately. When the Archiver application is restarted, it continues 
the interrupted task and archives the remaining documents with the most 
recent document types.

To restart an application

Right-click the application and select Restart.
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Deleting applications
You can delete applications from the tree view in Control Center. This does not 
delete the configuration files from the working directory. You must manually 
delete these files.

To delete an application

1 Right-click the application and select Delete.

2 Click OK.
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Refreshing application status information
Refresh updates the status information displayed for applications in Control 
Center.

To update the status information displayed for an application

Right-click the application and select Refresh.

To refresh the status information for all applications on a host 

Right-click the host node and select Refresh.

To specify a refresh interval for all applications

1 Select File > Settings. The Control Center Settings dialog box opens.

2 In the Refresh rate in seconds text box, enter the interval to refresh the 
status of the applications.

3 Select the nodes to change the refresh interval for. See Control Center 
Settings dialog box on page 160.

4 Click OK.
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Updating and exporting application 
properties

You can update the properties of applications, such as name, description, and 
startup options. You can also update the runtime properties of StreamServer 
applications, such as the log level of a StreamServer application.

In this section

• Updating application properties on page 109.

• Updating runtime properties of StreamServer applications on page 109.

• Exporting property information on page 110.

Updating application properties
You can update the properties of applications, such as name, description, and 
startup options.

It is possible to update the application description, startup type, and logon settings 
while the application is running. To update the name of the application and the 
application domain, you must stop the application.

To update an application property

1 Select the application.

2 In the Properties view, right-click the property and select Edit Property. 
The Edit Value dialog box opens.

3 Enter the new property value and click OK.

Updating runtime properties of StreamServer 
applications

You can update the runtime properties of StreamServer applications, such as the 
log level of the StreamServer application. For runtime properties, see Runtime 
Property view on page 144.

Note: If you update the runtime properties of a StreamServer application, the 
application is run using the updated values until the application is 
restarted. When you restart the application, the configuration from the 
working directory takes effect.

To update the runtime properties of a StreamServer application

1 Select the application.

2 In the Runtime properties window, enter the value for the runtime property.

The application is run using the new value until the application is restarted.
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Exporting property information
You can save the properties (name, description, version, etc.) for an application 
as a text file.

To save property information for an application as a text file

1 Select the application.

2 Select File > Export list. The Save As dialog box opens.

3 Browse to the location to save the file, and enter a name for the file.
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Monitoring applications
You use the surveillance functionality to monitor the status of StreamServe 
applications.

Surveillance monitors the preferred state of an application. The preferred state of 
the application is set when the application is started or stopped from Control 
Center. For example, if you start an application from Control Center, the preferred 
state is set to Started. However, if applications are started or stopped outside of 
Control Center, for example from Windows Control Panel, the preferred state 
does not change.

If an application that is monitored and that has a preferred state of Started goes 
down, you can use the surveillance functionality to try to restart the application. 
If this is not successful, it is also possible to:

• Start an external program, which can try to restart the application. For 
example, by sending an SNMP trap to a Network Management System 
(NMS), or by executing a BAT file or shell script.

• Send an email to the application domain contact.

In this section

• Configuring surveillance actions for the host on page 111.

• Configuring surveillance for the application or service gateway on page 
112.

• Configuring arguments for external programs or surveillance emails on 
page 112.

Configuring surveillance actions for the host
You must specify the surveillance failure actions that can be taken for the 
StreamServe applications on each host.

To configure surveillance actions for all the applications on a host

1 Right-click the host node and select Surveillance. The Host Surveillance 
dialog box opens.

2 Configure the surveillance options. See Host Surveillance dialog box on 
page 208.

3 Click OK to save the changes.
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Configuring surveillance for the application or service 
gateway

You must enable surveillance for each StreamServe application that you intend to 
monitor. You must also specify which of the failure actions are taken for the 
application. For example, send an email if the preferred state of the application 
cannot be reestablished.

To activate surveillance for an application

1 Right-click the application and click Surveillance. The Application 
Surveillance dialog box opens.

2 Click Enabled to activate surveillance.

3 Configure the surveillance options. See Application Surveillance dialog box 
on page 209.

4 Specify the failure actions.

5 Click OK to save the changes.

Configuring arguments for external programs or 
surveillance emails

You can use surveillance arguments to send information to external programs or 
to include in surveillance emails. These arguments can relate to all the 
StreamServe applications on a host, or be specific to an application.

To configure arguments at host level

1 Right-click the host node and select Surveillance. The Host Surveillance 
dialog box opens.

2 In the Program Arguments field, enter the arguments used to start the 
external program.

3 In the Subject field, enter the arguments to include in surveillance emails. 

4 Click OK to save the changes.

To configure arguments for an application

1 Right-click the application and select Surveillance. The Application 
Surveillance dialog box opens.

2 In the Message field, enter the arguments.

3 Click OK to save the changes.
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Surveillance Arguments

Arguments

Format specifier Description

%a The name of the application.

%c The contact person for the application domain. If no 
contact is specified for the application domain, it is the 
alternative contact specified in the Host Surveillance 
dialog box.

%f The name of the failure action. This is always 
KEEP_PREFERRED_STATE.

%u The time the management gateway has been running.

%m The arguments configured for the application or service 
gateway in the Application Surveillance dialog box.

Note: This argument can only be used at host level.
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Administering applications on remote hosts
Remote hosts are displayed in the Control Center tree view after you create an 
application on the host.

To administer applications on a remote host, you must connect to the host. To do 
this you need the login details (case-sensitive) for a management gateway user on 
the computer.

To connect to a remote host

1 From the tree view in Control Center, right-click the host node and select 
Connect.

2 Enter the user name and password for the management gateway user and 
click OK.

After you connect to the host, the StreamServe applications configured on 
the host are visible in Control Center.
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Configuring Java parameters
You can configure Java parameters, such as the target JRE (Java Runtime 
Environment) vendor and the Java class paths, for each StreamServe application 
(StreamServer application, Archiver application, or service gateway).

Name/value pairs

You configure the parameters as a name/value pair. The name/value pair must 
follow the standard syntax for Java properties (name<Delimiter>value). For 
example, for the Java system property -Djava.library.path=c:\mylibs:

• Name: java.library.path

• Value: c:\mylibs

To configure a parameter with a non-standard syntax, you must enter the full 
parameter in the name field and leave the value field empty. For example, for the 
Java option -Xdebug:

• Name: Xdebug

• Value: (empty)

To configure Java parameters

1 Right-click the application and select Java Configuration. The Java 
Configuration dialog box opens.

2 If required, edit the default parameters directly in the list.

3 To add new parameters, select the (Item list) field and click the button to the 
right of the field. The Export Parameters dialog box opens.

4 Add and configure the required parameters.

5 Click OK to update the list in the Java Configuration dialog box.

6 Click OK to complete the configuration and exit the dialog box.
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Managing StreamServe 4.x 
applications

This section describes how to administer 4.x applications. To run 4.x 
Communication Server applications on UNIX hosts, you must install Control 
Center 4.x.

Displaying the node for 4.x services in Control Center

To run and manage 4.x applications from Control Center, you must display the 
node for 4.x Services. See Displaying the 4.x Services node in Control Center on 
page 118.
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Services in general
In this section

• Displaying the 4.x Services node in Control Center on page 118.

• Connecting to, and disconnecting from, remote hosts on page 118.

• Adding and deleting services on page 119.

• Configuring startup options for a service on page 119.

• Starting and stopping services on page 119.

• Grouping services on page 120.

• Logs for 4.x Services on page 120.

• Exporting path information to a file on page 121.

Displaying the 4.x Services node in Control Center
1 Select File > Settings. The Control Center Settings dialog box opens.

2 Select Display 4.x Services and click OK.

3 Close and restart Control Center for the settings to take effect.

Connecting to, and disconnecting from, remote hosts
To be able to administer services running on remote hosts, you must first connect 
the Control Center to the remote host. 

To connect to a remote host

1 Right-click the 4.x Services node and select Connect. The Connect To 
Host dialog box opens.

2 Specify the host and click OK.

If you are not an authorized user on the remote host, you can add a new 
network connection to the remote host. In this case, the Add Network 
Connection dialog box opens when you try to connect to the remote host. In 
this dialog box, you specify the user name and password for the new 
connection. You can, for example, connect as Windows administrator for the 
remote host.

To disconnect from a remote host

1 Right-click the 4.x Services node and select Disconnect. The Disconnect 
Host dialog box opens.

2 Specify the host and click OK.
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Adding and deleting services

To add a service

1 From the 4.x Services node, right-click the host node (or a group node 
below the host node) and select New Configuration. The Choose Object 
dialog box opens.

2 Select a service type from the list of available objects and click OK.

Depending on the type of service, a configuration wizard or configuration 
dialog box opens. What to do and what to enter is described in the 
documentation for the corresponding service type.

To delete a service

Right-click the service and select Delete Service.

Configuring startup options for a service
You can specify startup method and logon options for the service.

1 Right-click the service and select Service Startup. The Service Startup 
Configuration dialog box opens.

2 Specify the options and click OK.

Starting and stopping services

To start a service

Right-click the service and select Start.

To stop a service

Right-click the service and select Stop.

Startup options

Startup method Automatic – Starts the service automatically when the 
system (host for the corresponding service) starts.

Manual – Starts the service manually.

Disabled – Disables the service.

Log on as System account – Runs the service under the local 
system account. With this option you can also enable the 
service to send messages to your desktop.

This account – Specifies the user name and password for 
another account, and runs the service under this account.
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To restart a service

Right-click the service and select Restart. This will first stop and then start the 
service.

Grouping services
You can organize the services into groups. You can create new services from 
within a group, and you can move services to and from a group.

To create a group

1 Right-click the Groups node and select New Group. The New group dialog 
box opens.

2 Enter the name of the group and click OK.

To remove a group

Right-click the group and select Remove Group. 

The group is removed, and any services within are moved directly under the host 
node.

To move services to and from a group

1 Right-click the group and select Add/Remove Services. The Add/Remove 
Services dialog box opens.

2 Specify which services to include and click OK.

You can also use drag-and-drop to move the services. You can drop a service 
on any group node or on the host node.

Logs for 4.x Services
The following logs are available:

• Communication Server log file – Displays the log entries for the selected 
StreamServe service.

• Event log (Application) – Displays the last ten entries in the Event log from 
the Windows application.

• Event log (System) – Displays the last ten entries in the Event log from the 
Windows system components.

To view the Event Log for a remote host

1 Select File > Event Log. The connect to host dialog box opens.

2 Specify the host and click OK.
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Exporting path information to a file
Information about the paths defined for a service can be exported to a text file.

To export the path information for a service

1 Select the service.

2 Select File > Export list and specify the location to export the file to.
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Administrating 4.x Communication Server 
services

In this section

• Adding Communication Server services for 4.x Projects on page 122.

• Editing service paths on page 123.

• Exploring the export directory on page 123.

• Terminating a Communication Server service for a 4.x Project on page 123.

• Using the Communication Server log file on page 124.

• Notifications on page 124.

• Administering Communication Servers on UNIX hosts on page 124.

Adding Communication Server services for 4.x Projects
1 From the 4.x Services node, right-click the host node (or a group node 

below the host node) and select New Configuration. The Choose Object 
dialog box opens.

2 Select Communication Server Configuration and click OK. The 
configuration wizard opens.

3 Follow the instructions in the wizard to create the service.

Information to enter

Descriptive name A descriptive name for the service.

Project directory The absolute path to the directory of the Project files.This 
directory normally contains the design files (from Design 
Center) for the Project.

Export directory The directory containing the Project files exported in the 
Design Center.

This can be an absolute path or a relative path to the 
Project Directory.

Argument file name The name of the startup argument file.

Temporary files 
directory

The location where the temporary files will be stored.

This can be an absolute path or a relative path to the 
Export Directory (if there is no export directory the 
relative path is relative to the Project directory).

License file The absolute path to the Communication Server license 
file.
StreamServe Persuasion SP5 Control Center User Guide Rev C



Administrating 4.x Communication Server services 123
Managing StreamServe 4.x applications
Editing service paths
In the Properties view you can modify the paths for the following Communication 
Server service directories and files:

• Export directory.

• Temporary directory.

• Executable.

• Argument file.

To edit a path

1 Select the service.

2 In the Properties window, right-click the property and select Edit Property. 
The Edit Value dialog box opens.

3 In the Value field, enter the new path and click OK.

Exploring the export directory
You can open the export directory for a Communication Server service to view or 
edit the files and sub-directories.

To open the export directory

Right-click the service and select Explore. The export directory opens in a 
directory browser.

Terminating a Communication Server service for a 4.x 
Project

If a Communication Server service cannot be stopped with a normal Stop you can 
use the Terminate Process option instead. This option will unconditionally 
terminate the service process, and should be used with caution.

Executable The absolute path to the Communication Server 
executable.

Startup type See Configuring startup options for a service on page 
119.

Log on as See Configuring startup options for a service on page 
119.

Information to enter
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To be able use the Terminate Process option for processes running on Windows 
you must add the -pid argument to the startup argument file. See the Startup 
argument reference for information about -pid.

To terminate a service

Right-click the service and select Terminate Process. Click Yes to confirm the 
termination.

Using the Communication Server log file
By default the Communication Server log file is continuously scanned, which 
means that the relevant log messages are displayed in the Control Center.

To open the log file

Right-click the Communication Server and select Log > View Log. The log file 
is displayed in a text editor.

To clear the log displayed in the Control Center

Right-click the Communication Server and select Log > Clear Window. 

To stop/start log scanning

Right-click the Communication Server and select Log > Stop/Start Log 
Scanning.

To delete the log file

Right-click the service and select Log > Delete Log File.

Notifications
You must install Control Center 4.x to view or subscribe to notifications 
configured in 4.x Communication Servers.

Administering Communication Servers on UNIX hosts
You administer Communication Server services on UNIX hosts almost the same 
way as you administer Communication Server services on Windows hosts.

Export from 
the Design 
Center

The export from the Design Center is handled differently when handling 
Communication Servers on UNIX hosts. See Exporting the Communication 
Server configuration to the UNIX host on page 125.

First time 
connection 
to host

The first time you connect to a UNIX host in the Control Center you must 
activate the Console (select View > Console). In the Console, you must accept 
the key sent to you by the host. The next time you connect to the same host you 
do not have to activate the Console – unless you have changed the host name.
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Exporting the Communication Server configuration to the UNIX host
You always export the Communication Server configuration from the Design 
Center to an Export directory – this applies to Communication Servers running on 
both Windows and UNIX.

When you administer Communication Server services running on Windows you 
can point to the same Export directory when you configure the service in the 
Control Center. This also applies to Communication Server services running on 
UNIX – provided that the Design Center can export files to the UNIX file system 
via Samba or NFS.

If you do not have Samba, NFS or similar you must set up your export directory 
on a Windows host and copy this directory to the UNIX host.

To copy the Export directory to the UNIX host

1 Right-click the service and select Explore. The MGW Explorer opens with 
the Export directory for the service active.

2 From the Tools menu, select Copy directory to remote and copy the 
Export directory to the UNIX host.

Note: All sub directories are included. You might not want to include the temp, 
data\log and data\queues directories.

Copying files from the UNIX host to the Control Center host
1 Right-click the service and select Explore. The Explore browser opens with 

the Export directory for the service active.

2 Browse to the file you want to copy from the UNIX host .

3 Right-click the file and select Copy to local or Copy to local and open.

Host name 
format

When you connect to a UNIX host you use the following host name format:

<user>@<host>

For example:

strs@190.153.8.25

If the remote host uses the SSH2 protocol for authentication, you may need to 
force the remote connection to use SSH2 instead of SSH1 by adding the -2 
option to the host argument. For example: strs@190.153.8.25 -2 

Executable When you create the service you must specify which Communication Server 
executable to run. You do this by specifying the shell script strs_pm.sh. If this 
script is missing you can create it with the following command:

$ln -s strs.sh strs_pm.sh

Terminating 
a service on 
UNIX

To be able to use the Terminate Process option for services running on Windows 
hosts you must add the -pid argument to the startup argument file. This is not 
necessary when terminating a Communication Server service on a UNIX host.
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Logging

In this chapter

• Logs in Control Center on page 128.

• Specifying log levels on page 131.

• Logging to the runtime repository on page 133.
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Logs in Control Center
You can view and manage the logs for the applications in Control Center.

Three separate logs

Each application (StreamServer, service gateway, Archiver, and management 
gateway) generates three separate logs:

• Boot log – early startup messages.

• Platform log – low level details.

• Application log – runtime log messages.

Log files

The log entries for each log are appended to separate log files.

Management gateway logs

Log Log file path

Boot log <ManagementGatewayRoot>/strs_boot.log

Platform log <ManagementGatewayRoot>/platform.log

Application log <ManagementGatewayRoot>/mgw.log

Service gateway logs

Log Log file path

Boot log <Service gateway wd>/strs_boot.log

Platform log <Service gateway wd>/platform.log

Application log <Service gateway wd>/servicegateway.log

StreamServer logs

Log Log file path

Boot log <StreamServer wd>/strs_boot.log

Platform log <StreamServer wd>/platform.log

Application log <StreamServer wd>/<logfile>

Where <logfile> is the log file name specified in Design 
Center. Default is Log.txt.
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Log file entries

Each entry in a log file consists of the following:

<date> <time> (<logMessageID>) <logLevel> <logMessage>

Example 5 Log entry.

0309 033344 (0260) 3 SCF started.

Logging to database

You can enable database logging for each application. See Logging to the runtime 
repository on page 133.

Control Center log view 

The logs can be viewed on separate tabs in the Control Center log view. For 
example, when a service gateway is selected in the tree view, the log view 
contains three tabs: 

• strs_boot.log

• platform.log

• servicegateway.log

Each tab contains the same information as the corresponding log file. If you want 
to, you can clear the information displayed on each tab (right-click the log view 
and select Clear). This action clears the log displayed in Control Center, but does 
not affect the corresponding log file.

Archiver logs

Log Log file path

Boot log <Archiver wd>/strs_boot.log

Platform log <Archiver wd>/platform.log

Application log <Archiver wd>/archiver.log

<date> The date the log entry was created.

<time> The time the log entry was created.

<logMessageID> The log message ID. Each type of log message has a 
unique ID.

<logLevel> The severity level of the log message.

<logMessage> The log message.
StreamServe Persuasion SP5 Control Center User Guide Rev C



130 Logs in Control Center
Logging
If logging to database is enabled for the application, a Database log tab is added 
to the log view. This tab displays the log information stored in the runtime 
repository.

Note: In order to display the information on the Database log tab, a service 
gateway must be connected to the same application domain as the 
application, and this service gateway must be running.
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Specifying log levels
The log level determines which type of messages to include in the platform log 
and application log. The log level spans from 0 to 4 – the higher the number, the 
more details are added to the log.

Log level for platform logs
You specify the platform log level for each application separately.

To specify the platform log level

1 Stop the application.

2 In the Control Center tree view, right-click the application and select Log 
Configuration. The Log Configuration dialog box opens.

3 Change Log level to the appropriate level and click OK.

4 Start the application.

Log level for application logs
You can specify the application log level for StreamServer and Archiver 
applications.

Log level for StreamServer application logs
The log level for a StreamServer application log is specified in Design Center. 
Each time you start a StreamServer application, the log level is set to the same 
value as specified in Design Center.

You can change the log level for a running StreamServer application from Control 
Center, without having to change the log level in Design Center and export/
redeploy to the StreamServer application.

To change the log level for a running StreamServer application

1 Select the StreamServer application node in the tree view.

Level Types of messages included in log

0 Severe errors only.

1 As level 0 plus all other types of errors.

2 As level 1 plus warnings.

3 As level 2 plus information messages.

4 As level 3 plus extended information messages.
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2 In the Runtime Property view, change Log level to the appropriate level.

Log level for Archiver application logs

To specify the Archiver application log level

1 Stop the Archiver application.

2 In the Control Center tree view, right-click the Archiver application and 
select Configuration. The Configuration dialog box opens.

Note: The Archiver application log level is set in the Configuration 
settings, and not in the Log Configuration settings for the Archiver 
application.

3 Change Log level to the appropriate level and click OK.

4 Start the Archiver application.

Debugging applications
You can enable debugging to include more log information in the logs. 

The following options are available:

• Disabled – Disables debugging.

• Enabled – Enables debugging to include extended log information. For 
example, for ODBC calls, SQL statements are included in the logs.

• Enabled verbose – Enables verbose debugging to include all available log 
information. For example, for ODBC calls, SQL statements and parameters 
are included in the logs.

Note: The formats of the parameters presented in the logs may not 
correspond to the formats actually used in the SQL statements. For 
example, timestamps are presented differently in the logs.

The configured option applies to all logs (boot log, platform log, and application 
log), for the selected application.

To enable debugging

1 Select the application node in the tree view.

2 Stop the application.

3 In the Properties view, double-click Debug mode. The Edit Debug Mode 
dialog box opens.

4 Select the appropriate debug option and click OK.

5 Start the application.
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Logging to the runtime repository
Logging to the runtime repository (application log and platform log) includes not 
only date, time, log message ID, log level, and log message, but also year, 
job ID, external job ID, and thread ID. Logging to the runtime repository 
provides better control of the logs than using log files, since you can examine the 
logs from several applications using for example date and job ID as search 
criteria.

To examine the runtime repository logs, you can use the command line tool 
LogWebServiceClient.exe located in:

<StreamServe_Installation>\Platform\Core\1.4\bin\

See the tool help text for information on how to use this tool (enter 
LogWebServiceClient.exe -h in a command prompt).

Enabling logging to the runtime repository
You enable logging to the runtime repository for each application separately. 

Note: In order to display the information on the Database log tab in Control 
Center, a service gateway must be connected to the same application 
domain as the application, and this service gateway must be running.

To enable logging to the runtime repository

1 Stop the application.

2 In the Control Center tree view, right-click the application and select Log 
Configuration. The Log Configuration dialog box opens.

3 Change Database logging to Enabled and click OK.

4 Start the application.

Removing old log messages from the runtime 
repository

By default, log messages are kept one day in the runtime repository, and then 
removed. You can change this time limit for each application separately. 

To set a time limit for log messages

1 Stop the application.

2 In the Control Center tree view, right-click the application and select Log 
Configuration. The Log Configuration dialog box opens.

3 Change Time limit to the appropriate number of days and click OK.

4 Start the application.
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Control Center GUI Reference

In this section

• Views on page 136.

• Menus and menu commands on page 146.

• Dialog boxes, wizards, and tools on page 159.
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Views 
Tree view

This is the top left frame in Control Center. The tree view displays applications 
by application domain and host. If the same host is used to run applications in 
several application domains, the host is shown under each application domain. 
The view also displays available StreamStudio web portals in the StreamStudio 
Portals folder and available StreamServe archives in the Archives folder.

Properties view

This shows the properties for the selected object (application domain, 
applications, StreamServe archive, etc). See Properties view on page 136.

Runtime properties view

This shows the runtime properties for the selected StreamServer application. For 
example, log level and cache size. It is only displayed for StreamServer 
applications that are running. See Runtime Property view on page 144.

FastCopy view

This shows the FastCopy source and destination pairs for the selected 
StreamServer application.

To display the FastCopy view, right-click the StreamServer application and select 
FastCopy view. To return to the Properties view, right-click the StreamServer 
application and select Properties view.

Log view

This shows the logs for the selected application.

To display/hide the log view in Control Center, right-click the application and 
select View log.

Properties view

In this section

• Site properties on page 137.

• Application domain properties on page 138.

• Host properties on page 138.

• Application (StreamServer) properties on page 139.

• Application (Service Gateway) properties on page 141.

• Application (Archiver) properties on page 142.

• Application (Task Scheduler) properties on page 143.

• Resource (StreamStudio portals) properties on page 143.

• Resource (Archives) properties on page 144.
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• Runtime Property view on page 144.

Site properties
The properties are described in the table below.

Property Description

Management 
gateway host

The host name or IP address of the computer with the 
management gateway used to communicate with the 
StreamServe Enterprise Repository.

Gateway port The port used to communicate with the management 
gateway. The default port is 28000.

Management 
gateway send and 
response time-out 
(ms)

The time Control Center waits for responses from the 
management gateway after the initial connection to the 
management gateway is established. This is specified in 
milliseconds.

If you experience problems with time-out when you 
deploy a Design Center Project, you can try increasing 
this value.

Management 
gateway 
connection time-
out (ms)

The time Control Center waits when trying to establish a 
new connection to the management gateway. This is 
specified in milliseconds.

Management 
gateway certificate 
file

The path to the root certificate on the local computer. 
This must be a valid root certificate for the server 
certificate on the management gateway you are 
connecting to.

The path to the default StreamServe root certificate is:

<StreamServe installation>\Platform\Core\<Vers
ion>\bin\security\certificatestore\trusted\aut
horities\streamserve.ca.crt

Management 
gateway user name

The user connected to the management gateway.

Management 
gateway user role

The role of the management gateway user.

Application 
domains

The application domains configured at the site.

Enterprise 
repository vendor

The database vendor used for the enterprise repository.

Enterprise 
repository name

The name of the enterprise repository database.
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Application domain properties
The properties are described in the table below.

Host properties
The properties are described in the table below.

Enterprise 
repository host 

The host name or IP address of the computer with the 
enterprise repository.

Enterprise 
repository port

The port used for communication with the enterprise 
repository.

Property Description

Property Description

Name The name of the application domain.

Queue and 
Archiving database 
server

The host name or IP address of the computer with the 
Queue repository.

Web Access 
database server

The host name or IP address of the computer with the 
Web Access repository.

Security database 
server

The host name or IP address of the computer with the 
Security repository.

Internal user 
directory

The host name or IP address of the computer with LDAP 
server used for the internal user directory.

External user 
directory

The host name or IP address of the computer with the 
LDAP server used for the external user directory.

Application domain 
version

The version of the application domain.

StreamStudio 
Portal

The StreamStudio web portal linked to the application 
domain.

Archive The StreamServe archive linked to the application 
domain.

Property Description

Management 
gateway host

The host name or IP address of the computer.

Gateway port The port used for communication with the management 
gateway on the computer. The default port is 28000.
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Application (StreamServer) properties
The properties are described in the table below.

Management 
gateway send and 
response time-out 
(ms)

The time Control Center waits for responses from the 
management gateway after the initial connection to the 
management gateway is established. This is specified in 
milliseconds.

Management 
gateway 
connection time-
out (ms)

The time Control Center waits when trying to establish a 
new connection to the management gateway. This is 
specified in milliseconds.

Management 
gateway certificate 
file

The path to the root certificate on the local computer. 
This must be a valid root certificate for the server 
certificate on the management gateway you are 
connecting to.

The path to the default StreamServe root certificate is:

<StreamServe installation>\Platform\Core\<Vers
ion>\bin\security\certificatestore\trusted\aut
horities\streamserve.ca.crt

Management 
gateway user name

The user connected to the management gateway.

Management 
gateway user role

The role of the management gateway user.

Application 
domains

The application domains that the applications on the host 
belong to.

OS platform The operating system of the host.

Enterprise 
repository vendor

The database vendor used for the enterprise repository.

Enterprise 
repository name

The name of the enterprise repository database.

Enterprise 
repository host 

The host name or IP address of the computer with the 
enterprise repository.

Enterprise 
repository port

The port used for communication with the enterprise 
repository.

Property Description

Property Description

Name The name of the StreamServer application.

Description The description of the StreamServer application.
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Application type The type of application, that is StreamServer.

State The status of the application, for example running or 
stopped.

Application 
Domain

The application domain of the StreamServer application 
and status of the application domain configuration.

Current – The most recent version of the application 
domain configuration is used for the application.

Out of date – The application domain configuration has 
been updated, but the new configuration has not been 
applied to the application. See To apply the changes to the 
applications on page 47.

StreamServer 
version

The version of the StreamServer used to run the 
application.

Startup type How the StreamServer application is started. For 
example, automatic, manual, or disabled.

Log on The account used to run the StreamServer application.

Export file The name of the export file deployed to the StreamServer 
application.

Working directory The path to the working directory for the StreamServer 
application.

Log files The name of the log files for the StreamServer 
application.

Management 
gateway host

The computer used to run the StreamServer application.

Deployment 
timestamp

The date and time the export file was deployed.

Project name The name of the Project deployed to the application.

Project export 
timestamp

The date and time the last export was made in Design 
Center.

Project label If the Project is deployed from the file system, this is the 
creation date and time of the export file.

If the Project is deployed from a version control system, 
this is the label of the export file.

Physical layer The physical layer of the Platform that is deployed to the 
StreamServer application.

Property Description
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Application (Service Gateway) properties
The properties are described in the table below.

Temp directory The directory (relative to the working directory) 
containing temporary files for the StreamServer 
application and the platform.

Debug mode Enables or disables debug mode for the StreamServer 
application. For example, disabled, enabled, or enabled 
verbose.

Cache size (KB) See the Adobe LiveCycle Designer ES documentation.

Property Description

Property Description

Name The name of the service gateway.

Description The description of the service gateway.

Application type The type of application, that is Service Gateway.

State The status of the service gateway, for example running or 
stopped.

Application 
Domain

The application domain of the service gateway and status 
of the application domain configuration.

Current – The most recent version of the application 
domain configuration is used for the application.

Out of date – The application domain configuration has 
been updated, but the new configuration has not been 
applied to the application. See To apply the changes to the 
applications on page 47.

Service Gateway 
version

The version of the service gateway used to run the 
application.

Startup type How the service gateway is started. For example, 
automatic, manual, or disabled.

Log on The account used to run the service gateway.

Working directory The working directory for the service gateway.

Log files The log files for the service gateway.

Service gateway 
port

The port used for communication with the service 
gateway.
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Application (Archiver) properties
The properties are described in the table below.

Temp directory The directory (relative to the working directory) 
containing temporary files for the platform.

Debug mode Enables or disables debug mode for the service gateway. 
For example, disabled, enabled, or enabled verbose.

Property Description

Property Description

Name The name of the Archiver application.

Description The description of the Archiver application.

Application type The type of application, that is Archiver.

State The status of the Archiver application, for example 
running or stopped.

Application 
Domain

The application domain of the Archiver appplication and 
status of the application domain configuration.

Current – The most recent version of the application 
domain configuration is used for the application.

Out of date – The application domain configuration has 
been updated, but the new configuration has not been 
applied to the application. See To apply the changes to the 
applications on page 47.

Version The version of the Archiver application.

Startup type How the Archiver application is started. For example, 
automatic, manual, or disabled.

Log on The account used to run the Archiver application.

Working directory The working directory for the Archiver application.

Log files The log files for the Archiver application.

Temp directory The directory (relative to the working directory) 
containing temporary files for the Archiver application 
and the platform.

Debug mode Enables or disables debug mode for the Archiver 
application. For example, disabled, enabled, or enabled 
verbose.
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Application (Task Scheduler) properties
The properties are described in the table below.

Resource (StreamStudio portals) properties
The properties are described in the table below.

Property Description

Name The name of the Task Scheduler application.

Description The description of the Task Scheduler application.

Application type The type of application, that is Task Scheduler.

State The status of the Task Scheduler application, for example 
running or stopped.

Application 
Domain

The application domain of the Task Scheduler 
appplication and status of the application domain 
configuration.

Current – The most recent version of the application 
domain configuration is used for the application.

Out of date – The application domain configuration has 
been updated, but the new configuration has not been 
applied to the application. See To apply the changes to the 
applications on page 47.

Version The version of the Task Scheduler application.

Startup type How the Task Scheduler application is started. For 
example, automatic, manual, or disabled.

Log on The account used to run the Task Scheduler application.

Working directory The working directory for the Task Scheduler 
application.

Log files The log files for the Task Scheduler application.

Temp directory The directory (relative to the working directory) 
containing temporary files for the Task Scheduler 
application and the platform.

Debug mode Enables or disables debug mode for the Task Scheduler 
application. For example, disabled, enabled, or enabled 
verbose.

Property Description

Name The name of the StreamStudio web portal.
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Resource (Archives) properties
The properties are described in the table below.

Runtime Property view
This view displays the runtime properties for the StreamServer application. The 
properties are described in the table below.

Description A description of the StreamStudio web portal.

Host name The host name or IP address of the computer where the 
web portal resides.

Application 
domains

The application domains that the StreamStudio web 
portal is linked to.

Portal root The directory on the Java application server to which you 
want to deploy the StreamStudio web archive 
<Portal name>.war file. For example, for Apache 
Tomcat:

<TOMCAT_HOME>\webapps\

Manual deploy path Applicable if you select Manual deploy in the web portal 
configuration.

The path to the directory where the StreamStudio web 
archive file, <Portal name>.war, is stored.

Property Description

Property Description

Name The name of the StreamServe archive.

Description A description of the StreamServe archive.

Host name The host name or IP address of the computer where the 
StreamServe archive resides.

Application 
domains

The application domains that the StreamServe archive is 
linked to.

Property Description

Temp compression 
enabled

Enables compression of the temporary files to save disc 
space. Files are gzipped. Enabling temporary 
compression affects performance.

Temp directory The directory containing in the temporary files.
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LXF cache size Specifies the number of cache items (LXF documents) 
that can be stored. 

The cache will always try to cache static overlays. Static 
overlays stay in the cache as long as possible, and are 
only discarded when the StreamServer application is 
stopped.

LXF cache dynamic Enables caching of dynamic overlays. Dynamic overlays 
are not cached by default because they decrease the 
performance of static overlays during larger jobs. 

When enabled, dynamic overlays stay in the cache 
between the preprocess and runtime phases and are not 
removed until after runtime is finished.

Working directory The working directory for the StreamServer application.

WSIN enabled Records a list of all incoming data that the StreamServer 
identifies. A separate file is created for each Message. 
This file shows the Fields and Blocks in the Message, and 
in the order in which the StreamServer processes them.

WSIN file name If the WSIN property is enabled, the name of the file used 
for the Message data. 

You can specify a filename that is relative to the working 
directory for the application. Or, you can specify an 
absolute path and filename.

Recording mode 
enabled

Instructs the StreamServer to record the input data and 
create a sample file.

All pages recorded are appended to the sample file 
allpages.<input connector name>. This file is created 
in the directory specified in the Grab file directory 
property.

Grab file directory Specifies where sample files are saved when you use the 
Recording mode enabled runtime property, or run the 
StreamServer with the startup arguments -rec or -
reconly.

Log level Specifies the log level for the StreamServer application 
log. See Log level for StreamServer application logs on 
page 131.

Log file name Specifies the name for the StreamServer log file.

Application 
process ID

An internal number identifying the application process.

Property Description
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Menus and menu commands
In this section

• File menu commands on page 146.

• View menu commands on page 148.

• Format menu commands on page 148.

• Language menu commands on page 148.

• Help menu commands on page 149.

• Root menu commands on page 149.

• Site menu commands on page 149.

• Domain menu commands on page 150.

• Host menu commands on page 152.

• Application (StreamServer) menu commands on page 153.

• Application (Service Gateway) menu commands on page 154.

• Application (Archiver) menu commands on page 155.

• Application (Task Scheduler) menu commands on page 156.

• StreamStudio Portals menu commands on page 157.

• Archives menu commands on page 157.

• Resource (StreamStudio Portals) menu commands on page 157.

File menu commands
The File menu includes the commands described in the table below.

Command Description

New > Site Opens the New Site dialog box, which is used to 
configure a new site and connect the site to a 
StreamServe Enterprise Repository.

New > Application 
Domain

Opens the New Application Domain dialog box (Adding) 
and then the Application Domain Editor. These are used 
to configure the name, repositories, connection settings, 
and recovery settings for an application domain.

New > Application Opens the New Application dialog box, which is used to 
add a new StreamServer application, Archiver 
application, or service gateway.
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New > 
Configuration

Opens the New Site dialog box, New Application Domain 
dialog box (Adding), or New Application dialog box 
depending on object selected in the Control Center tree 
view.

From the 4.x Services node, this opens the Choose Object 
dialog box, which is used to configure a 4.x service.

Connect to Remote 
Host

Connects to the local computer or a remote computer.

From the 4.x Services node, this opens the Connect to 
host dialog box, which is used to connect to computers 
that run 4.x services.

Disconnect from 
Remote Host

Disconnects from the hosts at the site.

From the 4.x Services node, this opens the Disconnect 
Host dialog box, which is used to end connections with 
remote computers that run 4.x services.

Version Control > 
Manage VCS 
Connections

Opens the Open VCS Connection dialog box, which is 
used to:

• Create new VCS connections.

• Edit VCS connections.

• Rename VCS connections.

• Delete VCS connections.

Version Control > 
Connect to

Creates a connection to a version control system.

Version Control > 
Disconnect

Ends a connection to a version control system.

Export List Saves a list of the properties for the selected application 
domain, host, or application as a text file.

Settings Opens the Control Center Settings dialog box, which is 
used to specify:

• The interval at which the status information for 
applications is updated.

• Whether the 4.x Services node is displayed.

Exit Exits Control Center.

Command Description
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View menu commands
The View menu includes the commands described in the table below.

Format menu commands
The Format menu includes the commands described in the table below.

Language menu commands
The Language menu includes the command described in the table below.

Command Description

Status Bar Displays the status bar at the bottom of the Control 
Center window.

Console Enables you to connect to UNIX hosts running 4.x 
Communication Servers.

Log Window Displays/hides the log view.

Runtime Properties Displays/hides the runtime properties view. This view is 
only displayed for StreamServer applications that are 
running or that have been run.

Show Gateways Displays/hides the host nodes in the tree view. When the 
host nodes are hidden, the applications are sorted by 
application domain.

Refresh Refreshes the status information displayed for all 
applications.

Refresh Item Refreshes the status information for the selected object 
(application domain, host, or application).

Command Description

Word Wrap Wraps the log messages text displayed in the log view.

Font Size Specifies the size of the font used for the text in the log 
view.

Command Description

Select Specifies the language of the Control Center user 
interface.
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Help menu commands
The Help menu includes the commands described in the table below.

Root menu commands
The Root menu includes the command described in the table below.

Site menu commands
The Site menu includes the commands described in the table below.

Command Description

Help Topics Opens the StreamServe Online Help in a new window.

www.streamserve.c
om

Opens the StreamServe home page in a new window

About Control 
Center

Displays the Control Center version and StreamServe 
license information.

Command Description

New Site Opens the New Site dialog box, which is where you 
configure a new site and connect the site to a 
StreamServe Enterprise Repository.

Clear Log Clears the entries in the log view.

View Log Displays/hides the log view in Control Center.

Command Description

Connect Creates a connection to a site. The user name and 
password for the management gateway are required to 
connect to the site.

Disconnect Disconnects from the site.

New Application 
Domain

Opens the New Application Domain dialog box (Adding) 
and then the Application Domain Editor. These are used 
to configure the administrator, name, repositories, 
connection settings, and recovery settings for an 
application domain.

Refresh Updates the status information displayed for applications 
at the site.

Rename Renames the site node.
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Domain menu commands
The Domain menu includes the commands described in the table below.

Remove Removes the site from the tree view in Control Center. 
This does not delete the application domains or 
applications at the site.

Clear Log Clears the entries in the log view.

View Log Displays/hides the log view in Control Center.

Manage Document 
Types

Opens the Manage Document Types dialog box, which 
displays the document types in the enterprise repository. 
In this dialog box, you can delete document types from 
the enterprise and the runtime repositories. 

Manage Templates Opens the Manage Templates dialog box, which displays 
the Composition Center templates in the enterprise 
repository. In this dialog box, you can delete templates 
from the enterprise and the runtime repositories.

Create Database Opens the Create Database dialog box, which is used to 
create a StreamServe Enterprise Repository for the site, 
generate the database scripts used to create the 
repository, or apply hotfixes to the repository.

Available Database 
Hotfixes

Opens the Available Database Hotfixes dialog box, 
which is used to list all repositories that belong to a site, 
together with their current schema versions and the latest 
available hotfixes.

Configuration Opens the Configure Enterprise Repository dialog box, 
which is used to edit the configuration for a StreamServe 
Enterprise Repository for the site.

Command Description

Command Description

New Application Opens the New Application dialog box, which is used to 
add a new StreamServer application, Archiver 
application, or service gateway.

Start All 
Applications

Starts all the applications in the application domain.

Restart All 
Applications

Stops and restarts all the running applications in the 
application domain.
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Stop All 
Applications

Stops all the running applications in the application 
domain.

Refresh All 
Applications

Updates the status information for the applications in the 
application domain.

Deploy Export File Opens the Deploy wizard, which is used to select a 
StreamServer application and Project export file, and 
deploy the export file to the application.

Update Application 
Domain File

Updates the application domain configuration for the 
applications in the application domain. Changes are 
applied when the applications are restarted.

Rename Renames the application domain.

The application domain name must:

• Only include ASCII characters (a-z, A-Z, 0-9).

• Not include any whitespaces.

Edit Application 
Domain

Opens the Application Domain Editor, which is used to 
edit the administrator, repositories, connection settings, 
and recovery settings for an application domain.

Link Archive Opens the Link Archive dialog box, which is used to link 
a StreamServe archive to the application domain.

Link StreamStudio 
Portal

Opens the Link StreamStudio Portal dialog box, which is 
used to link a StreamStudio web portal to the application 
domain.

Export Application 
Domain

Saves the application domain configuration as an XML 
file.

Create Database Opens the Create Database dialog box, which is used to 
create a runtime repository and web content repository 
for the site, or generate the database scripts used to create 
the repositories, or apply hotfixes to the repositories.

Retrieve Document 
Types File

Saves the document types used in the application domain 
in the specified file.

Launch Database 
Administration 
Tool

Launches the Database Administration Tool, which is 
used to administer the runtime repository for the 
application domain.

For more information, see the Database Administration 
Tool documentation.

Command Description
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Host menu commands
The Host menu includes the commands described in the table below.

Delete Application 
Domain

Deletes the application domain and related applications 
from the tree view in Control Center.

This does not delete the configuration files for the 
applications in the application domain or the runtime 
repository for the application domain.

Command Description

Command Description

Connect Creates a connection to the host. The user name and 
password for the management gateway must be entered. 
These are case-sensitive.

Disconnect Disconnects from the host.

New Application Opens the New Application dialog box, which is used to 
add a new StreamServer application, Archiver 
application, or service gateway.

Start All 
Applications

Starts all the applications on the host.

Restart All 
Applications

Stops and restarts all the applications on the host.

Stop All 
Applications

Stops all the running applications on the host.

Refresh Updates the status displayed for all the applications on 
the host.

Deploy Export file Opens the Deploy wizard, which is used to select a 
StreamServer application and Project export file, and 
deploy the export file to the application.

Update Application 
Domain File

Updates the application domain configuration for the 
applications on the host. Changes are applied when the 
applications are restarted.

Change Password Changes the password for the management gateway user 
currently logged in to Control Center.

Manage Users Opens the Manage Users dialog box on page 223, which 
is used to add and remove users from the management 
gateway, and to change passwords and roles for users.
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Application (StreamServer) menu commands
The Application (StreamServer) menu includes the commands described in the 
table below.

Surveillance Opens the Host Surveillance dialog box, which is used to 
specify the surveillance actions that can be taken for 
applications on the host.

Clear Log Clears the entries in the log view.

View Log Displays/hides the log view in Control Center.

Explore Opens the MGW Explorer dialog box, which is used to 
manage files and directories.

View Installed 
Versions

Opens the View software versions window, which 
displays the StreamServe components, with version 
information, installed on a computer. 

Command Description

Command Description

Start Starts the StreamServer application.

Stop Stops the StreamServer application.

Restart Stops and restarts the StreamServer application.

Properties View Displays the Properties view for the StreamServer 
application.

FastCopy View Displays the FastCopy view for the StreamServer 
application.

Refresh Updates the status of the StreamServer application.

Redeploy Redeploys the export file to the StreamServer 
application. You must restart the StreamServer 
application for the new configuration to take effect.

Deploy Export File Opens the Deploy wizard, which is used to select a 
Project export file, and deploy the export file to the 
application.

Update Application 
Domain 
Information

Updates the application domain configuration for the 
StreamServer application. Changes are applied when the 
application is restarted.

Rename Renames the StreamServer application.
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Application (Service Gateway) menu commands
The Application (Service Gateway) menu includes the commands described in 
the table below.

Delete Deletes the StreamServer application. 

The application node is removed from the tree view, 
however the configuration files are not deleted from the 
working directory.

Surveillance Opens the Application Surveillance dialog box, which is 
used to enable surveillance and specify which 
surveillance actions are taken for the application.

Clear Log Clears the entries in the log view for the StreamServer 
application.

View Log Displays/hides the log view in Control Center.

Log Configuration Opens the Log Configuration dialog box, which is used 
to set the platform log level, and to enable/disable 
logging to the runtime repository.

Java Configuration Opens the Java Configuration dialog box, which is used 
to configure Java parameters for the StreamServer 
application.

Explore Opens the MGW Explorer dialog box, which is used to 
manage files and directories.

Command Description

Command Description

Start Starts the service gateway.

Stop Stops the service gateway.

Restart Stops and restarts the service gateway.

Refresh Updates the status of the service gateway.

Change 
Application 
Domain

Applicable if there is more than one application domain 
configured for the site.

Changes the application domain for the service gateway. 
After the change, the service gateway must be restarted in 
the new application domain.

Update Application 
Domain 
Information

Updates the application domain configuration for the 
service gateway. Changes are applied when the service 
gateway is restarted.
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Application (Archiver) menu commands
The Application (Archiver) menu includes the commands described in the table 
below.

Rename Renames the service gateway.

Delete Deletes the service gateway node from Control Center.

Surveillance Opens the Application Surveillance dialog box, which is 
used to enable surveillance for a service gateway and 
specify which surveillance actions are taken for the 
service gateway.

Clear Log Clears the entries in the log view for the service gateway.

View Log Displays/hides the log view in Control Center.

Log Configuration Opens the Log Configuration dialog box, which is used 
to set the platform log level, and to enable/disable 
logging to the runtime repository.

Java Configuration Opens the Java Configuration dialog box, which is used 
to configure Java parameters for the service gateway 
application.

Command Description

Command Description

Start Starts the Archiver application.

Stop Stops the Archiver application.

Restart Stops and restarts the Archiver application.

Refresh Updates the status of the Archiver application.

Update Application 
Domain 
Information

Updates the application domain configuration for the 
Archiver application. Changes are applied when the 
Archiver application is restarted.

Rename Renames the Archiver application.

Delete Deletes the Archiver application from Control Center.

Surveillance Opens the Application Surveillance dialog box, which is 
used to enable surveillance and specify which 
surveillance actions are taken for the Archiver 
application.

Clear Log Clears the entries in the log view for the Archiver 
application.
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Application (Task Scheduler) menu commands
The Application (Task Scheduler) menu includes the commands described in the 
table below.

View Log Displays/hides the log view in Control Center.

Log Configuration Opens the Log Configuration dialog box, which is used 
to set the platform log level, and to enable/disable 
logging to the runtime repository.

Java Configuration Opens the Java Configuration dialog box, which is used 
to configure Java parameters for the Archiver 
application.

Configuration Opens the Configuration dialog box (Archiver 
application), which is used to configure the Archiver 
application. For example, in this dialog, you configure 
the archiving tasks and the application log level.

Command Description

Command Description

Start Starts the Task Scheduler application.

Stop Stops the Task Scheduler application.

Restart Stops and restarts the Task Scheduler application.

Refresh Updates the status of the Task Scheduler application.

Update Application 
Domain 
Information

Updates the application domain configuration for the 
Task Scheduler application. Changes are applied when 
the Task Scheduler application is restarted.

Rename Renames the Task Scheduler application.

Delete Deletes the Task Scheduler application from Control 
Center.

Surveillance Opens the Application Surveillance dialog box, which is 
used to enable surveillance and specify which 
surveillance actions are taken for the Task Scheduler 
application.

Clear Log Clears the entries in the log view for the Task Scheduler 
application.

View Log Displays/hides the log view in Control Center.
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StreamStudio Portals menu commands
The StreamStudio Portals menu includes the command described in the table 
below.

Archives menu commands
The Archives menu includes the command described in the table below.

Resource (StreamStudio Portals) menu commands
The Resource (StreamStudio Portals) menu includes the commands described in 
the table below.

Log Configuration Opens the Log Configuration dialog box, which is used 
to set the platform log level, and to enable/disable 
logging to the runtime repository.

Java Configuration Opens the Java Configuration dialog box, which is used 
to configure Java parameters for the Task Scheduler 
application.

Configuration Opens the Configuration dialog box (Task Scheduler), 
which is used to configure the Task Scheduler 
application.

Command Description

Command Description

Add StreamStudio 
Portal

Opens the Add StreamStudio Portal dialog box, which is 
used to add a StreamStudio web portal to the 
StreamStudio Portals folder.

Command Description

New Archive Opens the New Archive dialog box, which is used to add 
a StreamServe archive.

Command Description

Link Application 
Domain

Opens the Link Application Domains dialog box, which 
is used to link the StreamStudio web portal or 
StreamServe archive to the application domains.

Update Domain 
Information

Updates the application domain configuration for the 
StreamStudio portal.
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Resource (Archives) menu commands
The Resource (Archives) menu includes the commands described in the table 
below.

Unregister Unregisters the StreamStudio web portal. Before the web 
portal is unregistered, any links to application domains 
are automatically removed.

The actual StreamStudio web portal is not deleted, only 
removed from the Control Center Tree view.

Launch Database 
Administration 
Tool

Launches the Database Administration Tool, which is 
used to administer a web content repository in a linked 
application domain.

For more information, see the Database Administration 
Tool documentation.

Command Description

Command Description

Link Application 
Domain

Opens the Link Application Domains dialog box, which 
is used to link the StreamStudio web portal or 
StreamServe archive to the application domains.

Unregister Unregisters the StreamServe archive. Before the archive 
is unregistered, any links to application domains are 
automatically removed.

The actual StreamServe archive is not deleted, only 
removed from the Control Center Tree view.

Create Database Opens the Create Database dialog box, which is used to 
create the StreamServe archive, or generate the database 
scripts used to create the archive, or apply hotfixes to the 
archive.

Configuration Opens the Configuration dialog box (Archive) on page 
214, which is used to configure the database settings for 
the StreamServe archive and the connection settings to 
access the StreamServe archive.

Launch Database 
Administration 
Tool

Launches the Database Administration Tool, which is 
used to examine the StreamServe archive.
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Dialog boxes, wizards, and tools
In this section

• Control Center Settings dialog box on page 160.

• Log Configuration dialog box on page 161.

• Open VCS Connection dialog box on page 162.

• Add connection dialog box on page 163.

• Editing connections dialog box on page 164.

• Configure Enterprise Repository dialog box on page 165

• Create Database dialog box on page 167.

• Available Database Hotfixes dialog box on page 169.

• New Site dialog box on page 171.

• New Application Domain dialog box (Adding) on page 172.

• New Application Domain dialog box (Selecting type) on page 173.

• Application Domain Editor on page 174.

• Import from Gateway dialog box on page 187.

• New Application dialog box on page 188.

• Configuration dialog box (Archiver application) on page 191.

• Configuration dialog box (Task Scheduler) on page 195.

• Scheduler Configuration dialog box on page 199.

• Deploy wizard on page 201.

• Java Configuration dialog box on page 205.

• Host Surveillance dialog box on page 208.

• Application Surveillance dialog box on page 209.

• Add StreamStudio Portal dialog box on page 211.

• Link StreamStudio Portal dialog box on page 212.

• New Archive dialog box on page 213.

• Configuration dialog box (Archive) on page 214.

• Link Archive dialog box on page 217.

• Link Application Domains dialog box on page 218.

• Manage Document Types dialog box on page 219.

• Compare Document Types tool on page 220.

• Force Document Type Update dialog box on page 221.

• MGW Browser dialog box on page 222.

• MGW Explorer dialog box on page 222.

• Manage Users dialog box on page 223.
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• Add User dialog box on page 224.

• Edit User dialog box on page 225.

• Manage Templates dialog box on page 227.

• Compare Composition Center Templates tool on page 228.

Control Center Settings dialog box
The Control Center Settings dialog box is used to:

• Define the interval at which status information displayed for StreamServer 
applications is updated.

• Display/hide the 4.x Service node in the tree view.

Figure 9 The Control Center Settings dialog box

The settings are described in the table below.

Setting Description

Refresh rate in 
seconds

The time interval at which the status information 
displayed for applications is updated. 

For example, if you enter 5, the status information is 
updated every 5 seconds.
StreamServe Persuasion SP5 Control Center User Guide Rev C



Dialog boxes, wizards, and tools 161
Control Center GUI Reference
Log Configuration dialog box
The Log Configuration dialog box is used to:

• Specify the platform log level for the selected application.

• Enable/disable logging to the runtime repository for the selected 
application.

Figure 10 The Log Configuration dialog box

The settings are described in the table below.

Refresh Only selected node and visible subnodes – Refreshes 
the status information for applications in the node 
selected and the subnodes of that node.

All visible nodes – Refreshes the status information for 
all the nodes of the host.

4.x Services Displays/hides the 4.x Services node in Control Center. 
You run 5.x SAP StreamServer applications under this 
node. You must restart Control Center for changes to this 
option to take effect.

Setting Description

Setting Description

Log level The log level for the platform log. See Specifying log 
levels on page 131.

Database logging Enable/disable logging to the runtime repository.

Time limit The number of days to keep the log in the runtime 
repository.
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Open VCS Connection dialog box
The Open VCS Connection dialog box is used to manage all connections to 
version control systems.

Figure 11 The Open VCS Connection dialog box

The settings are described in the table below.

Setting Description

Select connection Lists all available VCS connections.

Add Opens the Add connection dialog box, which is used to 
add a new VCS connection. Before this dialog opens, you 
are prompted to select the type of connection, and to 
specify a name for the connection. Currently, the types 
CVS and CVSNT are available.

Rename Renames the VCS connection selected in the Select 
connection list. This option is disabled if the connection 
is active.

Edit Opens the Editing connections dialog box, which is used 
to edit a VCS connection. This option is disabled if the 
connection is active.

Delete Deletes a VCS connection. This option is disabled if the 
connection is active.

Connect Connects Design Center to the version control system 
using the connection selected.

Close Closes the Open VCS Connection dialog box.
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Add connection dialog box
The Add connection dialog box is used to configure a connection to a CVS or 
CVSNT version control system.

Figure 12 The Add connection dialog box
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The settings are described in the table below.

Editing connections dialog box
The Editing connections dialog box is used to edit the settings for existing 
connections to a version control system. 

For settings, see Add connection dialog box on page 163.

Setting Description

Protocol Specifies the access method to the CVS/CVSNT.

local – Access a CVS/CVSNT repository directory on 
the same computer. Used if Control Center and the VCS 
run on the same computer.

pserver – Access a CVS/CVSNT repository on a remote 
computer via a password authenticating server.

server – Access a CVS/CVSNT repository on a remote 
computer using an internal rsh client.

ssh – Access a CVS/CVSNT repository on a remote 
machine using SSH.

ext – Access a CVS/CVSNT repository on a remote 
computer using an external rsh program.

Property/Value list User name – A user name to access the CVS/CVSNT.

Host name – The host name or IP address of the CVS/
CVSNT computer.

Port – The port number to access CVS/CVSNT. The 
default is 2401.

CVSROOT The CVS/CVSNT repository address.

CVS module The base module for the Project in the CVS/CVSNT.

Local module path The path to the folder that contains the Design Center 
files you are working with.

Use CVSROOT 
environment 
variable

Adds a connection to CVS/CVSNT using values defined 
in the CVSROOT environment variable.

If you select this option, you only have to enter the CVS 
Module name. For more information, see the CVS 
documentation.
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Configure Enterprise Repository dialog box
The Configure Enterprise Repository dialog box is used to edit the database 
settings for the StreamServe Enterprise Repository and the connection settings to 
access the enterprise repository.

Figure 13 The Configuration dialog box for StreamServe Enterprise Repository

The settings are described in the table below.

Setting Description

Database vendor The database vendor for the enterprise repository.

Host name The IP address or host name of the database server.

If you use a named instance of SQL Server, you must 
specify the host name and instance name using the syntax 
<hostname>\<instancename>. 
For example: gbg5000\instance1
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Port The port used for communication with the database 
server. Contact your database administrator to find the 
port for your database server.

• The default port for Microsoft SQL Server is 1433.

• The default port for Oracle database is 1521.

Database name Applicable for Microsoft SQL Server.

A name for the enterprise repository. 

The name should comply with the naming standards in 
your database server. Contact your database 
administrator for more information.

Service name (SID) Applicable for Oracle.

The name of the enterprise repository. 

The name should comply with the naming standards in 
your database server. Contact your database 
administrator for more information.

User name The user name to access the enterprise repository. The 
user is automatically created when the enterprise 
repository is created.

For Oracle, the user name setting is also used as schema 
owner.

The user name should comply with the naming standards 
in your database server. Contact your database 
administrator for more information. 

Note: You cannot use the system administrator as user 
name (for example, sa for SQL Server).

Password The password to access the enterprise repository.

The password should comply with the naming standards 
in your database server. Contact your database 
administrator for more information.

Setting Description
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Create Database dialog box
The Create Database dialog box is used to create the repositories for a selected 
node. For example, if a site node is selected, StreamServe Enterprise Repository 
for the site can be created from the dialog box. Or if an application domain node 
is selected, the runtime repository and the web content repository for the 
application domain can be created.

Figure 14 The Create Database dialog box
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The settings are described in the table below.

Setting Description

Create now Applicable for Microsoft SQL Server and Oracle.

Runs the scripts to create the repository selected in the 
drop down list. You must enter the database 
administrator user name and password.

Note: For Microsoft SQL Server 2008 R2, you cannot 
create the repository directly from Control Center 
if the password contains certain characters. For 
example: [] {}() , ; ? * ! @
For more information, see:
http://msdn.microsoft.com/en-us/library/
ms161962.aspx

Create scripts for 
later use

Generates the SQL scripts used to create the repository 
selected in the drop down list. You can run these scripts 
using an external tool at a later stage. 

The scripts are saved in the following zip file:

<Base directory>\<Version>\root\config\databas
e\<GUID>.zip

Where:

• <Base directory> – Is the path specified for 
StreamServe Projects during the Framework and 
Control Center installation.
For example: C:\ManagementGateway

• <GUID> – Is a globally unique identifier for the zip 
file.

Apply hotfix Applies hotfixes to the repository selected in the drop 
down list. You must enter the database administrator user 
name and password.

The hotfixes must be installed in the following directory:

<Base directory>\<Version>\root\config\databas
e\

Where <Base directory> is the path specified for 
StreamServe Projects during the Framework and Control 
Center installation.
For example: C:\ManagementGateway

Select database A list populated with the possible repositories for the 
selected node. 

Start Starts the selected operation.

Close Closes the Create Database dialog box.
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Available Database Hotfixes dialog box
The Available Database Hotfixes dialog box is used to list all repositories that 
belong to a site, together with their current schema versions and the latest 
available hotfixes. This gives an overview of the current statuses of the 
repositories and helps to decide whether the repositories need to be upgraded.

Figure 15 The Available Database Hotfixes dialog box

Open Log File Opens the full log in the default text editor.

Setting Description
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The settings are described in the table below.

Setting Description

Overview An area that displays a list of repositories, schema 
versions, and available hotfixes:

• Repository type – Enterprise, Runtime, Web 
Content, or Archive

• Name / Application domain – The name of the 
repository and, for the runtime and web content 
repositories, the application domain that the 
repository belongs to.

• Schema version – The current database schema 
version.

• Available hotfix – The latest available hotfix 
installed in:

<Base directory>\<Version>\root\config\
database\

Where <Base directory> is the path specified for 
StreamServe Projects during the Framework and 
Control Center installation.
For example: C:\ManagementGateway

Get list Populates the list in the Overview area the first time the 
dialog box is opened.

Update list Updates the list in the Overview area.

Close Closes the Apply Database Hotfixes dialog box.
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New Site dialog box
The New Site dialog box is used to create a site and connect the site to a 
StreamServe Enterprise Repository. To do this, you connect to the management 
gateway that is used to communicate with the enterprise repository. You need the 
login details for a management gateway user (case-sensitive).

Figure 16 The New Site dialog box

The settings are described in the table below.

Setting Description

Site name A name for the site.

Host name The IP address or host name of the computer with the 
management gateway used to connect to the enterprise 
repository.

Port The port used for communication with the management 
gateway.

Send and response 
time-out

The time Control Center waits for responses from the 
management gateway after the initial connection to the 
management gateway is established. This is specified in 
milliseconds.
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New Application Domain dialog box (Adding)
The New Application Domain dialog box is used to add a new application 
domain.

Figure 17 The New Application Domain dialog box

The settings are described in the table below.

Connection time-
out

The time Control Center waits when trying to establish a 
new connection to the management gateway. This is 
specified in milliseconds.

Certificate file The path to the root certificate on the local computer. 
This must be a valid root certificate for the server 
certificate on the management gateway you are 
connecting to. 

The path to the default StreamServe root certificate is:

<StreamServe installation>\Platform\Core\<Vers
ion>\bin\security\certificatestore\trusted\aut
horities\streamserve.ca.crt

Setting Description

Setting Description

Enter name of new 
application domain

The name of the application domain.

The application domain name must:

• Only include ASCII characters (a-z, A-Z, 0-9).

• Not include any white spaces.

Application domain 
version

The version of the application domain. 

For example: 5.5.0
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New Application Domain dialog box (Selecting type)
The New Application Domain dialog box is used to specify how you want to 
configure the new application domain.

From the New Application Domain dialog box, the Application Domain Editor 
opens, enabling you to edit the new application domain.

Figure 18 The New Application Domain dialog box

The settings are described in the table below.

Setting Description

Manually by 
entering values 
into this wizard

Select to specify an application domain configuration 
manually using the Application Domain Editor.

By importing the 
application domain 
settings from the 
installed template

Imports an application domain configuration from the 
application domain template provided in the installation.

The template includes preconfigured connection settings 
for a runtime repository in SQL Server and to the 
OpenDS directory server. You can make changes to the 
imported configuration using the Application Domain 
Editor.

By importing the 
application domain 
settings from a file

Imports an application domain configuration from a file.

The passwords to access the repositories are not 
imported. You can make changes to the imported 
configuration using the Application Domain Editor.

By importing the 
application domain 
settings from a 
management 
gateway

Imports an application domain from a management 
gateway via the Import from Gateway dialog box. 

The user names and passwords to access the repositories 
are not imported. You can make changes to the imported 
configuration using the Application Domain Editor.
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Application Domain Editor
The Application Domain Editor is used to configure the administrator, 
repositories, connection settings, and recovery actions for an application domain.

In this section

• Administrator tab on page 174.

• Runtime Repository tab on page 175.

• Directory tab on page 178.

• Recovery tab on page 181.

• Web Services tab on page 182.

• Web Content Repository tab on page 183.

• General tab on page 186.

Administrator tab
The Administrator tab is used for specifying the application domain 
administrator.

The application domain administrator is automatically assigned the System 
Manager role in StreamStudio. The administrator can always be used for 
StreamStudio log on, regardless of user directory vendor or even without a user 
directory. 

The first time you log on to StreamStudio, you must log on as the application 
domain administrator.

Do not use an existing user from the user directory as application 
domain administrator, since this may cause conflicts when logging on 
to StreamStudio
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Figure 19 The Application Domain Editor, Administrator tab

The settings are described in the table below.

Runtime Repository tab
The Runtime Repository tab is used for specifying the connection settings for the 
runtime repository, which includes the Queue, Security, and Web Access 
repositories.

Setting Description

Administrator user 
name

The user name for the application domain administrator.

Administrator 
password

The password for the application domain administrator.

Confirm password A confirmation of the password for the administrator.
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Figure 20 The Application Domain Editor, Runtime Repository tab

The settings are described in the table below.

Setting Description

Database vendor The database vendor to use for the runtime repository, 
which includes the Queue, Security, and Web Access 
repositories.

Database name Applicable for Microsoft SQL Server.

A name for the runtime repository. The name you specify 
should comply with the naming standards in your 
database server. Contact your database administrator for 
more information.

Schema owner Applicable for Oracle. 

The schema owner of the tables, functions, users, etc. for 
the Queue, Security, and Web Access repositories. The 
schema owner should be unique for each application 
domain.

Host name 
(\instance name)

The IP address or host name of the database server.

If you use a named instance of SQL Server, you must 
specify the hostname and instance name of the database 
using the syntax <hostname>\<instance name>. For 
example: gbg5000\instance1
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Repositories

In the repositories area, the connection profiles for each of the Queue, Security, 
and Web Access repositories are displayed.

The users are created in the runtime repository when you create the repository. 
The users are assigned the permissions required for applications in the application 
domain to read and update data in the Queue, Security, and Web Access 
repositories.

Port The port used for communication with the database 
server. Contact your database administrator to find the 
port for your database server.

• The default port for Microsoft SQL Server is 1433.

• The default port for Oracle Database is 1521.

Service name (SID) Applicable for Oracle.

The name of the runtime repository.

Setting Description

Profile name A name for the user profile.

User name The user name to access the repository. 

The user name should comply with the naming standards 
in your database server. Contact your database 
administrator for more information. The user is 
automatically created when the runtime repository is 
created.

Note: You cannot use the system administrator as user 
name (for example, sa for SQL Server).

• If you use the same Oracle database server for more 
than one application domain, you must configure 
unique user names in each application domain.

• If you use the same Microsoft SQL Server instance 
for more than one application domain, where 
possible you should configure unique user names in 
each application domain. If you use the same user 
name in more than one application domain, you 
must also use the same password in each 
application domain.

Setting Description
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Directory tab
The Directory tab is used for specifying the connection settings to access the 
internal and external user directories.

Figure 21 The Application Domain Editor, Directory tab

The settings are described in the table below.

Password The password to access the repository.

The password should comply with the naming standards 
in your database server. Contact your database 
administrator for more information.

Reset to Default Resets the settings for the selected repository to the 
default values.

Setting Description

Setting Description

Disable directory 
server settings

Select if you run without user directories in your 
application domain.

Reset to Default Resets the connection settings for the selected user 
directory to the default values.
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User directories

In the User directories area, the connection options for the internal and external 
user directories are displayed. To configure the connection settings for the 
internal and external user directories, you need the login details for a user with 
read access to the LDAP server.

Get Domain 
Controller

Applicable for Microsoft Active Directory.

Tries to translate the Host name setting (see below) into 
the format <Host>@<Domain>. First by using the Host 
name setting as host name and trying to resolve the 
domain. Then by using the Host name setting as a domain 
name and trying to resolve the host. If both fails, you 
must manually specify the Host name setting.

Default Naming 
Context

Gets the default naming context (the DN Base setting 
below) from the directory server specified in the Host 
name setting.

To be able to use this option, a valid User name and 
Password (see below) must be specified.

Check User Authenticates the user in the User name and Password 
settings against the user directory.

For Active Directory, you can choose to translate the 
alias of an authenticated user into a qualified 
distinguished name.

Setting Description

Vendor The vendor of the LDAP server.

Host name The IP address or host name of the LDAP server. The 
following formats are compatible on all platforms:

• <Host>

• <Host>@<Domain> (only Active Directory)

For Active Directory, you can enter <Host> or <Domain> 
and then translate the name into the <Host>@<Domain> 
format by clicking Get Domain Controller.

Port The port used for communication with the LDAP server.

Setting Description
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DN Base The distinguished name base. For example:

dc=itdept,dc=telco,dc=com

The LDAP queries will run against the specified name 
base and all underlying branches. For performance 
reasons, it is recommended to set the DN Base as exact 
and narrow as possible.

Click Default Naming Context to get the default naming 
context (the distinguished name base) from the directory 
server specified in the Host name setting. You can use 
this as a basis when specifying the DN Base setting.

See also Storing external and internal users in the same 
directory on page 73.

Profile name A name for the connection profile to the directory.

User name The distinguished name of the authorized LDAP reader 
user. This user must exist in the user directory and have 
read access to the directory server. For example:

cn=reader,cn=users,dc=itdept,dc=telco,dc=com

For Active Directory, you can enter the alias of the user 
and then translate the alias into a qualified distinguished 
name by clicking Check User and then answer Yes.

Password The password to access the LDAP server for the user 
specified in the User name setting.

Show queries Select to show the queries below, to be executed against 
the directory server.

Verify user attributes – An LDAP string with attributes 
for controlling the sender or receiver of a job.

Translate name attributes – An LDAP string with 
attributes for translating an alias into a qualified 
distinguished name which is used to authenticate the user 
in the user directory.

For syntax, see LDAP attribute syntax on page 72.

Setting Description
StreamServe Persuasion SP5 Control Center User Guide Rev C



Dialog boxes, wizards, and tools 181
Control Center GUI Reference
Recovery tab
The Recovery tab is used for specifying the recovery options for the runtime 
repository and the user directories.

Figure 22 The Application Domain Editor, Recovery tab

The settings are described in the table below.

Setting Description

On lost repository 
connection

Specifies how StreamServer should reconnect to the 
repository in case of a lost connection.

Do not attempt recovery – StreamServer does not try to 
reconnect to the repository. 

Attempt recovery an unlimited number of times – 
StreamServer tries to reconnect to the repository until a 
connection has been successfully established. 

Attempt recovery a limited number of times – 
StreamServer tries to make <x> number of Reconnection 
attempts to the repository. 

Reconnection 
attempts

The number of times StreamServer attempts to reconnect 
the repository.

Time between 
attempts

The time period between the reconnection attempts.
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Web Services tab
The Web Services tab is used for specifying the communication settings for the 
primary and secondary service gateways, and for enabling web service security.

Figure 23 The Application Domain Editor, Web Services tab

The settings are described in the table below.

If reconnection 
attempts fail

Ignore the failure and continue processing – 
StreamServer application continues to process the 
current job.

Stop processing on the affected StreamServer – The 
current job is aborted and StreamServer is stopped.

Reset to Default Resets the recovery options for the selected item to the 
default values.

Setting Description

Setting Description

Service Gateway 
instances

Primary Service Gateway – The primary service 
gateway, used to host the web services.

Secondary Service Gateway – The secondary service 
gateway, used for failover and load balancing reasons. 
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Web Content Repository tab
The Web Content Repository tab is used for specifying the database settings for 
the web content repository and the connection settings to access the repository.

Figure 24 The Application Domain Editor, Web Content Repository tab

The settings are described in the table below.

Web Service 
Security

Enable Web Service security – Enables web service 
security for all service gateways in the application 
domain. This is recommended for test and production 
environments.

For more information, see Enabling web service security 
on page 75.

Setting Description

Setting Description

Disable web 
content repository 
settings

Select if you are not running StreamStudio Composition 
Center in the application domain.

Database vendor The database vendor to use for the web content 
repository. You must use the same vendor as for the 
runtime repository.
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Database name Applicable for SQL Server.

A name for the database instance. The name you specify 
should comply with the naming standards in your 
database server. Contact your database administrator for 
more information.

Schema owner Applicable for Oracle databases.

The schema owner. The schema owner for the web 
content repository should be unique for each application 
domain.

Host name 
(\instance name)

The IP address or host name of the database server. 

If you use a named instance of Microsoft SQL Server, 
you must specify the hostname and instance name of the 
database using the syntax <hostname>\<instance 
name>. For example: gbg5000\instance1

Port The port used for communication with the database 
server. Contact your database administrator to find the 
port for your database server.

• The default port for Microsoft SQL Server is 1433. 

• The default port for Oracle is 1521. 

Service name (SID) Applicable for Oracle databases.

The name of the web content repository.

Profile name A name for the user profile.

User name The user name to access the repository. 

The user name should comply with the naming standards 
in your database server. Contact your database 
administrator for more information. The user is 
automatically created when the web content repository is 
created.

Note: You cannot use the system administrator as user 
name (for example, sa for SQL Server).

If you use the same SQL Server instance for more than 
one application domain, where possible you should 
configure unique user names in each application domain. 
If you use the same user name in more than one 
application domain, you must also use the same password 
in each application domain.

Setting Description
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Database name Applicable for SQL Server.

A name for the database instance. The name you specify 
should comply with the naming standards in your 
database server. Contact your database administrator for 
more information.

Schema owner Applicable for Oracle databases.

The schema owner. The schema owner for the web 
content repository should be unique for each application 
domain.

Host name 
(\instance name)

The IP address or host name of the database server. 

If you use a named instance of Microsoft SQL Server, 
you must specify the hostname and instance name of the 
database using the syntax <hostname>\<instance 
name>. For example: gbg5000\instance1

Port The port used for communication with the database 
server. Contact your database administrator to find the 
port for your database server.

• The default port for Microsoft SQL Server is 1433. 

• The default port for Oracle is 1521. 

Service name (SID) Applicable for Oracle databases.

The name of the web content repository.

Profile name A name for the user profile.

User name The user name to access the repository. 

The user name should comply with the naming standards 
in your database server. Contact your database 
administrator for more information. The user is 
automatically created when the web content repository is 
created.

Note: You cannot use the system administrator as user 
name (for example, sa for SQL Server).

If you use the same SQL Server instance for more than 
one application domain, where possible you should 
configure unique user names in each application domain. 
If you use the same user name in more than one 
application domain, you must also use the same password 
in each application domain.

Setting Description
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General tab
The General tab is used for updating the description and contact person for the 
application domain.

Figure 25 The Application Domain Editor, General tab

The settings are described in the table below.

Password The password to access the repository.

The password should comply with the naming standards 
in your database server. Contact your database 
administrator for more information.

Setting Description

Setting Description

Application domain 
description

The description of the application domain.

Email address to 
contact person

The email address for the person responsible for the 
application domain.

If the surveillance functionality is used, surveillance 
emails will be sent to this address.
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Import from Gateway dialog box
The Import from Gateway dialog box is used to import an application domain 
configuration file from a management gateway.

Figure 26 The Import from Gateway dialog box

The settings are described in the table below.

Setting Description

Host name The hostname or IP address of the computer with the 
management gateway.

Port The port used for communication with the management 
gateway.

Time-out The time Control Center waits for a response from the 
management gateway. This is specified in milliseconds.

Certificate file The path to the root certificate on the local computer. 
This must be a valid root certificate for the server 
certificate on the management gateway you are 
connecting to.
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New Application dialog box
The New Application dialog box is used to add a new StreamServer application, 
Archiver application, service gateway, or Task Scheduler application.

Figure 27 The New Application dialog box

The settings are described in the table below.

Setting Description

Application host The computer used to run the application.

Select Show all hosts to display all the hosts that are part 
of the site.

Application name A name for the application.

Application 
description

A description of the application.

Application type The type and version of the application (Archiver, 
Service Gateway, StreamServer, or Task Scheduler).
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Edit Log On dialog box
The Edit Log On dialog box is used to specify the account that is used to run the 
application.

Figure 28 The Edit Log On dialog box

Startup type Specifies how the application is started.

Automatic – Starts the application automatically when 
the system (host for the corresponding application) starts. 
The application must be started after the database server 
is started.

Note: If the system is set up to start the application 
before the database server is started, you must use 
the Control Center surveillance functionality to 
restart the application. For more information, see 
Monitoring applications on page 111. 

Manual – Starts the application manually.

Disabled – Disables the application.

Log on The account used to run the application. See Edit Log On 
dialog box on page 189.

Setting Description
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The settings are described in the table below.

Setting Description

Log on as: 
Local System 
account

Runs the application under the local system account.

Log on as: 
This account

Specifies the user name and password for another 
account, and runs the application under that account. 

You must use this option to run applications on UNIX 
hosts. You must enter a user name and password. The 
application is run as a management gateway user.

Note: You must enter .\ in front of the user name. 
For example: .\my_account
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Configuration dialog box (Archiver application)
The Configuration dialog box is used to configure an Archiver application. For 
example, schedule the document archiving in the StreamServe archive and to set 
the application log level for the Archiver.

Figure 29 The Configuration dialog box for the Archiver application

The settings are described in the table below.

Setting Description

Log level The application log level for the Archiver.
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Service Configuration dialog box (Archiver application)
In the Service Configuration dialog box, you set up the tasks for an Archiver 
application. For more information about the options in this dialog box, see Adding 
an Archiver application on page 91.

Figure 30 The Service Configuration dialog box

Tasks The tasks for the Archiver application. For example, an 
archiving task defining how and when documents and 
metadata are archived in the StreamServe archive.

You set up the tasks in the Service Configuration dialog 
box (Archiver application). You reach the Service 
Configuration dialog box by selecting the (Item list) field 
and clicking the button to the right of the field. Once a 
task is set up, you can edit the task directly in the 
Configuration dialog box. 

Setting Description
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The settings are described in the table below.

For each added task, the settings below are available.

Setting Description

Continuous Select to create a task for continuously archiving 
documents and metadata. 

When the Archiver application polls the output queue and 
finds documents ready for archiving, the documents are 
immediately archived.

Batch Select to create a task for archiving batches of documents 
and metadata.

When the Archiver application polls the output queue and 
finds documents ready for archiving and the number of 
documents exceeds the Task trigger (documents), the 
documents are archived.

Archive time-
stamping

Select to create a task for archive time-stamping.

For information about the option and the corresponding 
settings, see the E-Invoice Center documentation.

Migration Select to create a migration task.

For information about the option and the corresponding 
settings, see the Upgrading Instructions.

Add Click to add a new task.

Remove Click to remove the selected task.

Setting Description

Type The type of archiving task (Continuous, Batch or 
Archive time-stamping or Migration).

Name A name for the task.

Description A description of the archiving task.

Schedule The polling interval at which the Archiver application 
polls the output queue for documents and metadata ready 
to be archived. 

You set up the polling interval in the Scheduler 
Configuration dialog box. You reach the Scheduler 
Configuration dialog box by selecting the field and 
clicking the button to the right of the field.

Document type Select the document type(s) to be archived within the 
task.
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Time-out (s) The time after which documents held by an Archiver 
application are unlocked if the Archiver application has 
not updated its heartbeat. The unlocked documents are 
then available to all Archiver applications within the 
application domain.

For granularity reasons, it is not recommended to set the 
time-out to less than 60 seconds.

Note: The time-out must be larger than the Heartbeat.

Heartbeat The heartbeat at which the status and health of the 
Archiver application are monitored. For each heartbeat, 
the Archiver application updates the runtime repository 
with status information.

For granularity reasons, it is not recommended to set the 
heartbeat to less than 10 seconds.

Note: The heartbeat must be less than the Time-out (s).

Note: If you use one single Archiver application, and 
want to enhance performance by disabling the 
heartbeat, you can set the heartbeat to 0. You must 
then set the Time-out (s) to 0.

Advanced Advanced settings for the archiving task.

Documents moved per transfer – The maximum 
number of documents that the Archiver application locks 
and transfers in each archiving operation within the 
schedule.

Task trigger 
(documents)

Applicable for Batch tasks.

The minimum number of documents that must exist in 
the output queue before the archiving task is triggered.

Setting Description
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Configuration dialog box (Task Scheduler)
The Configuration dialog box is used to configure system command tasks and log 
level for a Task Scheduler application. The Task Scheduler application can 
perform one or several tasks at the scheduled intervals. For example:

• A task that triggers maintenance of the runtime repository each night at 
1:00 a.m. 

• A task that deletes expired StreamServe jobs from the runtime repository 
every 60 minutes.

Figure 31 The Configuration dialog box for the Task Scheduler application

The settings are described in the table below.

Setting Description

Log level The application log level.
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Service Configuration dialog box (Task Scheduler)
In the Service Configuration dialog box, you set up the tasks for a Task Scheduler 
application. You can add several tasks to the same application.

Figure 32 The Service Configuration dialog box

The settings are described in the table below.

Tasks The tasks for the application.

You set up the tasks in the Service Configuration dialog 
box (Task Scheduler). You reach the Service 
Configuration dialog box by selecting the (Item list) field 
and clicking the button to the right of the field. Once a 
task is set up, you can edit the task directly in the 
Configuration dialog box. 

Setting Description

Setting Description

Run system 
command

Select to create a system command task to be executed 
according to the specified schedule.
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For each added task, the settings below are available.

Update job status Select to update and report the statuses of top jobs.

For information about this task and the corresponding 
settings, see the Database Guidelines.

Delete expired jobs Select to delete expired StreamServe jobs from the 
runtime repository according to the specified schedule.

For information about this task and the corresponding 
settings, see the Database Guidelines.

Delete expired 
Messages

Select to delete expired Messages from Message storages 
in the runtime repository according to the specified 
schedule.

For information about this task and the corresponding 
settings, see the Database Guidelines.

Delete expired 
documents

Select to delete expired documents from Post-processing 
storages in the runtime repository according to the 
specified schedule.

For information about this task and the corresponding 
settings, see the Database Guidelines.

Run database 
maintenance

Select to perform database maintenance on a specified 
repository according to the specified schedule.

For information about this task and the corresponding 
settings, see the Database Guidelines.

Add Click to add a new task.

Remove Click to remove the selected task.

Setting Description

Type The type of task.

Name A descriptive name for the scheduled task.

Description A description of the scheduled task.

Schedule The interval at which the application performs the 
scheduled task.

You set up the interval in the Scheduler Configuration 
dialog box. You reach the Scheduler Configuration 
dialog box by selecting the field and clicking the button 
to the right of the field.

Setting Description
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Logical task name Applicable for Run system command tasks.

The logical name of the system command, to be used in 
the log file. This parameter is optional.

Command Applicable for Run system command tasks.

The system command, including parameters, to be 
executed by the application. 

The command must follow the syntax of the operating 
system where the application is run. For example, on 
Windows, use backslash (\) as a directory separator and 
quotes ("") for arguments containing spaces.

For example, the following command runs a batch file 
that triggers reports according to the specified schedule:

"c:\My Reports\TriggerReport.bat –type 
ReportType –SortOrder Alpabethical"

Working directory Applicable for Run system command tasks.

The name and path of the working directory for the 
system command task.

For example, for the command above you can specify the 
following working directory for the reports:

c:\My Maintenance Reports

If you leave this option empty, the working directory for 
the application is used:

<Base directory>\<Version>\root\applications\<
Task Scheduler name>\wd

Where:

• <Base directory> – Is the path specified for 
StreamServe Projects during the Framework and 
Control Center installation.
For example: C:\ManagementGateway

• <Task Scheduler name> – Is the name of the Task 
Scheduler application.

Setting Description
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Scheduler Configuration dialog box
The Scheduler Configuration dialog box is used to schedule the interval at which 
an application performs a task. For example, the interval at which an Archiver 
application polls the output queue for documents and metadata ready to be 
archived. Or the interval at which a Task Scheduler application performs a system 
command task.

You can set a single interval, or create more complex schedules.

If you specify a stop time (or end time), all ongoing tasks will continue until they 
are finished, even if the stop time is passed.

If a new task is scheduled to start before an on-going task has completed, the 
application first finalizes the ongoing task before the new task is started.

Figure 33 The Scheduler Configuration dialog box. The task is set up to run 
once a day, starting June 4, 2010.
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The settings are described in the table below.

Setting Description

Intervals The scheduled interval for the action.

New – Click to add an interval for the action. Edit the 
default interval in the Define interval area below.

Delete – Click to delete a selected interval.

Move up – Click to move up a selected interval.

Move down – Click to move down a selected interval.

Define interval – Select a time unit (Year, Month, etc.) 
and a frequency for the action.

For example, by adding an interval and selecting 
Seconds and 30 in the Define interval area, you specify 
that the action should be triggered every thirty second.

Apply selected 
intervals

Optional.

The time frame for the selected interval for the action.

New – Click to add a time frame for the selected interval. 

Delete – Click to delete a selected time frame.

Move up – Click to move up a selected time frame.

Move down – Click to move down a selected time frame.

Select a time unit (Year, Month, Week of Year, etc.), start 
value, and (optionally) stop value for the time frame.

For example, by adding a time frame and selecting 
Day of Week, and specifying the start value 1 and stop 
value 3, you specify that the selected interval should be 
applied Monday to Wednesday each week.

Apply all intervals Optional.

The main time frame for when to apply all intervals in the 
list.

Start – Select to add a start date and time for all intervals.

Stop – Select to add a stop date and time for all intervals. 

Add a start date and time and (optionally) stop date and 
time for all scheduled intervals within the configuration.

For example, by selecting Start and specifying the 
current day and time and selecting Stop and specifying a 
day and time next year, you specify that all listed 
intervals should be ran from today until the specified stop 
date and time.
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Deploy wizard
The Deploy wizard is used to select a Project export file, and deploy the export 
file to a StreamServer application.

In this section

• Select the StreamServer application(s) to deploy the export file to on page 
201.

• Where do you want to deploy the file from? on page 202.

• Select the physical layer to deploy on page 203.

Select the StreamServer application(s) to deploy the export file to
You can deploy the export file to an existing StreamServer application or create 
a new application.

Figure 34 Select StreamServer application(s) to deploy

The settings are described in the table below.

Setting Description

All Hosts Displays the existing applications on all hosts at the site.
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Where do you want to deploy the file from?

Figure 35 Where do you want to deploy the file from

Host name <host 
name>

Displays the existing applications on the selected host.

Available 
applications

Lists the existing applications at the site or for the host.

Application Name – The name of the application.

StreamServer version – The version of the application.

Host – The host used to run the application.

Export file – If there is already an export file deployed to 
the application, the name of the export file.

New Application Opens the New Application dialog box, which is used to 
create a new application.

Setting Description
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The settings are described in the table below.

Select the physical layer to deploy
Select the physical layer of the Project to deploy.

Figure 36 Select the physical layer to deploy

Setting Description

Deploy an export 
file from the file 
system

Used to select an export file from the file system. Click 
Browse to select the file.

Deploy an export 
file from a version 
control system

Used to select an export file from a version control 
system.

You must select the connection profile to connect to the 
version control system and enter the user name and 
password.
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The setting is described in the table below.

Setting Description

Clear data folder on 
deploy

Removes the following folder at deploy:

<Base directory>\<Version>\root\applications\
<Application_Name>\data

Where:

• <Base directory> – Is the path specified for 
StreamServe Projects during the Framework and 
Control Center installation.
For example: C:\ManagementGateway

• <Application name> – Is the name of the 
StreamServer application.

Clear this option if you have stored non-Project related 
data in this folder.
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Java Configuration dialog box
The Java Configuration dialog box is used to configure Java parameters for a 
StreamServe application (StreamServer application, Archiver application, or 
service gateway). For example, the target JRE (Java Runtime Environment) 
vendor and the Java class paths.

Figure 37 The Java Configuration dialog box

The settings are described in the table below.

Setting Description

Parameters The Java parameters for the application. For example, the 
target JRE (Java Runtime Environment) vendor and the 
Java class paths.

You set up new parameters in the Export Parameters 
dialog box on page 206. You reach the Export Parameters 
dialog box by selecting the (Item list) field and clicking 
the button to the right of the field.

Once a parameter is set up, you can edit the parameter 
directly in the Java Configuration dialog box. 
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Export Parameters dialog box
The Configure Platform Export Settings dialog box is used to add and configure 
Java parameters for a StreamServe application (StreamServer application, 
Archiver application, or service gateway). For example, the target JRE (Java 
Runtime Environment) vendor and the Java class paths.

Figure 38 The Export Parameters dialog box

The settings are described in the table below.

Setting Description

Java Vendor The JRE (Java Runtime Environment) vendor. 

• Name: Java Vendor

• Value: none (default), Sun, or IBM

The option none means that the Java support is 
disabled. No JVM (Java Virtual Machine) will be 
loaded.
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Java Class Path A semicolon separated list of directories, JAR (Java 
ARchive) files, and ZIP archives to search for class files. 

If all class files are located in one of the following 
directories, you do not have to specify the Java class path:

• <Working directory>\java

• <Working directory>\..\data\java (only for 
StreamServer applications) 

For example:

• Name: Java Class Path

• Value: c:\jndi.jar; c:\myjavaclasses

Java Option A Java option.

Note: Do not include "-" in the name.

For example:

• Name: verbose

• Value: jni

Java System 
Property

A Java system property. 

Note: Do not include "D" in the name. 

For example:

• Name: java.library.path

• Value: c:\mylibs

Add Click to add a new parameter.

Remove Click to remove the selected parameter.

Setting Description
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Host Surveillance dialog box
The Host Surveillance dialog box is used to define surveillance actions that can 
be taken for StreamServer applications, Archiver applications, or service 
gateways on the host.

If the preferred state of an application cannot be reestablished by the surveillance 
actions, an email can be sent to the application domain contact. The application 
domain contact is defined in the Application Domain Editor, on the General tab.

Figure 39 The Host Surveillance dialog box

The settings are described in the table below.

Setting Description

Mail server The IP address or host name of the mail server used to 
send surveillance emails.

Mail domain The domain name for the mail server. 

For example: streamserve.com
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Application Surveillance dialog box
The Application Surveillance dialog box is used to enable surveillance for a 
StreamServer application, Archiver application, or service gateway, and to select 
the surveillance actions can be taken for the application.

Return address The return address for surveillance emails. This address 
is displayed in the sender field.

Alternative email 
address

The email address to use if no contact is specified for the 
application domain or if the email sent to the application 
domain contact fails.

Mail time-out (ms) The time the management gateway waits for a response 
from the mail server. This is specified in milliseconds.

Subject The text displayed in the Subject line of surveillance 
emails. You can use arguments in this field, see 
Surveillance Arguments on page 113. 

For example: The application %a is down.

Program The path to a program used to attempt to restart the 
applications.

Program 
arguments

Arguments used by the program. See Surveillance 
Arguments on page 113.

Setting Description
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Figure 40 The Application Surveillance dialog box

The settings are described in the table below.

Setting Description

Enabled Switches on the surveillance functionality for the 
application.

Number of 
attempts

The number of attempts made to reestablish the preferred 
state of the application. For example, to restart the 
application if it goes down.

Time between 
attempts

The interval between the attempts. This is specified in 
seconds.

Send SMTP mail Sends an email if the preferred state of the application 
cannot be reestablished. For example, if the application 
cannot be restarted. This email is sent using the options 
specified at host level. See Host Surveillance dialog box 
on page 208.
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Add StreamStudio Portal dialog box
The Add StreamStudio Portal dialog box is used to add a StreamStudio web portal 
to the StreamStudio Portals folder. The configured portal is then available to all 
application domains at the site.

Figure 41 The Add StreamStudio Portal dialog box

Message The information included in the body of the surveillance 
email. You can use arguments in this field, see 
Surveillance Arguments on page 113. 

For example: The application %a is down.

Run program Executes an external program if the preferred state of the 
application cannot be reestablished. For example, if the 
application cannot be restarted. The path to the program 
and the startup options are specified at host level. See 
Host Surveillance dialog box on page 208.

Setting Description
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The settings are described in the table below.

Link StreamStudio Portal dialog box
The Link StreamStudio portal dialog box is used to link an application domain to 
a StreamStudio web portal. You can link the application domain to one web 
portal. One web portal can be shared by several application domains.

Setting Description

Name A name for the web portal.

The web portal name must:

• Only include ASCII characters (a-z, A-Z, 0-9).

• Not include any white spaces.

• Be unique if you deploy several web portals to the 
same Java application server.

• Not be the word applications.

Description A description of the web portal.

Manual deploy Select this option if you run in an isolated environment.

Destination folder – The directory where the 
StreamStudio web archive file, <Portal name>.war, is 
stored.

When the Control Center configuration is completed, you 
must manually copy the web archive file and the 
application domain configuration file for StreamStudio 
to the Java application server. See the StreamStudio 
Administrator’s Guide.

Portal root The directory on the Java application server to which you 
want to deploy the StreamStudio web archive file, 
<Portal name>.war. For example (for Apache Tomcat):

<TOMCAT_HOME>\webapps\

The management gateway copies the file to the specified 
directory from where the file can be unpacked. For 
information on how to unpack the file, see the user 
documentation for the Java application server. For 
Apache Tomcat, the file may be unpacked automatically 
if you restart the Apache Tomcat service.
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Figure 42 The Link StreamStudio Portal dialog box

The settings are described in the table below.

New Archive dialog box
The New Archive dialog box is used to add a new StreamServe archive to the 
Archives folder. The archive is then available to all application domains at the 
site.

Note: After adding and configuring the StreamServe archive, you must also 
create the archive.

Figure 43 The New Archive dialog box

Setting Description

Available portals Lists the StreamStudio web portals available in the 
StreamStudio Portals folder.

Select New to open the Add StreamStudio Portal dialog 
box and add a new StreamStudio web portal.
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The settings are described in the table below.

Configuration dialog box (Archive)
The Configuration dialog box is used to configure the database settings for the 
StreamServe archive and the connection settings to access the StreamServe 
archive. The settings are used when the StreamServe archive is created.

Figure 44 The Configuration dialog box for the StreamServe archive

Setting Description

Name A name for the StreamServe archive.

The name of the StreamServe archive cannot include 
underscore characters ("_").

In the Configuration dialog box (Archive), the name will 
be suggested as Database name (for SQL Server) or 
Service name (SID) for Oracle.

Description A description of the StreamServe archive.
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The settings are described in the table below.

Setting Description

Database vendor The database vendor for the StreamServe archive. You 
must use the same vendor as for the runtime repository.

Host name The IP address or host name of the database server.

If you use a named instance of SQL Server, you must 
specify the host name and instance name using the syntax 
<hostname>\<instancename>. 
For example: gbg5000\instance1

Port The port used for communication with the database 
server. Contact your database administrator to find the 
port for your database server.

• The default port for Microsoft SQL Server is 1433.

• The default port for Oracle database is 1521.

Database name Applicable for Microsoft SQL Server.

A name for the StreamServe archive. By default, the 
name you entered in the New Archive dialog box is 
suggested as Database name.

The name should comply with the naming standards in 
your database server. Contact your database 
administrator for more information.

Service name (SID) Applicable for Oracle.

The name of the StreamServe archive.

The name should comply with the naming standards in 
your database server. Contact your database 
administrator for more information.

Recovery Settings 
> On lost 
repository 
connection

Recovery options for the StreamServe archive.

Specifies how the Archiver application should reconnect 
to the repository in case of a lost connection.

Attempt recovery a limited number of times – The 
Archiver application tries to make <x> number of 
Reconnection attempts to the repository. 

Attempt recovery an unlimited number of times – The 
Archiver application tries to reconnect to the repository 
until a connection has been successfully established.

Do not attempt recovery – The Archiver application 
does not try to reconnect to the repository.
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Recovery Settings 
> If reconnection 
attempts fail

Recovery options for the StreamServe archive.

The action to take if the reconnection fails.

Stop processing on the affected Archiver – The 
current job is aborted and the Archiver application is 
stopped.

Ignore the failure and continue processing – The 
Archiver application continues to process the current job.

Recovery Settings 
> Reconnection 
attempts

Recovery options for the StreamServe archive.

The number of times the Archiver application attempts to 
reconnect the repository.

Recovery Settings 
> Time between 
attempts

Recovery options for the StreamServe archive.

The time period between the reconnection attempts.

User name The user name to access the StreamServe archive. 

For Oracle, the user name setting is also used as schema 
owner.

The user name should comply with the naming standards 
in your database server. Contact your database 
administrator for more information. The user is 
automatically created when the StreamServe archive is 
created.

Note: You cannot use the system administrator as user 
name (for example, sa for SQL Server).

Password The password to access the StreamServe archive.

The password should comply with the naming standards 
in your database server. Contact your database 
administrator for more information.

Setting Description
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Link Archive dialog box
The Link Archive dialog box is used to link an application domain to a 
StreamServe archive. You can link the application domain to one StreamServe 
archive. One StreamServe archive can be shared by several application domains.

Figure 45 The Link Archive dialog box

The settings are described in the table below.

Setting Description

Available archives Lists the StreamServe archives available in the Archives 
folder.

Select New to open the New Archive dialog box and add 
a new StreamServe archive.
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Link Application Domains dialog box
The Connect Application Domains dialog box is used to link a StreamStudio web 
portal or a StreamServe archive to one or more application domains.

Figure 46 The Link Application Domains dialog box

The settings are described in the table below.

Setting Description

Available 
Application 
Domains

A list of all available application domains at the site (that 
is, all applications domains on the local host and any 
remote hosts included in the site).

Linked Application 
Domains

A list of the application domains that the StreamStudio 
web portal or StreamServe archive is linked to.
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Manage Document Types dialog box
The Manage Document Types dialog box is used to display:

• The document types available in the StreamServe Enterprise Repository.

• The application domain(s) associated each document type.

• The revision of each document type.

From this dialog, you can delete document types from the enterprise and the 
runtime repositories. You can also compare two document types in the enterprise 
repository.

Figure 47 The Manage Document Types dialog box

The settings are described in the table below.

Setting Description

Close Closes the Document Types dialog box.

Delete Deletes the selected document type from the enterprise 
and the runtime repositories.

View Opens the Document Type Content dialog box, where the 
XML file for the selected document type is displayed.

Compare Compares two selected document types in the enterprise 
repository. 

You can use this function before redeploying a Project to 
check which impact the redeployment will have. For 
example, you can compare a document type used in the 
development environment with the one used in the 
production environment.
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Compare Document Types tool
The Compare Document Types tool is used to compare an updated document type 
with an existing document type, already deployed to the StreamServe Enterprise 
Repository.

The document types are configured in Design Center. Each document type is 
stored in a separate XML file. When you redeploy a Project in Control Center, the 
XML file for the updated document type is compared with the XML file for the 
existing document type. If there is a difference between the document types, the 
Compare Document Types tool opens. Both document types are displayed and 
any differences are marked with colors:

• Green – Information that differs between the document types. For example, 
an updated revision number.

• Yellow – New information in the updated document type. For example, new 
metadata.

• Red – Information deleted from the existing document type. For example, 
removed metadata.

Depending on type of difference, you may or may not be able to redeploy the 
Project and update the document type in the enterprise repository. For example, 
if a document type includes new metadata, you can redeploy the Project. If 
metadata is removed from a document type, you cannot redeploy the Project. 
However, if certain prerequisites are fulfilled (see Changes that require database 
manipulation in the Document types and metadata documentation), you can force 
such an update into the enterprise and the runtime repositories and thereby 
complete the redeploy operation.

If the Project includes several updated document types, one document type is 
displayed at a time. You toggle between the document types using the navigation 
buttons.

Figure 48 The Compare Document Types tool
StreamServe Persuasion SP5 Control Center User Guide Rev C



Dialog boxes, wizards, and tools 221
Control Center GUI Reference
Force Document Type Update dialog box
The Force Document Type Update dialog box is used to force a modified 
document type into the enterprise and runtime repositories at redeploy.

Note: Forcing a modified document type into the enterprise and runtime 
repositories does not affect the document type in the StreamServe archive.

Figure 49 The Force Document Type Update dialog box

The settings are described in the table below.

Setting Description

Start Starts the force operation.

Close Closes the Force Document Type Update dialog box.
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MGW Browser dialog box
The MGW Browser dialog box is used to create a Source/Destination pair when 
using FastCopy for testing StreamServer applications. The source file and the 
destination directory can be located on the local host or any remote host with a 
management gateway that is connected to the site, both on Windows and UNIX.

The MGW Browser dialog box opens when you click a browse button in the 
Source and destination dialog box.

Figure 50 The MGW Browser dialog box

MGW Explorer dialog box
The MGW Explorer dialog box is used to manage files and directories. The files 
and directories can be located on the local host or any remote host with a 
management gateway that is connected to the site, both on Windows and UNIX.

You can, for example:

• Create and delete directories.

• Cut, copy, and paste single files from one location to another.

The MGW Explorer dialog box opens when you select Host > Explore.

To access the working directory for a StreamServer application directly, right-
click the application and select Explore. 
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Figure 51 The MGW Explorer dialog box

Manage Users dialog box
The Manage Users dialog box is used to:

• Create a new user on the management gateway.

• Remove a user from the management gateway.

• Change a password.

• Change the role for a user.

Figure 52 The Manage Users dialog box
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The settings are described in the table below.

Add User dialog box
The Add User dialog box is used to add a new management gateway user.

Figure 53 The Add User dialog box

The settings are described in the table below.

Option Description

Management 
Gateway users

Lists all the users on the management gateway.

Add Adds a new user to the management gateway. See Add 
User dialog box on page 224.

Remove Removes a management gateway user.

Edit Changes the password for a user, or changes the role for 
a user. See Edit User dialog box on page 225.

Setting Description

User name A user name. This cannot be changed after the user is 
created.

Password A password for the user.

Confirm password Confirmation of the password.
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Edit User dialog box
The Edit User dialog box is used to:

• Change a password for a user.

• Change the role for a user.

Figure 54 The Edit User dialog box

The settings are described in the table below.

Change password 
on first login

Prompts the user to change their password on first log on 
to Control Center.

User privileges Administrator – Grants the Administrator role to the 
user. See Access rights for Administrators on page 40.

Basic – Grants the Basic role to the user. See Access 
rights for basic users on page 40.

Setting Description

Setting Description

User name The user name for the user. This cannot be changed.

Change password Select to change the password for a user.

New password – A new password for the user.

Confirm password – Confirmation of the password.
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Change password 
on first login

Prompts the user to change their password on first log on 
to Control Center.

User privileges Administrator – Grants the Administrator role to the 
user. See Access rights for Administrators on page 40.

Basic – Grants the Basic role to the user. See Access 
rights for basic users on page 40.

Setting Description
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Manage Templates dialog box
The Manage Templates dialog box is used to display:

• The Composition Center templates available in the StreamServe Enterprise 
Repository.

• The application domain(s) associated with each Composition Center 
template.

• The revision of each Composition Center template.

From this dialog, you can delete Composition Center templates from the 
enterprise and the runtime repositories. You can also compare two Composition 
Center templates in the enterprise repository.

Figure 55 The Manage Templates dialog box

The settings are described in the table below.

Setting Description

Close Closes the Manage Templates dialog box.

Delete Deletes the selected Composition Center templates from 
the enterprise and the runtime repositories.

View Opens the Document Template Content dialog box, 
where the XML file for the selected Composition Center 
template is displayed.

Compare Compares two selected Composition Center templates in 
the enterprise repository. 

You can use this function before redeploying a Project to 
check which impact the redeployment will have. For 
example, you can compare a Composition Center 
template used in the development environment with the 
one used in the production environment.
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Compare Composition Center Templates tool
The Compare Composition Center Templates tool is used when redeploying 
Projects containing StoryTeller Processes that are used as templates in 
Composition Center. 

If the version number of the redeployed StoryTeller Process is lower than the 
version number in the enterprise repository, the Compare Composition Center 
Templates tool opens. The tool also opens if the version numbers are the same, 
but the template is modified.

The tool displays information that helps you make the necessary corrections in 
StoryTeller. The corrections are required for redeploying the template, since you 
cannot force an updated version into the repository. 

Any differences between the templates are marked with colors:

• Green – Information that differs between the templates. For example, the 
template version numbers differ or a section is renamed.

• Yellow – New information is added in the updated template. For example, a 
new exposed story.

• Red – Information is removed in the updated template. For example, a story 
or section is removed.

If the Project includes several updated StoryTeller Processes, one template is 
displayed at a time. You can toggle between the templates using the navigation 
buttons.

Figure 56 The Compare Composition Center Templates tool
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Related topics

• For information about Composition Center template versioning and updates 
that affect the possibility to redeploy Projects used with Composition 
Center, see Modifying Composition Center Projects in the Composition 
Center documentation.
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